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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
Xerox printer. 
 
 

 1 Safety 
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Notices and Safety 

Read the following instructions carefully before operating your printer. Refer to these instructions to 
ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These 
include safety agency evaluation and certification, and compliance with electromagnetic regulations 
and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 

Note: Unauthorized alterations, which can include the addition of new functions or connection of 
external devices, can affect the product certification. For more information, contact your Xerox 
representative. 
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Electrical Safety 

This section includes: 
• General Guidelines ................................................................................................................................................................. 15 
• Power Cord ................................................................................................................................................................................ 16 
• Emergency Turn Off .............................................................................................................................................................. 16 
• Telephone Line Cord ............................................................................................................................................................. 16 
 
 

General Guidelines 
 

 WARNINGS:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Power off the printer when performing these 
installations. Disconnect the power cord when removing covers and guards for installing 
optional equipment. Except for user-installable options, there are no parts that you can 
maintain or service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Power off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
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Power Cord 

Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

 

 WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or 
power plugs for more than 90 days. When a permanent outlet receptacle cannot be installed, 
use only one factory-assembled extension cord of the appropriate gauge for each printer or 
multifunction printer. Always adhere to national and local building, fire, and electrical codes 
regarding length of cord, conductor size, grounding, and protection. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have 
a ground connection terminal. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Do not plug or unplug the power cord while the power switch is in the On position. 
• If the power cord becomes frayed or worn, replace it. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.  
 

Emergency Turn Off 

If any of the following conditions occur, power off the printer immediately and disconnect the power 
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the 
problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 

Telephone Line Cord 
 

 WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of 
your printer. 
 

Operational Guidelines 
• Do not remove any trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer while is printing. 
• Keep hands, hair, neckties, and so on away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
• Do not override any electrical or mechanical interlock devices. 
• Do not attempt to remove paper that is jammed deeply inside the product. Switch off the product 

promptly and contact your local Xerox representative. 
 

 WARNING: The metallic surfaces in the fuser area are hot. Always use caution when removing 
paper jams from this area and avoid touching any metallic surfaces. 

 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
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Safety 

 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, refer to Physical Specifications on page 300. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation on page 303. 
 

Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation 
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified 
for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. 
Coverage could vary outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

• Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 

• Clean with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 

recycling programs, go to www.xerox.com/gwa. 

 WARNING:  

Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on 
electromechanical equipment. 
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Safety 

 

Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a hazard which, if not avoided, could result in death or serious injury. 

 

Hot Warning: 
Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Caution: 
To avoid damage to the property, be careful not to spill toner when handling the waste 
cartridge. 

 

Do not touch the part or area of the printer. 

 

Do not expose the drum cartridges to direct sunlight. 

 

Do not burn the toner cartridges. 

 

Do not burn the waste cartridge. 

 

Do not burn the drum cartridges. 

 

Do not use paper attached with staples or any other form of binding clip. 

20 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



Safety 

 

 

Do not use folded, creased, curled, or wrinkled paper. 

 

Do not use inkjet paper. 

 

Do not use transparencies or overhead projector sheets. 

 

Do not reload paper previously printed on or used. 

 

Do not copy money, revenue stamps, or postage stamps. 

 

Add paper or media. 

 

Paper Jam 

 

Lock 

 

Unlock 

 

Document 

 

Paper 

 

WLAN 
Wireless Local Area Network 
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LAN 
Local Area Network 

 

USB 
Universal Serial Bus 

 

Telephone Line 

 

Modem Line 

 

Postcard 

 

Load envelopes in the tray with the flaps closed and facing up. 

 

Load envelopes in the tray with the flaps open and facing up. 

 

NFC Area 

 

Data Transmission 

 

Home Button 

 

Power/Wake Button 

 

Paper-Feeding Direction Indicator 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 

Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
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Features 

 

Parts of the Printer 

This section includes: 
• Front View.................................................................................................................................................................................. 26 
• Single-Pass Duplex Automatic Document Feeder ................................................................................................... 27 
• Rear View ................................................................................................................................................................................... 27 
• Internal Parts............................................................................................................................................................................ 28 
• Control Panel ............................................................................................................................................................................ 29 
 
 

Front View 

 
 

1. Tray 2, Optional 550-Sheet Feeder 
2. Tray 1 
3. Bypass Tray 
4. Front Door 
5. USB Memory Port 
6. Power/Wake Button 

7. Touch Screen Display 
8. Single-Pass Duplex Automatic Document Feeder (DADF) 
9. Output Tray 
10. Output Tray Extension 
11. Right-Side Door 
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Single-Pass Duplex Automatic Document Feeder 

 
 

1. Document Feeder Cover 
2. Document Guides 
3. Document Feeder Tray 
4. Document Feeder Tray Extension 
5. Document Output Tray 

6. Document Output Tray Extension 
7. CVT Glass 
8. Second-Side Scanning Access Cover Lever 
9. Document Glass 
10. Document Cover 

 
 

Rear View 

  

1. Fuser 
2. Rear Door 
3. Wireless Network Adapter Port Cover 
4. Left-Side Cover 
5. Phone Connector 

6. Fax Line Connector 
7. USB Port, Type A 
8. USB Port, Type B 
9. Ethernet Connection 
10. Power Connector 
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Internal Parts 

 
 

1. Front Door 
2. Toner Cartridges 
3. Document Glass 
4. Document Cover 
5. Single-Pass Duplex Automatic Document Feeder (DADF) 

6. Drum Cartridges 
7. Waste Cartridge 
8. Cleaning Rod 
9. Right-Side Door 
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Control Panel 

The control panel consists of a touch screen and buttons you press to control the functions available on 
the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print, copy, and scan features. 
• Provides access to reference materials. 
• Provides access to Tools and Setup menus. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
• Provides the Power/Wake button used for turning on or turning off the printer. This button also 

supports the power-saver modes, and blinks to indicate the power status of the printer. 
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Item Name Description 

1 

NFC Area Near Field Communication (NFC), is a technology that enables devices to 
communicate when they are within 10 cm (4 in.) of each other. Use the NFC area 
to obtain a network interface or to establish a TCP/IP connection between your 
device and the printer. 

2 Touch Screen 
Display 

The screen displays information and provides access to printer functions. 

3 
Home Button This button provides access to the Home menu for access to printer features, such 

as copy, scan, and fax. 

4 

Power/Wake This button serves several power-related functions. 
• When the printer is off, this button turns on the printer. 
• When the printer is on, pressing this button displays a menu on the control 

panel. From this menu, you can choose to enter Sleep mode, restart, or power 
off the printer. 

• When the printer is on, but in a low-power or Sleep mode, pressing this button 
wakes the printer. 

• When the printer is on, holding this button for 10-seconds turns off the printer. 
This button also blinks to indicate the power status of the printer. 
• When the light blinks slow, the printer is in Low Power or Sleep mode. 
• When the light blinks fast, the printer is powering down, or exiting a low-power 

mode. 

5 

Status LED This light blinks blue or amber to indicate printer status. 
Blue 
• Blinks-blue once to acknowledge a successful Authentication request. 
• Blinks slow-blue once for a Copy or Print job initiated at the control panel. 
• Blinks slow-blue twice for Fax or Print job received from the network. 
• Blinks fast-blue while the printer is powering up, or to signal detection of a Wi-Fi 

Direct connection request, such as AirPrint™. 
Amber 
• Blinks amber to indicate an error condition or warning that requires your 

attention. For example, an out of toner condition, a paper jam, or out of paper 
for the current job. 

• It also blinks amber to indicate a system error, which typically is associated with 
an error code. 

 
 

30 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



Features 

 

Power Saver 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower 
power level. For details, referto Configuring Power Saver Using the Embedded Web Server on page 235. 

There are two levels of power-saver mode. 
• Low Power Timeout: The printer shifts from Ready mode to Low Power mode to reduce standby 

power consumption. 
• Sleep Timeout: The printer shifts from Low Power mode to Sleep mode for a greater reduction in 

power consumption. 

Note: Increasing the default Power Saver activation times can result in an overall higher energy 
consumption of the printer. 

 

Exiting Sleep Mode 

The printer exits Low Power mode or Sleep mode automatically when it receives data from a connected 
device. 

To exit Low Power mode or Sleep mode manually, at the control panel, press the Power/Wake button. 
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Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 
 

Printing Information Pages 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. To print an information page, touch the desired page. 
4. To return to the Home screen, press the Home button. 
 

Configuration Report 

The Configuration Report provides product information including, installed options, network settings, 
port setup, tray information, and more. 
 

Printing the Configuration Report 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Configuration Report. 
4. To return to the Home screen, press the Home button. 
 

Configuring Printing of the Startup Page at Power On 

The Startup Page provides basic printer configuration information, such as printer name, serial number, 
fonts, firmware, and Ethernet versions. When this feature is on, the Startup Page prints each time you 
power on your printer. If you do not want the Startup Page to print, you can disable the feature. 

To configure the Startup page: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. Click System. 
3. Click Defaults and Policies > Startup Page. 

a. To print the Startup Page at power-on, click Auto Print. 
b. To disable printing the Startup Page at power-on, click Do Not Auto Print. 

4. Click OK. 
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Administrative Features 

The Embedded Web Server 

The Embedded Web Server is the administration and configuration software that is installed in the 
printer. It allows you to configure and administer the printer from a Web browser. 

The Embedded Web Server requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 
 

Accessing the Embedded Web Server 

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press 
Enter or Return. 
 

Finding the IP Address of Your Printer 

To install the print driver for a network-connected printer, you need the IP address of your printer. 
You also need the IP address to access the settings of your printer through the Embedded Web Server. 
You can view the IP address of your printer on the control panel or on the Configuration Report. 

Note: Wait until the printer has been on for 2 minutes to view the TCP/IP address. If the TCP/IP address 
is 0.0.0.0 or begins with 169, this indicates a network connectivity issue. For details, refer to Printer Does 
Not Print on page 193. 

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About. 
3. Record the IP address from the display. 
4. To return to the Home screen, press the Home button. 

To view the IP address of the printer on the Configuration Report: 
1. If needed, log in as administrator. For details, refer to Logging In as the Administrator on page 265. 
2. At the printer control panel, press the Home button. 
3. Touch Device > About > Information Pages. 
4. Touch Configuration Report. 
5. To return to the Home screen, press the Home button. 

The IP address information is located in the Communication Settings section of the Configuration 
Report under IPv4 and IPv6. 
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Accessing the Printer 

The system administrator can set access rights on the printer to ensure that unauthorized users cannot 
access the printer. If the system administrator configures authentication and authorization, users require 
a login and a password to access some or all of the features of the printer. 
 

Logging In 

Logging in is the process by which you identify yourself to the printer for authentication. If 
authentication is set, to access printer features, you log in with your user credentials. 
 

Logging In at the Control Panel 
1. At the printer control panel, press the Home button. 
2. Touch Log In. 
3. Type the User Name using the keypad, then touch Enter. 
4. If prompted, enter the password, then press Enter. 
5. Touch OK. 

Notes: 

• To access each service that is password-protected, repeat steps 3 and 4 of the procedure. 
• To log in as the System Administrator, refer to Logging In as the Administrator on page 265. 
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Billing Meters/Usage Counters 

The Usage Counter menu shows the total number of impressions. You cannot reset the counters, which 
track the total number of pages printed for the life of the printer. A page is one side of a sheet of paper 
that can be printed on one or two sides. A sheet printed on two sides counts as two impressions. 

To view the Usage Counters at the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Billing/Usage. 
3. To view more details, touch Usage Counters and select an option. 
4. After viewing the usage readings, to return to the Home screen, press the Home button. 

To view the Usage Counters using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. To view the Billing/Usage counters, in the Embedded Web Server, click Home. 
3. To view more details, for Billing/Usage, click Details. 

− To view Billing Meter details, click Billing Meters. 
− To view Usage Counter details, click Usage Counters. 

4. To return to the previous window, click Close. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/WC6515docs  

Recommended Media List United States: www.xerox.com/rmlna  
European Union: www.xerox.com/rmleu  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and print driver downloads. 

www.xerox.com/office/WC6515support  

Information Pages Print from the control panel. For details, refer to 
Information Pages on page 32. 

Order supplies for your printer www.xerox.com/office/WC6515supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
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This chapter includes: 
• Installation and Setup Overview ..................................................................................................................................... 38 
• Selecting a Location for the Printer ................................................................................................................................ 39 
• Connecting the Printer ......................................................................................................................................................... 40 
• Powering the Printer On and Off ..................................................................................................................................... 52 
• Configuring Network Settings .......................................................................................................................................... 54 
• Configuring AirPrint ............................................................................................................................................................... 56 
• Google Cloud Print ................................................................................................................................................................. 57 
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• Configure the Fax Defaults and Settings .................................................................................................................... 59 
• Installing the Software ........................................................................................................................................................ 60 

For reference:  
Installation Guide packaged with your printer. 
Online Support Assistant at www.xerox.com/office/WC6515support  
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Installation and Setup 

 

Installation and Setup Overview 

Before you print, ensure that your computer and the printer are plugged in, turned on, and connected. 
Configure the initial settings of the printer, then install the print driver software and utilities on your 
computer.  

You can connect to your printer directly from your computer using USB, or connect over a network using 
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network switches, modems, Ethernet cables, and USB cables are not 
included with your printer and must be purchased separately. Xerox recommends an Ethernet connection 
because it is typically faster than a USB connection, and it provides access to the Embedded Web Server. 

Note: If the Software and Documentation disc is not available, you can download the latest print 
drivers from www.xerox.com/office/WC6515drivers. 

For reference:  
Selecting a Location for the Printer on page 39 
Selecting a Connection Method on page 40 
Connecting the Printer on page 40 
Configuring Network Settings on page 54 
Installing the Software on page 60 
 

38 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6515&PgName=driver&Language=English


Installation and Setup 

 

Selecting a Location for the Printer 

1. Select a dust-free area with temperatures from 5–32°C (41–90°F), and relative humidity 15–85%. 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the 
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the 
weight for your printer configuration, refer to Physical Specifications on page 300. Select a location 
with adequate clearance to access supplies and to provide proper ventilation. To find the clearance 
requirements for your printer, refer to Clearance Requirements on page 301. 

3. After positioning the printer, you are ready to connect it to the power source and computer or 
network. 

 

Opening the Output Tray Extension 
1. To provide better support for your prints, open the Output Tray Extension. 

 

2. To print on longer paper, open the Output Tray Extension, then pull out the upper section until it 
stops. 
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Connecting the Printer 

This section includes: 
• Selecting a Connection Method ...................................................................................................................................... 40 
• Connecting to a Computer Using USB ......................................................................................................................... 41 
• Connecting to a Wired Network ...................................................................................................................................... 41 
• Connecting to a Wireless Network.................................................................................................................................. 42 
• Connecting to a Telephone Line ...................................................................................................................................... 51 
 
 

Selecting a Connection Method 

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection. 
The method that you select depends on how your computer is connected to the network. A USB 
connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect 
to a network. If you are using a network connection, it is important to understand how your computer is 
connected to the network. For details, refer to About TCP/IP and IP Addresses on page 54. 

Note: Hardware and cabling requirements vary for the different connection methods. Routers, 
network switches, modems, Ethernet cables, and USB cables are not included with your printer and 
must be purchased separately. 

• Network: If your computer is connected to an office network or home network, use an Ethernet 
cable to connect the printer to the network. You cannot connect the printer directly to the computer. 
The printer must be connected through a router or network switch. An Ethernet network can be used 
for one or more computers and supports many printers and systems simultaneously. Ethernet 
connection is typically faster than USB and allows you direct access to the settings of the printer 
using the Embedded Web Server. 

• Wireless Network: If your environment includes a wireless router or wireless access point, you can 
connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection. A wireless network connection is 
typically faster than USB and allows direct access to the setting of the printer using the Embedded 
Web Server. 

• USB: If you connect the printer directly to a single computer and not to a network, use a USB 
connection. A USB connection offers fast data speeds, but typically is not as fast as an Ethernet 
connection. 

Note: To access the Embedded Web Server, a network connection is required. 

• Telephone: To send and receive faxes, ensure that the printer is connected to a dedicated 
telephone line. 
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Connecting to a Computer Using USB 

To connect using USB, you need one of these operating systems: Windows Vista, Windows 7, 
Windows 8.1, Windows 10, Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, 
or Macintosh OS X version 10.9 or later. 

To connect the printer to the computer using a USB cable: 
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the 

printer. 
2. Connect the A end of the USB cable to the USB port on the computer. 
3. If the Windows Found New Hardware Wizard appears, cancel it. 
4. Install the print driver. 

For reference:  
Installing the Software on page 60. 
 

Connecting to a Wired Network 
1. Ensure that the printer is powered off. 
2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. 

Use an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the 
switch or router with one cable, then connect the printer to the switch or router with the second 
cable. Connect to any port on the switch or router except the uplink port. 

3. Attach the power cord, then plug in the printer and turn it on. 
4. Set the network IP printer address, or set up the printer for automatic printer IP detection. 

For reference:  
Assigning the IP address of the printer on page 54. 
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Connecting to a Wireless Network 

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN 
without a physical connection. The printer can connect to a wireless LAN that includes a wireless router 
or wireless access point. Before connecting the printer to a wireless network, the wireless router must be 
configured with a service set identifier (SSID) and any necessary credentials. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

 

Installing the Wireless Network Adapter 

The optional wireless network adapter plugs in to the back of the control board. After the adapter is 
installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless 
network. 

To install the Wireless Network Adapter: 
1. Power off the printer. 

 

2. To remove the Wireless Network Adapter Port Cover, press down on the latch, then pull the cover 
away from the printer. 
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3. Remove the packaging from the Wireless Network Adapter. 
4. To install the Wireless Network Adapter, follow the procedure defined on the instruction sheet 

provided with the Wireless Network Adapter. 

 
 

 CAUTION: Pulling on the adapter can damage it. Once installed, remove the adapter only as 
needed, and according to the Wireless Network Adapter removal instructions. For details, refer to 
Removing the Wireless Network Adapter on page 44. 

 

5. Power on the printer. 

 
6. Configure the Wi-Fi Settings. 

For reference:  
Connecting to a Network with a Wi-Fi protected Setup on page 48 
Connecting to a Wireless Network Manually on page 50 
Connecting to a Wireless Network Using the Embedded Web Server on page 227 
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Removing the Wireless Network Adapter 
1. Power off the printer. 

 

2. To unlatch the left-side cover, slide the handle away from the printer, then swing the handle toward 
the rear of the printer. 

 

3. To remove the cover, slide it toward the back, then away from the printer. 
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4. Reach into the printer and push the release lever toward the front of the printer. Hold the release 
lever in this position and gently pull the Wireless Network Adapter away from the printer. 

 
 

 CAUTION: Do not use force to pull on the Wireless Network Adapter. If the latch is released 
properly, the adapter pulls out easily. Pulling on a secured adapter can damage it. 

 

5. To reinstall the Wireless Network Adapter Port Cover, insert the bottom tab into the small slot. 
Gently press the port cover against the back of the printer until it latches into place. 
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6. Place the left-side cover into place, then slide it toward the front of the printer. 

 

7. To latch the cover, swing the handle toward the front of the printer, then push the handle in until it 
clicks into the locked position. 

 

8. Connect the printer to your computer with a USB cable or to a network using an Ethernet cable. 
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9. Power on the printer. 

 
 

Resetting Wireless Settings 

If the printer was previously installed in a wireless network environment, it could retain setup and 
configuration information. To prevent the printer from attempting to connect to the previous network, 
reset the wireless settings. 

To reset the wireless settings: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Connectivity > Wi-Fi. 
3. Touch the network selection that you want to reset. 
4. Touch Forget This Network. 
5. At the prompt, touch Forget & Reboot. 
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Connecting to a Network with a Wi-Fi Protected Setup 

Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network. The WPS protocols 
enable you to set up devices in a secure wireless network without having wireless networking experience. 
With a WPS-certified router, you can use tools in the router and the printer to connect the printer to the 
network. To use the tools, ensure that the wireless router is configured properly and is compliant with the 
WPS. 
• Push Button Connection (PBC) is the easiest way to connect the printer to a wireless network. 

It automatically connects when you push a button on the router and on the printer. After the router 
and printer exchange information, the printer accepts the security and configuration information 
from the router and connects to the network. The PBC is a moderately secure way to connect the 
printer to the network. You do not need to enter any information to make the network connection. 

• PIN (Personal Identification Number) automatically connects the printer to a wireless router using a 
common PIN. The printer generates and prints a PIN for use in the setup process. When you enter 
the PIN into the router, the router broadcasts network information using the PIN. When both 
devices recognize the PIN, the router provides the security and configuration information to the 
printer, which uses it to connect to the network. 

To connect to a WPS wireless network using the PBC method: 

Note: Before you install the device, ensure that the wireless router is configured properly and is 
connected to the network. 

1. At the printer control panel, press the Home button. 
2. Touch Device > Connectivity > Wi-Fi. 
3. If Wi-Fi is Off, turn it on. 

a. To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button. 
b. To activate your Wi-Fi setting changes, press the Home button. 
c. At the prompt, touch Restart Now. 
d. After the printer restarts, touch Device > Connectivity > Wi-Fi. 

4. Touch Manual Setup. 
5. Touch Wi-Fi Protected Setup (WPS). 

Note: If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch Manual Setup. 

6. Touch PBC. 
7. Touch OK. 
8. On the wireless router, press the WPS button. 

The router broadcasts setup information for 120 seconds. 

Note: If the wireless router does not have a physical PBC button, use your computer to select the 
virtual button in the router control panel. For details, refer to your router documentation. 

9. To activate your Wi-Fi setting changes, restart the printer. 
a. Press the Home button. 
b. At the prompt, touch Restart Now. 

10. After the printer restarts, wait two minutes, then to get the network information that includes the 
IP address, print a Configuration Report. For details, refer to Printing the Configuration Report on 
page 32. 
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To connect to a WPS wireless network using the PIN method: 

Note: Before you install the printer, ensure that you connect and configure the wireless router for 
the network. 

1. At the printer control panel, press the Home button. 
2. If Wi-Fi is Off, turn it on. 

a. Touch Device > Connectivity > Wi-Fi. 
b. To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button. 
c. To activate your Wi-Fi setting changes, press the Home button. 
d. At the prompt, touch Restart Now. 

Note: The following steps can vary with different router manufacturers. For details, refer to your 
router documentation. 

3. At your computer, open the wireless router control panel, then select Add WPS Client. 
4. Select PIN Method. The wireless router control panel opens to a dialog box ready for the PIN 

number. 
5. At the printer control panel, touch Device > Connectivity > Wi-Fi. 
6. Touch Manual Setup. 
7. Touch Wi-Fi Protected Setup (WPS). 

Note: If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch Manual Setup. 

8. Touch PIN. 
9. Record the PIN from the screen, then touch OK. 

The printer starts advertising using the displayed PIN Code. 

Note: The printer continues to advertise for 120 seconds. If the printer does not locate the wireless 
router within 120 seconds, the connection attempt stops. 

10. At your computer, in the wireless router control panel Client PIN Code field, enter the PIN code, then 
click Next. 
The printer communicates with the wireless router to resolve setup and configuration information. 
When the printer has the correct information, it connects to the router and restarts with the proper 
setup and configuration information. 
If the router does not connect with the printer within 120 seconds, the connection attempt stops. 

11. After the printer restarts, wait 20 seconds, then to get the network information that includes the 
IP address, print a Configuration Report. For details, refer to Printing the Configuration Report on 
page 32. 
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Connecting to a Wireless Network Manually 

When connecting to a wireless network that does not include a WPS-compliant router, set up and 
configure the printer manually. Before starting, obtain the router setup and configuration information, 
such as name and passphrase. For assistance, contact your system administrator. 

To connect to a wireless network manually: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Connectivity > Wi-Fi. 
3. If Wi-Fi is Off, turn it on. 

a. To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button. 
b. To activate your Wi-Fi setting changes, press the Home button. 
c. At the prompt, touch Restart Now. 
d. After the printer restarts, touch Device > Connectivity > Wi-Fi. 

4. To connect to a network: 
− Touch the name of the network, enter the password for the selected network, then touch OK. 
− If the desired network does not appear, touch Manual Setup, then configure the wireless 

network settings. 
• For Enter the Network Name (SSID), type the name (SSID) of your network, then press OK. 
• Touch Security, then select the security method that your wireless network uses. 
• Touch Enter Password, then enter the password for your wireless network. 
• Touch OK. 

5. To activate your Wi-Fi setting changes, press the Home button. 
6. At the prompt, touch Restart Now. 
7. After the printer restarts, wait two minutes, then to get the network information that includes the 

IP address, print a Configuration Report. For details, refer to Printing the Configuration Report on 
page 32. 

 

Connecting to Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. Wi-Fi Direct is disabled by default. For details, refer to Configuring Wi-Fi Direct on 
page 229. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

 

Connecting with Wi-Fi Direct from Your Mobile Device 

To connect with Wi-Fi Direct, follow the directions provided with your mobile device. 
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Connecting to a Telephone Line 
 

 WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 

 

1. Ensure that the printer is powered off. 
2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on 

the back of the printer. 
3. Connect the other end of the RJ11 cable to an operating telephone line. 
4. Power on the printer. 
5. Enable and configure the Fax functions. 

For reference:  
Configuring Fax Defaults and Settings on page 161. 
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Powering the Printer On and Off 

The printer has a single multifunction button on the control panel. The Power/Wake button restarts, 
powers up, or powers down the printer. This button also enters and exits low-power mode, and flashes 
when the printer is in power-saver mode. 

To power on the printer, or to exit Low-Power mode or Sleep mode, press the Power/Wake button. 

 
Notes: 

• The Power/Wake button is the only power switch on the printer. 
• The printer exits Low-Power mode or Sleep mode automatically when it receives data from a 

connected device. 
• When in Low-Power mode, or Sleep mode, the touch screen is turned off and unresponsive. 

To wake the printer manually, press the Power/Wake button. 

To restart, place the printer in Sleep Mode, or power off the printer: 
1. At the printer control panel, press the Power/Wake button. 

 
2. Select an option. 

− To restart the printer, touch Restart. At the prompt, touch Restart. 
− To place the printer in Sleep Mode, touch Sleep. 

In Sleep Mode, the touch screen is powered off and the Power/Wake button flashes. 
− To power off the printer, touch Power Off. 
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3. If the printer does not respond to a single press of the Power/Wake button, press and hold the 
button for 5 seconds. A message appears that requests you to wait for the printer to power off. 
After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the printer 
has completed the power off process. 

 

 CAUTION: Do not plug or unplug the power cord when the printer is powered on. 

 
 

Installation Wizard 

The Installation wizard starts the first time you power on the printer. The wizard prompts you with a 
series of questions to help you configure basic printer settings. 

Note: You can change these settings at any time. 
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Configuring Network Settings 

This section includes: 
• About TCP/IP and IP Addresses ....................................................................................................................................... 54 
• Assigning the Printer IP Address ...................................................................................................................................... 54 
 
 

About TCP/IP and IP Addresses 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a 
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour 
does not require printers or computers to have IP addresses. 

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and 
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically assigns an IP address to every computer and printer on the network that is configured 
to use DHCP. 

If you use a Cable or DSL router, refer to the documentation for your router for information on IP 
addressing. 
 

Assigning the Printer IP Address 

By default, the printer is configured to acquire an IP address from the network server using DHCP. 
Network addresses assigned by DHCP are temporary, however. After a specified time, the network can 
assign a new IP address to the printer. If the print driver is configured to use a specific IP address that 
changes periodically, you can experience connectivity issues. To avoid problems, or if your network 
administrator requires a static IP address for the printer, you can assign the IP address to the printer. 

You can view the IP address of your printer on the control panel or on the Configuration Report. 
For details, refer to Finding the IP Address of Your Printer on page 33. 

For reference:  
Assigning the IP Address Manually on page 231 
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Assigning the IP Address Automatically 
1. At the printer control panel, press the Home button. 
2. Touch Device > Connectivity > Ethernet > IPv4. 
3. To enable IPv4, touch the Enable IPv4 toggle button. 
4. To allow your DHCP server to assign an IP address to the printer, touch DHCP, then touch OK. 

Note: For best results on most networks, enable DHCP. This option enables Dynamic DNS 
Registration. 

5. To save the settings, touch OK. 
6. Press the Home button. 
7. For the settings to take effect, at the prompt, touch Restart Now. 
8. Two minutes after the printer restarts, verify that the printer has obtained a valid IP Address. 

For details, refer to Finding the IP Address of Your Printer on page 33. 
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Configuring AirPrint 

AirPrint is a software feature that allows you to print from wired or wireless Apple iOS-based mobile 
devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers 
allow you to print or fax directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print 
from a wired device or a wireless device without using a print driver. 

 
Notes: 

• Not all applications support AirPrint. 
• Wireless devices must join the same wireless network as the printer. 
• For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled. 
• The device that submits the AirPrint job must be on the same subnet as the printer. To allow 

devices to print from different subnets, configure your network to pass multicast DNS traffic 
across subnets. 

• The Mac OS device must be Mac OS 10.7 or later. 
• AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch 

(3rd generation or later), running the latest version of iOS. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, click Home > Connectivity. 

Note: If this feature does not appear, log in as a system administrator. For details, refer to Logging 
In as the Administrator on page 265. 

3. For Mobile Printing, click AirPrint™. 
4. To enable AirPrint™, click the Enable toggle button. 

Note: AirPrint™ is enabled by default when IPP and Bonjour (mDNS) are both enabled. 

− To change the printer name, in the Name field, enter a new name. 
− To enter a location for the printer, in the Location field, enter the location of the printer. 
− To enter a physical location or address for the printer, in the Geo-Location field, enter the 

geographic latitude and longitude coordinates in decimal form. For example, use coordinates 
such as 45.325026, -122.766831 for a location. 

5. Click OK. 
6. To activate your changes, at the prompt, click Restart Now. 
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Google Cloud Print 

Google Cloud Print allows you to print documents that are stored in the cloud without using a print 
driver. 

Before you begin: 
• Set up a Google email account. 
• Configure the printer to use IPv4. 
• Configure Proxy Server settings as needed. 

To configure Google Cloud Print: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, click Home > Connectivity. 
3. For Mobile Printing, click Google Cloud Print. 
4. To enable Google Cloud Print, click the Enable toggle button. 
5. Click OK. 
6. Restart the printer, then wait two minutes for the printer to connect. 
7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print. 
8. Click Printer Registration. 
9. Click Register. 

A printer registration page prints. 
10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to 

scan the barcode. 
Once the printer is registered, the word Registered appears in the printer status. 

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer. 

Note: The default printer name appears in this format: Model name (MAC address). 
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Configuring General Setup Using the 
Control Panel 

This section includes: 
• Accessing Information About the Printer Using the Control Panel ................................................................. 58 
• Displaying or Hiding Installed Apps ............................................................................................................................... 58 
 
 

Accessing Information About the Printer Using the Control Panel 

To view information about the printer: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About. 
3. To return to the Home screen, press the Home button. 

To print information about the printer: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. To print a specific information page, touch the desired report. 
4. To return to the Home screen, press the Home button. 
 

Displaying or Hiding Installed Apps 
1. At the printer control panel, press the Home button. 
2. Touch Customize. 
3. To display an installed, but hidden App: 

a. Touch +. 
b. Touch the App that you want to appear on the control panel. 
c. Touch Done. 

4. To hide an installed App: 
a. For the desired App, touch X. 
b. Touch Done. 

5. Verify that only the desired Apps are displayed on the Home screen. 
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Configure the Fax Defaults and Settings 

It is unlawful to send a message from a fax machine without the proper Fax Send Header information. 
The following information must appear on the first transmitted page, or in the top or bottom margin of 
each transmitted page: 
• Identity of the business or individual sending the fax 
• Telephone number of the sending machine 
• Date and time of the transmission 

The Installation wizard starts the first time you power on the printer. The wizard prompts you with a 
series of questions to guide you through initial configuration of the printer and includes configuration 
of Fax settings and defaults. At any time, you can configure the Fax settings and defaults at the printer 
control panel or in the Embedded Web Server. For details, refer to Configuring Fax Defaults and Settings 
on page 161. 
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Installing the Software 

This section includes: 
• Operating System Requirements .................................................................................................................................... 60 
• Installing the Print Drivers for a Windows Network Printer ................................................................................. 61 
• Installing the Print Drivers for a Windows USB Printer ......................................................................................... 61 
• Installing the Drivers and Utilities for Macintosh OS X ......................................................................................... 62 
• Installing Drivers and Utilities for UNIX and Linux ................................................................................................. 65 
• Installing the Printer as a Web Service on Devices ................................................................................................. 66 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If 
you cannot find the IP address, refer to Finding the IP Address of Your Printer on page 33. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/WC6515drivers. 
 
 

Operating System Requirements 
• Windows Vista, Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 

R2, and Windows Server 2012. 
• Macintosh OS X version 10.9 and later. 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. 
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Installing the Print Drivers for a Windows Network Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the 

installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer 
file. 

2. Select your printer model. 
3. Click Install Drivers. 
4. Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers. 
5. At the License Agreement, click I Agree. 
6. From the list of discovered printers, select your printer. 

Note: When installing drivers for a network printer, if your printer does not appear in the list, click 
the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of 
your printer, then click Search to locate and select your printer. If you do not know the IP address of 
the printer, refer to Finding the IP Address of Your Printer on page 33. 

7. Click Next. 
8. If desired, you can name your printer by typing a name in the Queue Name field. 
9. If installing a print driver, make a print driver selection. 
10. If installing a scan driver, make a scan driver selection. 
11. Click Install. 
12. If desired, set the printer as the default printer. 

Note: Before selecting Share Printer, contact your system administrator.  

13. To complete the installation, click Finish, then click Close. 
 

Installing the Print Drivers for a Windows USB Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. To install the printer support software, select Software, then click Next. 
5. In the Software and Documentation window, clear the check box for any undesired options. 
6. Click Next. 
7. To complete the installation, click Finish. 
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Installing the Drivers and Utilities for Macintosh OS X 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer. 
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name. 
4. When prompted, click Continue. 
5. To accept the license agreement, click I Agree. 
6. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
7. If prompted, enter your password, then click OK. 
8. From the list of discovered printers, select your printer, then click Next. 
9. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

10. If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is 
connected properly. 

11. To accept the print queue message, click OK. 
12. Select or clear the Set Printer as Default and Print a Test Page check boxes. 
13. Click Continue, then click Close. 
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Adding the Printer 

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your 
printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection. 

To add the printer using Bonjour: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
3. Under the list of printers, click the plus button (+). 
4. At the top of the window, click the Default icon. 
5. Select your printer from the list, then click Add. 

Note: If your printer was not detected, verify that the printer is on and that the Ethernet cable is 
connected properly. 

To add the printer by specifying the IP address: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
3. Under the list of printers, click the plus button (+). 
4. Click IP. 
5. From the Protocol drop-down menu, select the protocol. 
6. In the Address field, enter the IP address of the printer. 
7. In the Name field, enter a name for the printer. 
8. From the Print Using drop-down list, choose Select a driver to use. 
9. From the printer software list, select the print driver for your printer model. 
10. Click Add. 
 

For reference:  
Online Support Assistant at: www.xerox.com/office/WC6515support  
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Installing Scan Drivers for Macintosh 
1. Insert the Software and Documentation disc into your computer. 
2. Double-click the disc icon on your desktop to view the .dmg file for your printer. 
3. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating 

system. 
4. Open the Scan Installer package file. 
5. Click Continue to acknowledge the warning and introductory messages. 
6. To accept the license agreement, click Continue, then click Agree. 
7. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click OK. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. Click Continue Installation. 
11. To restart, click Log Out. 
 

Installing LAN Fax Drivers for Macintosh 
1. Insert the Software and Documentation disc into your computer. 
2. Double-click the disc icon on your desktop to view the .dmg file for your printer. 
3. Open the LAN Fax Installer.dmg file, then navigate to the appropriate installer file for your 

operating system. 
4. Open the LAN Fax Installer package file. 
5. Click Continue to acknowledge the warning and introductory messages. 
6. To accept the license agreement, click Continue, then click Agree. 
7. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click OK. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. Click Continue Installation. 
11. To finish, click Close. 
12. To register your printer and software, complete the registration form. 
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Adding a LAN Fax Printer for Macintosh 

After installing the LAN fax driver on a Macintosh computer, use Bonjour to set up your printer. You can 
also add the printer using the IP Address of the printer for an LDP/LPR connection. For non-network 
printers, create a desktop USB connection. 

To add the printer using Bonjour: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
3. Under the list of printers, click the plus button (+). 
4. At the top of the window, click the Default icon. 
5. Select your printer from the list, then click Add. 

Note: If the printer is not detected, ensure that the printer is on and that the cable is connected 
properly. 

6. In the Print Using drop-down list, choose Select Printer Software. 
7. In the printer software list, select the appropriate Xerox® LAN fax driver model, then click OK. 
8. Click Add. 

To add the printer by specifying the IP address: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
3. Under the list of printers, click the plus button (+). 
4. Click IP. 
5. From the Protocol drop-down menu, select the Protocol. 
6. In the Address field, enter the IP address of the printer. 
7. In the Name field, enter the name of the printer. 
8. In the Print Using drop-down list, choose Select Printer Software. 
9. In the printer software list, select the appropriate Xerox® LAN fax driver model, then click OK. 
10. Click Add. 
 

Installing Drivers and Utilities for UNIX and Linux 

For details on installing print drivers and utilities for UNIX and Linux, refer to UNIX and Linux Printing on 
page 98. 
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Installing the Printer as a Web Service on Devices 

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated 
services across a network. WSD supports device discovery, control, and use. 

To install a WSD printer using the Add Device Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Device Wizard, click Add a Device. 
3. In the list of available devices, select the one you want to use, then click Next. 

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the 
WSD printer manually using the Add Printer Wizard. 

4. Click Close. 

To install a WSD printer using the Add Printer Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Printer Wizard, click Add a Printer. 
3. Click Add a network, wireless, or Bluetooth printer. 
4. In the list of available devices, select the one you want to use, then click Next. 
5. If the printer you want to use does not appear in the list, click The printer that I want is not listed. 
6. Select Add a printer using a TCP/IP address or hostname, then click Next. 
7. From the Device type field, select Web Services Device. 
8. Enter the printer IP address in the Hostname or IP address field, then click Next. 
9. Click Close. 
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Supported Paper 

This section includes: 
• Recommended Media .......................................................................................................................................................... 68 
• Ordering Paper ......................................................................................................................................................................... 68 
• General Paper Loading Guidelines.................................................................................................................................. 68 
• Paper That Can Damage Your Printer .......................................................................................................................... 69 
• Paper Storage Guidelines.................................................................................................................................................... 69 
• Supported Paper Types and Weights ............................................................................................................................ 70 
• Supported Standard Paper Sizes ..................................................................................................................................... 70 
• Supported Paper Types and Weights for Automatic 2-Sided Printing ........................................................... 71 
• Supported Custom Paper Sizes......................................................................................................................................... 71 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 
 

Recommended Media 

A list of paper and media recommended for your printer is available at: 
• www.xerox.com/rmlna Recommended Media List (United States). 
• www.xerox.com/rmleu Recommended Media List (Europe). 
 

Ordering Paper 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6515supplies. 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or 
gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 
 

Trays Paper Types Weights 

All Trays 
 

Recycled 60–80 g/m² 

Custom 60–90 g/m² 

Bond 
Hole-Punched 
Letterhead 
Plain 
Pre-Printed 

75–105 g/m² 

Lightweight Cardstock 
Lightweight Glossy Cardstock 

106–176 g/m² 

Cardstock 
Glossy Cardstock 

177–220 g/m² 

Tray 1 and 
Bypass Tray 

Envelope 
Labels 

 

 

Note: For the Single-Pass Duplex Automatic Document Feeder, refer to Single-Pass Automatic 
Document Feeder Guidelines on page 121. 

 

Supported Standard Paper Sizes 
 

Tray European Standard Sizes North American Standard Sizes 

Tray 1 and 
Bypass Tray 

A6 (105 x 148 mm, 4.1 x 5.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
215 x 315 mm, 8.5 x 12.4 in. 
DL Envelope (110 x 220 mm, 4.33 x 8.66 in.) 
C6 Envelope (114 x 162 mm, 4.5 x 6.38 in.) 

Postcard (102 x 152 mm, 4 x 6 in.) 
127 x 178 mm, 5 x 7 in. 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
203 x 254 mm, 8 x 10 in. 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Monarch Envelope (98 x 190 mm, 3.9 x 7.5 in.) 
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.) 

Tray 2 A5 (148 x 210 mm, 5.8 x 8.3 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 

Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
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Supported Paper Types and Weights for Automatic 2-Sided Printing 
 

Paper Type Weight 

Recycled 60–80 g/m² 

Custom 60–90 g/m² 

Bond 
Hole-Punched 
Letterhead 
Plain 
Pre-Printed 

75–105 g/m² 

Lightweight Cardstock 
Lightweight Glossy Cardstock 

106–176 g/m² 

 
 

Supported Custom Paper Sizes 
 

Tray Number Paper Sizes 

Tray 1 Minimum: 76 x 148 mm (3 x 5.8 in.) 
Maximum: 216 x 356 mm (8.5 x 14 in.) 

Tray 2 Minimum: 76 x 191 mm (3 x 7.5 in.) 
Maximum: 216 x 356 mm (8.5 x 14 in.) 

Bypass Tray Minimum: 76 x 127 mm (3 x 5 in.) 
Maximum: 216 x 356 mm (8.5 x 14 in.) 

2-Sided Printing, DN model only Minimum: 140 x 210 mm (5.5 x 8.3 in.) 
Maximum: 216 x 356 mm (8.5 x 14 in.) 
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Loading Paper 

This section includes: 
• Loading Paper in the Bypass Tray................................................................................................................................... 72 
• Configuring Trays 1 or 2 for the Paper Length ......................................................................................................... 75 
• Loading Paper in Trays 1 and 2 ....................................................................................................................................... 77 
• Setting the Tray Mode ......................................................................................................................................................... 80 
 
 

Loading Paper in the Bypass Tray 
1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a 

different size or type. 

 

2. Pull out the extension tray for larger sizes. 

 

72 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



Paper and Media 

 

3. Move the width guides to the edges of the tray. 

 

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

5. Load the paper in the tray. Load hole-punched paper with the holes to the left. 

 

− For 1-sided printing, load Letterhead or pre-printed paper face up with the top edge going into 
the printer first. 
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− For 2-sided printing, load Letterhead and pre-printed paper face down with the top edge going 
into the printer first. 

Note: Do not load paper above the maximum fill line on the width guides. Overfilling the tray can 
cause the printer to jam. 

 

6. Adjust the width guides until they touch the edges of the paper. 

 

7. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type and size. 
a. If the paper size and type are correct, touch OK. 
b. If the paper size or type are incorrect, change the settings. 

• To select a sheet size, touch the current size setting, then from the list, select the size. 
• To select a paper type, touch the current paper type, then from the list, select the type. 
• To save the settings, touch OK. 

8. If no prompt appears when paper is loaded, set the paper type and size. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. To open the Bypass Tray menu, touch the Bypass Tray icon. It is displayed in the top position, 

before the numbered trays. 
d. To select a paper or envelope size, touch the current size setting, then from the list, select a size. 
e. To select a paper type, touch the current paper type, then from the list, select a paper type. 
f. To save the setting, touch OK. 

9. To return to the Home screen, press the Home button. 
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Configuring Trays 1 or 2 for the Paper Length 

You can adjust the lengths of trays 1 and 2 to accommodate A4/Letter and Legal paper sizes. In the 
Legal length settings, the trays protrude from the front of the printer. 

To change Trays 1 and 2 to match the paper length: 
1. Remove all paper from the tray. 
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 

 

3. Set Up the Tray. 
− To compress the tray for shorter paper, hold the back of the tray with one hand. With the other 

hand, press the release latch at the front of the tray, then push the ends inward until they latch. 

 

− To extend the tray for longer paper, hold the back of the tray with one hand. With the other 
hand, press the release latch at the front of the tray and pull the ends outward until they latch. 
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To protect the paper when the tray is extended, place the paper cover over the extended 
section of the paper tray. 

 

Note: If the tray is extended for Legal-size paper, the tray protrudes when it is inserted into the 
printer. 

 

4. Load paper into the tray before inserting it back into the printer. For details, refer to Loading Paper 
into Trays 1 and 2 on page 77. 
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Loading Paper in Trays 1 and 2 
1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 

 

2. Adjust the paper length and width guides to fit the paper size. 

 

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 
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4. Load paper into the tray with the print side face up. 
− Load hole punched paper with the holes to the left. 
− For 1-sided printing, load letterhead face up with the top of the paper toward the back of the 

tray. 
− For 2-sided printing, load letterhead face down with the top of the paper toward the back of 

the tray. 

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

 

5. Adjust the paper length and width guides until they touch the edges of the paper. 

 

6. Slide the tray back into the printer. 
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7. Push the tray in all the way. 

Notes: 

• If the tray does not go all the way in, ensure that the paper lift at the back of the tray is locked 
down. 

• To avoid paper jams, do not remove the paper cover while printing is in progress. 
• If the tray is extended for legal size paper, the tray protrudes when it is inserted into the 

printer. 

 

8. If the control panel prompts you, verify the size and type on the screen. If you are not prompted, 
change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the desired tray. 
d. To configure the printer to prompt you to set the paper type and size when paper is loaded, 

touch Tray Mode, then touch Fully Adjustable. 
e. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated. 

• To select a paper or envelope size, touch the current size setting, then from the list, select 
the size. 

• To select a paper type, touch the current paper type, then from the list, select the paper 
type. 

• To select a paper color, touch the current paper color, then from the list, select the paper 
color. 

f. To save the setting, touch OK. 
9. To return to the Home screen, press the Home button. 
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Setting the Tray Mode 

Tray mode determines if you are prompted to confirm or modify paper settings when you load paper in 
the tray. Tray mode also defines how the printer behaves when a paper conflict or mismatch occurs. 

To configure the Bypass Tray Mode: 
1. At the printer control panel, press the Home button. 
2. Touch the Device > Paper Trays. 
3. Touch the Bypass Tray icon. It is displayed in the top position, before the numbered trays. 
4. Touch Tray Mode. 
5. Touch the desired mode: 

− Fully Adjustable prompts you to confirm or modify paper tray settings when paper is loaded in 
the Bypass Tray. 

− Bypass prompts you to confirm or modify paper tray settings when paper is loaded in the 
Bypass Tray. It also sets the Bypass Tray as the default tray for all print jobs without a specified 
tray. 

6. To save the setting, touch OK. 
7. To return to the Home screen, press the Home button. 

To configure the Tray 1 and 2 Tray Mode: 
1. At the printer control panel, press the Home button. 
2. Touch the Device > Paper Trays. 
3. Touch the desired tray. 
4. Touch Tray Mode. 
5. Touch the desired mode: 

− Fully Adjustable prompts you to confirm or modify paper tray settings when paper is loaded in 
a tray. 

− Dedicated uses the current paper size and type settings and does not prompt you to confirm or 
modify the settings. Use this setting to use a tray for printing on a specific paper type and size, 
such as letter-size or hole-punched paper. 

6. To save the setting, touch OK. 
7. To return to the Home screen, press the Home button. 
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Printing on Special Paper 

This section includes: 
• Envelopes ................................................................................................................................................................................... 81 
• Labels ........................................................................................................................................................................................... 87 
• Glossy Cardstock ..................................................................................................................................................................... 91 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6515supplies. 
 

For reference:  
www.xerox.com/rmlna Recommended Media List (United States) 
www.xerox.com/rmleu Recommended Media List (Europe) 
 

 
 

Envelopes 

You can print envelopes from Tray 1 or the bypass tray. 
 

Guidelines for Printing Envelopes 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
• Print quality depends on the quality and construction of the envelopes. If you do not get the desired 

results, try another envelope brand. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
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Loading Envelopes in the Bypass Tray 
1. Open the bypass tray. 

 

2. Move the width guides to the edges of the tray. 

 
Notes: 

• Do not load more than five envelopes in the Bypass Tray. 
• If you do not load envelopes in the bypass tray right after they have been removed from the 

packaging, they can bulge. To avoid jams, flatten the envelopes. 
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3. To load the envelopes, select an option: 
− For Number 10 envelopes, load the envelopes with the short edge going into the printer first, 

flaps down, and flaps to the right. 

 

− For Monarch or DL envelopes, do one of the following. If the envelopes wrinkle, try another 
option. 
• Load Envelopes with the short edge going into the printer first, flaps down, and flaps to 

the right. 

 

• Load Envelopes with the print side up, flaps open and down, and the bottom of the 
envelope going into the printer first. 
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• Load Envelopes with the print side up, flaps closed and down, and flaps going into the 
printer first. 

 

− For C5 envelopes, do one of the following. If the envelopes wrinkle, try another option. 
• Load Envelopes with the print side up, flaps open and down, and the bottom of the 

envelope going into the printer first. 

 

• Load Envelopes with the print side up, flaps closed and down, and going into the printer 
first. 

 

Note: When you load envelopes with the flaps open, in the print driver, select Portrait, Landscape, 
or Rotated Landscape, as needed, to have them print correctly. In the print driver, use Rotate 
Image 180 Degrees to flip the image, if needed. 
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4. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type and size. 
a. If the paper size and type are correct, touch OK. 
b. If the paper size or type are incorrect, change the settings. 

• To select a sheet size, touch the current size setting, then from the list, select the size. 
• To select a paper type, touch the current paper type, then from the list, select the type. 
• To save the settings, touch OK. 

5. If no prompt appears when paper is loaded, set the paper type and size. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. To open the Bypass Tray menu, touch the Bypass Tray icon. It is displayed in the top position, 

before the numbered trays. 
d. To select a paper or envelope size, touch the current size setting, then from the list, select a size. 
e. To select a paper type, touch the current paper type, then from the list, select a paper type. 
f. To save the setting, touch OK. 

6. To return to the Home screen, press the Home button. 
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Loading Envelopes in Tray 1 
1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 

 

2. Adjust the paper length and width guides as illustrated. 

 
3. Load envelopes in the trays with the flaps closed, flap-side down, and the short edge leading into 

the printer. 

Note: Do not load more than 20 envelopes. 

4. Slide the tray back into the printer. 
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5. Push the tray in all the way. 
6. If the control panel prompts you, verify the size and type on the screen. If you are not prompted, 

change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the desired tray. 
d. To configure the printer to prompt you to set the paper type and size when paper is loaded, 

touch Tray Mode, then touch Fully Adjustable. 
e. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated. 

• To select a paper or envelope size, touch the current size setting, then from the list, select 
the size. 

• To select a paper type, touch the current paper type, then from the list, select the paper 
type. 

• To select a paper color, touch the current paper color, then from the list, select the paper 
color. 

f. To save the setting, touch OK. 
7. To return to the Home screen, press the Home button. 
 

Labels 

You can print labels from the bypass tray or Tray 1. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Before loading labels, remove all other paper from the tray. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 
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Loading Labels in the Bypass Tray 
1. Remove all paper from the tray. 

 
2. Load Labels in the bypass tray, face up, with the top edge of the page feeding into the printer first. 
3. Adjust the width guides until they touch the edges of the paper. 

 

4. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type and size. 
a. If the paper size and type are correct, touch OK. 
b. If the paper size or type are incorrect, change the settings. 

• To select a sheet size, touch the current size setting, then from the list, select the size. 
• To select a paper type, touch the current paper type, then from the list, select the type. 
• To save the settings, touch OK. 

5. If no prompt appears when paper is loaded, set the paper type and size. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. To open the Bypass Tray menu, touch the Bypass Tray icon. It is displayed in the top position, 

before the numbered trays. 
d. To select a paper or envelope size, touch the current size setting, then from the list, select a size. 
e. To select a paper type, touch the current paper type, then from the list, select a paper type. 
f. To save the setting, touch OK. 

6. To return to the Home screen, press the Home button. 
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Loading Labels in Tray 1 
1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 

 

2. Adjust the paper length and width guides as illustrated. 

 

3. Load labels in the tray, face up. 

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams. 
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4. Slide the tray back into the printer. 

 

5. Push the tray in all the way. 
6. If the control panel prompts you, verify the size and type on the screen. If not, change the paper 

settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the desired tray. 
d. To configure the printer to prompt you to set the paper type and size when paper is loaded, 

touch Tray Mode, then touch Fully Adjustable. 
e. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated. 

• To select a paper or envelope size, touch the current size setting, then from the list, select 
the size. 

• To select a paper type, touch the current paper type, then from the list, select the paper 
type. 

• To select a paper color, touch the current paper color, then from the list, select the paper 
color. 

f. To save the setting, touch OK.ave the setting, touch OK. 
7. To return to the Home screen, press the Home button. 
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Glossy Cardstock 

You can print Cardstock and Glossy Cardstock up to 220 g/m² from any tray. For 2-Sided printing on 
cardstock, refer to Supported Paper Types and Weights for Automatic 2-Sided Printing on page 71. 
 

Guidelines for Printing on Glossy Cardstock 
• Do not open sealed packages of glossy cardstock until you are ready to load them into the printer. 
• Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until 

ready to use. 
• Remove all other paper from the tray before loading glossy cardstock. 
• Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in 

the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal. 
• Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to 

curl and jam in the printer. 
• In the print driver software, select the desired glossy cardstock type or select the tray loaded with 

the desired paper. 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure 
that you have the correct print driver software installed on your computer. For details, refer to Installing 
the Software on page 60. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type. 
3. Access the print settings in your software application. For most software applications, press CTRL+P 

for Windows, or CMD+P for Macintosh. 
4. Select your printer. 
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® 

Features for Macintosh. The title of the button can vary depending on your application. 
6. Modify the print driver settings as necessary, then click OK. 
7. Click Print to send the job to the printer. 
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Selecting Printing Options 

This section includes: 
• Print Driver Help ...................................................................................................................................................................... 95 
• Windows Printing Options .................................................................................................................................................. 96 
• Macintosh Printing Options ............................................................................................................................................... 98 
• UNIX and Linux Printing ..................................................................................................................................................... 98 
• Mobile Printing Options .................................................................................................................................................... 100 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printing Preferences become the default 
setting. Printing options that are set from within the software application are temporary. The application 
and the computer do not save the settings after the application is closed. 
 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window. From there, you can select by topic 
or use the search field to enter the topic or function for which you need information. 
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Windows Printing Options 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, you can change the Printing Preferences before 
sending the job to the printer. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File > Print or press CTRL+P for Windows. 
2. Select your printer and click the Properties or Preferences button to open the Printing Preferences 

window. The title of the button can vary depending on your application. 
3. Click a tab in the Printing Preferences window, then make selections. 
4. Click OK to save and close the Printing Preferences window. 
5. Click Print to send the job to the printer. 
 
 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. Navigate to the list of printers on your computer: 

− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2008 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, right-click the Start Menu, then click Control Panel > Devices and Printers. 
− For Windows 10, right-click the Start Menu, then click Start > Control Panel > Devices and 

Printers. 

Note: If you are using a custom Start Menu application, it can change the navigation path to your 
list of printers. 

2. In the list, right-click the icon for your printer and click Printing Preferences. 
3. In the Printing Preferences window, click a tab, select the options, then click OK to save. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 
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Selecting Printing Defaults in Windows for a Shared Network Printer 
1. Navigate to the list of printers on your computer: 

− For Windows Vista®, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2008 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 
− For Windows 10, click Start > Control Panel > Devices and Printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then 
select Personalize > Control Panel Home > Devices and Printers. 

2. In the Printers folder, right-click the name of your print driver and select Printer properties. 
3. In the printer Properties dialog box, click the Advanced tab. 
4. On the Advanced tab, click Printing Defaults. 
5. Make your selections on the print driver tabs as needed, then click Apply. 
6. To save the settings, click OK. 
 

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences. 
3. In the Printing Properties window, click the tabs, then select the desired settings 
4. In the Printing Properties window, click Saved Settings, then click Save As. 
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, 

then click OK. 
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Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer. 
3. Select Xerox® Features from the Copies & Pages menu. 
4. Select the desired printing options from the drop-down lists. 
5. Click Print to send the job to the printer. 
 
 

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the desired printing options from the drop-down lists in the Print dialog box. 
4. Click Presets > Save As. 
5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 
6. To print using these options, select the name from the Presets list. 
 
 

UNIX and Linux Printing 

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux 
environments. 

The Xerox® print drivers provide a GUI-based driver dialog for printer feature selections. You can select 
print drivers based on your operating system. 
 

Xerox® Printer Manager 

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in 
UNIX and Linux environments. 

Xerox® Printer Manager allows you to: 
• Configure and check the status of network connected printers. 
• Set up a printer on your network as well as monitor the operation of the printer once installed. 
• Perform maintenance checks and view supplies status at any time. 
• Provide a common look and feel across the many different suppliers of UNIX and Linux operating 

systems. 
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Installing the Xerox® Printer Manager 

Before you begin: 

Ensure that you have root or superuser privileges to install Xerox® Printer Manager. 

To install the Xerox® Printer Manager: 
1. Download the appropriate package for your operating system. To locate print drivers for your 

printer, go to www.xerox.com/office/drivers. 
2. On the print driver website, navigate to your printer model. 
3. For your printer model, click Drivers & Downloads. 
4. From the Operating System menu, select your operating system. 
5. To identify the print driver for your printer model, review the list of available print drivers. 

Note: For additional information on each driver, click Description. 

6. To select the print driver for your printer model and operating system, click its name. 
7. To begin the download, read the End User License Agreement, then click accept. 

The file automatically downloads to the default location for your computer file downloads. 
8. To install the Xerox® Print Driver package: 

a. Open the package with your OS package manager. 
b. To install using a command-line utility, change to the directory where you downloaded the file. 

To run the installer, type the appropriate command-line utility for your operating system. 
For example: 
• Red Hat: rpm -U <filename>.rpm 
• Debian-based Linux: dpkg -i <filename>.deb 
• AIX: rpm -U <filename>.rpm 
• HPUX: <filename>.depot.gz  
• Solaris: pkgadd -d <filename>.pkg 

Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information 
about utilities included in the OS package manager, refer to the manual included with the package. 
For example, man xeroxprtmgr. 

 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager, do one of the following tasks. 
• For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return. 
• For Linux, type sudo xeroxprtmgr, then press Enter or Return. 
 

Printing with xeroxprint 

Xerox has its own print command. You can use the following command: 

xeroxprint -d<Some_Queue> -o[Options] <Somefile> 
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Printing from a Linux Workstation 

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS print driver. 
You do not need both drivers. 

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate 
drivers for your printer, go to www.xerox.com/office/drivers. 

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for 
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and 
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer 
to the CUPS Software Users Manual available from www.cups.org/documentation.php. 
 

Installing the PPD on the Workstation 
1. If available, download the Xerox® PPD for CUPS from the Drivers and Downloads page on the Xerox 

Support website. 
2. Copy the PPD into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location 

of the folder, use the Find command to locate the PPD files. 
3. Follow the instructions that are included with the PPD. 
 

Adding the Printer 
1. Verify that the CUPS daemon is running. 
2. Open a Web browser and type http://localhost:631/admin, then click Enter or Return. 
3. For User ID, type root. For password, type the root password. 
4. Click Add Printer and follow the onscreen prompts to add the printer to the CUPS printer list. 
 

Printing with CUPS 

CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands. 
1. To print to a specific printer in System V, type: lp -dprinter filename, then click Enter. 
2. To print to a specific printer in Berkeley, type: lpr -Pprinter filename, then click Enter. 
 

Mobile Printing Options 

This printer can print from iOS and Android mobile devices. 
 

Printing with Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. 

For details, refer to Connecting with Wi-Fi Direct on page 50. 

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device. 

Note: Depending on which mobile device you are using, the printing procedure varies. 
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Printing with AirPrint 

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint. To enable AirPrint for 
your printer, refer to Configuring AirPrint on page 56. To use AirPrint, ensure that your mobile device is 
connected to the wireless network. 

To print with AirPrint: 
1. Open the email, photograph, website page, or document that you want to print. 
2. Tap the Action icon. 
3. Tap Print. 
4. Select your printer, then set the printer options. 
5. Tap Print. 
 

Printing from a Mopria-Enabled Mobile Device 

Mopria is a software feature that enables users to print from mobile devices without requiring a print 
driver. You can use Mopria to print from your mobile device to Mopria-enabled printers. 

Notes: 

• Mopria and all of its required protocols are enabled by default. 
• Ensure that you have the latest version of the Mopria Print Service installed on your mobile 

device. You can obtain a free download from the Google Play Store. 
• Wireless devices must join the same wireless network as the printer. 
• The name and location of your printer appears in a list of Mopria-enabled printers on 

connected devices. 

To print using Mopria, follow the directions provided with your mobile device. 
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Printing from a USB Flash Drive 

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. 

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported. 

To print from a USB Flash drive: 
1. Insert the USB Flash Drive into the USB memory port on the printer. 
2. At the USB Drive has been detected screen, touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. For 
details, refer to USB Port Security on page 274. 

3. Add files to the Document Source Table. 
a. To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify 

that your files are selected. 
b. To print a specific file, browse to that file, then touch the file name or icon. 

4. Touch OK. 
5. Confirm that the desired documents are listed. If not, touch Add Document, select the additional 

documents, then touch OK. 
6. Select the paper supply, quantity, output color, and 2-sided printing options. 
7. Touch Print. 
8. When you are finished, remove the USB Flash drive. 

To print from a USB Flash drive that is already inserted in the printer: 
1. If the USB Flash drive is already in the USB memory port, press the Home button. 
2. Touch USB. 
3. Touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. For 
details, refer to USB Port Security on page 274. 

4. Add files to the Document Source Table. 
a. To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify 

that your files are selected. 
b. To print a specific file, browse to that file, then touch the file name or icon. 

5. Touch OK. 
6. Confirm that the desired documents are listed. If not, touch Add Document, select the additional 

documents, then touch OK. 
7. Select the paper supply, quantity, output color, and 2-sided printing options. 
8. Touch Print. 
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Printing Features 

This section includes: 
• Managing Jobs ..................................................................................................................................................................... 104 
• Printing Special Job Types ............................................................................................................................................... 105 
• Printing on Both Sides of the Paper ............................................................................................................................ 109 
• Orientation ............................................................................................................................................................................. 110 
• Selecting Paper Options for Printing ........................................................................................................................... 110 
• Printing Multiple Pages to a Single Sheet ................................................................................................................ 110 
• Printing Booklets .................................................................................................................................................................. 111 
• Print Quality ........................................................................................................................................................................... 111 
• Image Options ...................................................................................................................................................................... 111 
• Printing Watermarks .......................................................................................................................................................... 112 
• Scaling ...................................................................................................................................................................................... 113 
• Lightness ................................................................................................................................................................................. 113 
• Contrast ................................................................................................................................................................................... 113 
• Printing Mirror Images ...................................................................................................................................................... 113 
• Selecting Job Completion Notification for Windows .......................................................................................... 114 
• Using Special Pages ........................................................................................................................................................... 114 
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Managing Jobs 

From the Jobs window in the Embedded Web Server, you can view a list of active and completed print 
jobs. 

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You 
can pause, delete, print, or view job progress or job details for a selected job. When you send a secure 
print job, the job is held until you release it by typing a passcode at the control panel. For details, refer to 
Printing Special Job Types on page 105. 

To pause the print job with the option to delete it: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs, then touch the name of the desired print job. 
3. Do one of the following: 

− To pause the print job, touch Pause. To resume the print job, touch Resume. 
− To delete the print job, touch Delete. At the prompt, touch Delete. 

Note: If you do not make a selection within 60 seconds, the job automatically resumes. 

4. To return to the Home screen, press the Home button. 

To view, print, or delete jobs: 
1. At the printer control panel, press the Home button. 
2. To view a list of active and completed jobs, touch Jobs. 
3. To view a list of specific job types, touch an option. 

− To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then 
touch OK. To delete the job, touch the Trash icon, then touch Delete. 

− To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then 
touch Print All, or Delete All. 

− For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number, 
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder, 
touch Print All, or Delete All. 

4. To view details about a job, touch the job. 
5. To return to the Home screen, press the Home button. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a Secure Print job. 
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Printing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 
 

Saved Job 

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any 
user can print or delete a Saved Job. 

To print a saved job: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Copies & Pages, then select Xerox Features. 
3. For Job Type, select Saved Job. 
4. Select other desired printing options and click OK. 

To release a Saved Job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Saved Jobs, touch Saved Jobs. 
4. To print a Saved Job, touch its name, select the number of copies to print, then touch OK. 
5. To delete the document after printing, for that job, touch the Trash Icon, then at the prompt, touch 

Delete. 
6. To return to the Home screen, press the Home button. 
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Secure Print 

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the 
printer until you enter your passcode at the printer control panel. 

To print using Secure Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Copies & Pages, then select Xerox Features. 
3. For Job Type, select Secure Print. 
4. Select other desired printing options and click OK. 

To release a Secure Print job: 

At the printer control panel, press the Home button. 

1. Touch Jobs. 
2. To view Secure Jobs, touch Personal & Secure Jobs. 
3. Touch your folder. 
4. Enter the passcode number, then touch OK. 
5. Select an option: 

− To print a Secure Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete all the jobs in the folder, touch Delete All. 

Note: After a Secure Print job is printed, it is deleted automatically. 

6. To return to the Home screen, press the Home button. 
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Personal Print 

Personal Print allows you to store a document in the printer, then print it from the control panel. Personal 
Print is a type of saved job with these differences: 
• It appears in a folder named after the user ID associated with the print job. 
• It requires a passcode. 
• Any user can print or delete a personal job. 
• You can also print all jobs in the list at once, delete an individual job, or delete all jobs in the list. 
• After a personal job is printed, it is deleted automatically. 

To print using Personal Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Copies & Pages, then select Xerox Features. 
3. For Job Type, select Personal Print. 
4. Select other desired printing options and click OK. 

To release a Personal Job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Personal Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. Enter your passcode, or touch Skip. 
6. Select an option: 

− To print a Personal Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete all the jobs in the folder, touch Delete All. 

7. To return to the Home screen, press the Home button. 
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Sample Set 

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining 
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the 
printer control panel.  

Sample Set is a type of saved job with these differences: 
• It appears in a folder named after the user ID associated with the print job. 
• It does not use a passcode. 
• Any user can print or delete a sample job. 
• A Sample Set prints one copy of a job to allow you to proofread the job before printing any 

remaining copies. 
• After a sample job is printed, it is deleted automatically. 

To print using Sample Set: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Copies & Pages, then select Xerox Features. 
3. For Job Type, select Sample Set. 
4. Select other desired printing options and click OK. 

To release a Sample Set: 
1. At the printer control panel, press the Home button. 
2. To view available jobs, touch Jobs. 
3. Touch the Sample Set job; it is shown with Held for Future Printing in its description. 
4. Select an option: 

− To print the remaining copies of the job, touch Release. 
− To delete the remaining copies of the job, touch the right arrow, then touch Delete All. 

5. To return to the Home screen, press the Home button. 
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Printing on Both Sides of the Paper 

Printing a 2-Sided Document 

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print 
driver uses the settings for portrait or landscape orientation from the application for printing the 
document. 

Note: Ensure that the paper size and weight are supported. For details, refer to Supported Paper Sizes 
and Weights for Automatic 2-Sided Printing on page 71. 
 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 
• 1-Sided Print: This option prints on one side of the media. Use this option when printing on 

envelopes, labels, or other media that cannot be printed on both sides. 
• 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long 

edge of the paper. The following illustrations show the result for documents with portrait and 
landscape orientations, respectively: 

   

• 2-Sided Print, Flip on Short Edge: Prints on both sides of the paper. The images print to allow 
binding on the short edge of the paper. The following illustrations show the result for documents 
with portrait and landscape orientations, respectively: 

   

Note: 2-Sided Printing is part of the Earth Smart settings. 

To change your default print driver settings, refer to Setting Default Printing Options for Windows. 
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Orientation 

To select the default orientation: 
1. In the print driver, on the Document Options tab, click the Orientation tab. 
2. Select an option: 

− Portrait: Orients the paper so that the text and images print across the short dimension of the 
paper. 

 

− Landscape: Orients the paper so that the text and images print across the long dimension of 
the paper. 

 

− Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the 
long bottom side up. 

 

3. Click OK. 
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size, paper type, and paper color you specify. You can also select a specific 
tray loaded with the desired paper. 
 

Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout 
is on the Document Options tab. 
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Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting 

compensates for the thickness of the folded paper, which can cause the page images to shift 
outward slightly when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 

 

 
 

 
 

Print Quality 

Print-quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• Enhanced print-quality mode: 1200 x 1200 dpi 
 

Image Options 

Image options controls the way the printer uses color to produce your document. The Windows 
PostScript and the Macintosh drivers provide the widest range of color controls and corrections on the 
Image Options tab. 

To convert all color in the document to black and white or shades of gray, select Xerox Black and White. 

The printer provides the following color correction options: 
• Xerox Automatic Color: This option applies the best color correction to text, graphics, and images. 

Xerox recommends this setting. 
• Vivid RGB: This setting produces brighter and more saturated colors using red, green, and blue color. 
• Commercial: This option applies color for printing on a commercial printing press. 
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Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

To print a watermark: 
1. In the print driver, click the Document Options tab. 
2. Click the Watermarks tab. 
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or 

create a customized watermark. You can also manage watermarks from this menu. 
4. Under Text, select an option: 

− Text: Enter the text in the field, then specify the font. 
− Time Stamp: Specify the date and time options, then specify the font. 
− Picture: To locate the picture, click the Browse icon. 

5. Specify the scaling angle and position of the watermark. 
• Select the scaling option that specifies the size of the picture in relation to the original 

image. Use the arrows to scale the image in increments of 1%. 
• To define the angle of the image on the page, specify the position option or to rotate the 

image left or right by increments of 1, use the arrows. 
• To define the location of the image on the page, specify the position option, or to move 

the image in each direction in increments of 1, use the arrows. 
6. Under Layering, select how to print the watermark. 

− Print in Background prints the watermark behind the text and graphics in the document. 
− Blend: This option combines the watermark with the text and graphics in the document. A 

blended watermark is translucent, so you can see both the watermark and the document 
content. 

− Print in Foreground prints the watermark over the text and graphics in the document. 
7. Click Pages, then select the pages to print the watermark: 

− Print on All Pages prints the watermark on all pages of your document. 
− Print on Page 1 Only prints the watermark only on the first page of the document. 

8. If you select a picture as a watermark, specify the lightness settings for the image. 
9. Click OK. 
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Scaling 

Scaling reduces or enlarges the original document to match the selected output paper size. In Windows, 
the Scale Options are located in the print driver on the Printing Options tab in the Paper field. 

To access Scaling Options, to the right of the Paper field, click the arrow, then select Other Size > 
Advanced Paper Size. 
• Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount 

appears in the percentage box below the sample image. 
• No Scaling does not change the size of the page image printed on the output paper, and 100% 

appears in the percentage box. If the original size is larger than the output size, the page image is 
cropped. If the original size is smaller than the output size, extra space appears around the page 
image. 

• Manually Scale scales the document by the amount entered in the percentage box below the 
preview image. 

 

Lightness 

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in 
your printed job. 
1. To adjust the lightness, on the Image Options tab, move the slider to the right to lighten or to the 

left to darken your print job. 
2. Click OK or Apply. 
 

Contrast 

You can use the Contrast feature to adjust the variation between light and dark areas of the print job. 
1. To adjust the contrast, move the slider to the right to reduce the contrast or to the left to increase 

the contrast. 
2. Click OK or Apply. 
 

Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right 
when printed. 
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Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer 
screen with the name of the job and the name of the printer where it was printed. 
 

Note: This feature is only available on a Windows computer printing to a network printer. 
 

To select job completion notification from the Advanced tab: 
1. Click Notification. 
2. Click Notify for Completed Jobs. Select an option: 

− Enabled: This option turns on notifications. 
− Disabled turns off the Notification feature. 

3. Click OK. 
 

Using Special Pages 

The Special Pages options control how covers, inserts, and exception pages are added to your printed 
document. 

For details on accessing the Properties window, refer to Printing Overview on page 94. 
 

Printing Cover Pages 

A cover page is the first or last page of a document. You can select paper sources for the cover pages 
that are different from the source used for the body of a document. For example, you can use your 
company letterhead for the first page of a document. You can also use heavyweight paper for the first 
and last pages of a report. You can use any applicable paper tray as the source for printing cover pages. 

Select one of these options for printing cover pages: 
• No Covers does not print cover pages. No cover pages are added to the document. 
• Front Only prints the first page on paper from the specified tray. 
• Back Only prints the back page on paper from the specified tray. 
• Front and Back: Same prints the front and back cover pages from the same tray. 
• Front and Back: Different prints the front and back cover pages from different trays. 

After making a selection for printing the cover pages, you can select the paper for the front and back 
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side 
two, or both sides of the cover pages. 
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Printing Insert Pages 

You can add blank or pre-printed insert pages before page one of each document or after designated 
pages within a document. Adding an insert after designated pages within a document separates 
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages. 
• Insert Options provides the options to place an insert After Page X, where X is the specified page, or 

Before Page 1. 
• Insert Quantity specifies the number of pages to insert at each location. 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. 
• Job Setting: Displays the attributes of the paper for the remainder of the job. 
 

Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. 
For example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. 
• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an 

option: 
− 1-Sided Print prints the exception pages on one side only. 
− 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the 

long edge. The job then can be bound on the long edge of the pages. 
− 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and 

flips the pages on the short edge. The job then can be bound on the short edge of the pages. 
− Use Job Setting prints the job using the attributes shown in the Job Settings box. 

• Job Setting: Displays the attributes of the paper for the remainder of the job. 

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce 
unexpected results. 
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Using Custom Paper Sizes 

This section includes: 
• Printing on Custom Paper Sizes .................................................................................................................................... 116 
• Defining Custom Paper Sizes ......................................................................................................................................... 117 

You can print on custom paper sizes that are within the minimum and maximum size range supported by 
the printer. For details, refer to Supported Custom Paper Sizes on page 71. 
 
 

Printing on Custom Paper Sizes 
Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer 
properties to define the custom size. For details, refer to Defining Custom Paper Sizes on page 117. 

 

Printing on Custom Paper Size Using Windows 
1. Load the custom-size paper in the tray. 
2. In the application, click File > Print and select your printer. 
3. In the Print dialog box, click Properties. 
4. On the Paper/Output tab, use the Paper Size drop-down list to select the desired custom size. 
 

Note: If you are printing on custom size paper, define the custom size in the printer properties 
before printing. 

 

5. From the Paper Type drop-down list, select the paper type. 
6. Select any other desired options, then click OK. 
7. In the Print dialog box, click OK to start printing. 
 

Printing on Custom Paper Size Using Macintosh 
1. Load the custom-size paper. For details, refer to Loading Paper on page 72. 
2. In the application, click Page Setup. 
3. From the Paper Size drop-down list, select the custom paper size. 
4. Click OK. 
5. In the application, click Print. 
6. Click OK. 
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Defining Custom Paper Sizes 

To print custom paper sizes, define the custom width and length of the paper in the print driver software 
and on the printer control panel. When setting the paper size, ensure that you specify the same size as 
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override 
control panel settings when you print using the print driver software on your computer. 
 

Creating and Saving Custom Paper Sizes in the Print Driver 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. 

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes on page 71. 

To create and save custom sizes for Windows: 
1. In the print driver, click the Printing Options tab. 
2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > 

New. 
3. In the New Custom Paper Size window, enter the height and width of the new size.  
4. To specify the units of measurement, at the bottom of the window, click the Measurements button, 

then select Inches or Millimeters. 
5. To save, in the Name field, type a title for the new size, then click OK. 

To create and save custom sizes for Macintosh: 
1. In the application, click File > Page Setup. 
2. Click Paper Sizes, then select Manage Paper Sizes. 
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+). 
4. Double-click Untitled at the top of the window and type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set 

the top, bottom, right, and left margins for User Defined margins. 
7. To save the settings, click OK. 
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Defining a Custom Paper Size at the Control Panel 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. 
1. At the printer control panel, press the Home button. 
2. Touch Device > Paper Trays. 
3. Touch the desired tray for your custom-size paper. 
4. Touch the current size setting, then from the list, touch Custom. 
5. In the Custom Paper Size screen, enter the height and width of the new size. 
6. To save the setting, touch OK. 
7. To return to the Home screen, press the Home button. 
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Making Copies 

1. At the printer control panel, press the Home button. 
2. To clear previous App settings, touch Reset. 
3. Load your original documents either onto the document glass or into the document feeder: 

− Use the document glass for single pages or paper that cannot be fed using the single-pass 
duplex automatic document feeder. Lift the single-pass duplex automatic document feeder, 
then place the original document face down in the upper-left corner of the document glass. 

 

− Use the single-pass duplex automatic document feeder for multiple or single pages. Remove 
any staples and paper clips from the pages. Insert the original documents face up in the 
automatic document feeder, with the top of the page entering the feeder first. Adjust the 
paper guides so that they fit against the original documents. 
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4. Touch Copy. 
5. To enter the number of copies, use the keypad on the touch screen. 

Note: To correct the number of copies entered, touch the X button, then enter the desired quantity. 

6. Change the copy settings as needed. For details, refer to Copy Settings. on page 122 
7. Touch Start. If you placed original documents in the document feeder, scanning continues until the 

document feeder is empty. 
8. If you are scanning from the document glass, when prompted, do one of the following: 

− If there are no more documents to scan, touch Done. 
− If you have another page to scan, place the next original on the document glass, then touch 

Add Page. 
− To cancel the job, touch Cancel Job, then to delete the job, at the prompt, touch Delete. 

Note: To pause the job printing, touch Pause. To continue the job, touch Add Page or to end the 
job, touch Done. 

9. To return to the Home screen, press the Home button. 
 

Single-Pass Duplex Automatic Document Feeder Guidelines 

The Single-Pass Duplex Automatic Document Feeder accommodates the following original-sized 
documents: 
• Width: 139.7–216 mm (5.5–8.5 in.) 
• Length: 139.7–356 mm (5.5–14 in.) 
• Weight: 60–125 g/m² 

Follow these guidelines when loading original documents into the duplex automatic document feeder: 
• Load original documents face up so that the top of the document enters the feeder first. 
• Place only loose sheets of undamaged paper in the duplex automatic document feeder. 
• Adjust the paper guides so that they fit against the original documents. 
• Insert paper in the duplex automatic document feeder only when ink on the paper is dry. 
• Do not load original documents above the MAX fill line. 
 

Document Glass Guidelines 

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.). To copy or scan 
certain types of original documents, use the document glass rather than the duplex automatic document 
feeder. 

Use the document glass for these document types: 
• Paper with paper clips or staples attached. 
• Paper with wrinkles, curls, folds, tears, or notches. 
• Coated or carbonless paper or items other than paper, such as cloth or metal. 
• Envelopes. 
• Books. 
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Copy Settings 

This section includes: 
• Selecting Color or Black and White Copies .............................................................................................................. 122 
• Setting 2-Sided Copying ................................................................................................................................................... 123 
• Selecting a Paper Tray ...................................................................................................................................................... 123 
• Collating Copies ................................................................................................................................................................... 123 
• Reducing or Enlarging the Image ................................................................................................................................ 124 
• Specifying the Original Document Type ................................................................................................................... 124 
• Making the Image Lighter or Darker .......................................................................................................................... 124 
• Specifying the Size of the Original .............................................................................................................................. 125 
• Specifying the Orientation of the Original ............................................................................................................... 125 

You can adjust the settings for your copy job, specify characteristics of the original documents, and 
customize the output. 

You can also modify the default settings for many options. For details, refer to Modifying the Default 
Copy Settings on page 126. 
 
 

Selecting Color or Black and White Copies 

If the original document contains color, you can create copies in full color or in black and white. 

Note: This setting returns to its default after the copy job is complete. To modify the default setting, 
refer to Modifying the Copy Default Settings on page 126. 

To select color or black and white copying: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Output Color. 
4. Select an option: 

− Auto Detect: The device detects the color content in the original document. If the original is a 
color document, the printer makes copies in full color. If the original is a black-and-white 
document, the printer makes copies in black only. 

− Color: This option copies in full color output using all four printing colors, cyan, magenta, 
yellow, and black. 

− Black & White: Produces copies in black and white only. Colors in the original are converted to 
shades of gray. 
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Setting 2-Sided Copying 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch 2-Sided. 
4. Touch one of the following: 

− 1 - 1 Sided 
− 1 - 2 Sided 
− 2 - 2 Sided 
− 2 - 1 Sided 

5. To rotate the image on side 2 by 180 degrees, touch More, then touch Rotate Side 2. 
6. Touch OK. 
 

Selecting a Paper Tray 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Paper Supply. 
4. Touch a selection. 
 

Collating Copies 

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a 
six-page document, the copies are printed in this order: 

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6 

Uncollated copies print in the following order: 

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6 

To select a collating option: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. To select collated output, touch the Collated toggle button. 
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Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the copied image: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Reduce/Enlarge, then select an option. 

− To have the device automatically select the best ratio to reduce or enlarge the original image, 
touch Auto %. When selected, the printer scales the original image based on the size settings of 
the selected paper tray. 

− To set the copy size in increments of 1%, touch the + or - buttons to set the percentage. The 
default setting is 100%. 

4. Touch OK. 
 

Specifying the Original Document Type 

To specify the type of the original document: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Original Type. 
4. Select one of the following: 

− Auto: Use this option to allow the printer to determine the original document type. 
− Text: Use this setting for black and white or colored text. 
− Text & Photo 

• Printed: Use this setting for documents with text and photographs printed on paper. 
• Photocopied: Use this setting for photocopied documents that include text and 

photographs. 
• Photograph: Use this setting for documents that include photographs and text on 

photographic paper. 
− Photo 

• Photograph: Use this setting for original photographs on photographic paper. 
• Printed: Use this setting for photographs printed on magazine paper. 
• Photocopied: Use this setting for photocopied photographs. 

− Map: Use this setting to enhance faint backgrounds and fine details on maps. 
5. Touch OK. 
 

Making the Image Lighter or Darker 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Lighten/Darken. 
4. To adjust the lightness, move the slider to the right to lighten or to the left to darken your print job. 
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Specifying the Size of the Original 

To scan the correct area of the original, specify the original size. 

To specify the original document size: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Original Size. 
4. On the Original Size screen, select an option: 

− Auto Detect: The printer determines the size of the original document, based on the size 
settings of the selected paper tray. 

− Mixed Size Originals: This option allows you to scan standard-size original documents of 
varying sizes. To determine which original sizes can be mixed in the same job, refer to the 
information on the screen. 

− Custom/Presets: The Custom option allows you to specify the height and width of the area to 
scan. The Preset options specify the area to scan when it matches a standard paper size. 

5. Touch OK. 
 

Specifying the Orientation of the Original 

Use the Original Orientation option to specify the layout of the original documents that you desire the 
printer to scan. The device uses the information to determine the required rotation on the output. 

To specify the original orientation: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Original Orientation. 
4. Touch Portrait or Landscape. 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 
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Advanced Copy Settings 

This section includes: 
• Saving Copy Presets ........................................................................................................................................................... 126 
• Modifying the Default Copy Settings ........................................................................................................................ 126 
• Retrieving a Copy Preset .................................................................................................................................................. 127 
• Customizing the Copy App .............................................................................................................................................. 127 
 
 

Saving Copy Presets 

Use this feature to save a particular combination of copy settings for future copy jobs. You can save the 
settings with a name and retrieve them for later use. 

To save the current copy settings: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Select the copy job settings. 
4. Scroll to the bottom and touch Save. 
5. Touch Save as New Preset. 
6. Touch Enter Preset Name, and using the keypad, enter the preset name. 
7. Touch Next. 
8. Select an icon that best suits the preset being created. 
9. Touch Done. 

Notes: 

• The preset is stored within the Preset feature. 
• To delete a saved preset, refer to Customizing the Copy App on page 127. 

 

Modifying the Default Copy Settings 

The printer uses the default copy settings on all copy jobs unless you change the settings. 

To modify the default copy settings: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch the options you want to change. 
4. Scroll to the bottom and touch Save. 
5. Touch Save Defaults. The existing default settings are overridden with the new ones selected. 
6. Touch Save. 
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Retrieving a Copy Preset 

To retrieve a saved preset: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Preset. 
4. From the list of stored presets, touch the desired preset. 
5. The preset settings appear on the screen and are ready for use.  

Note: You can make changes to the settings before you scan the original documents as needed. 

6. Touch Start. 
 

Customizing the Copy App 

Customization enables you to modify the features available, delete a saved preset, or remove 
customized settings applied to an App. 

To customize the available features: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Scroll to the bottom and touch Customize. 
4. Touch Feature List. For logged-in users, a window appears asking you to confirm that the changes 

are for a guest or for you. 
5. Touch the desired option. 
6. To hide a Copy App feature, follow the instructions that appear on the screen. 

To delete a saved preset: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Scroll to the bottom and touch Customize. 
4. Touch Presets. 
5. Touch the Trash icon that corresponds with the preset you want to delete. 
6. At the prompt, touch Delete. 
7. Touch Done. 

To remove the current Copy App customization settings: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Scroll to the bottom and touch Customize. 
4. Touch Remove App Customization. 
5. At the prompt, touch OK. 
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• Scanning to a Shared Folder on a Network Computer ....................................................................................... 136 
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For reference:  
Installation and Setup Overview on page 38 
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Scanning Overview 

The Scanning feature provides several methods for scanning and storing an original document. The 
scanning procedure using your printer differs from that of desktop scanners. The printer is connected 
typically to a network rather than a single computer, so you select a destination for the scanned image 
at the printer. 

The printer supports the following scanning functions: 
• Scan original documents to an email address. 
• Scan original documents to a USB Flash drive. 
• Scan original documents to your home folder. 
• Scan original documents to a computer using WSD. 
• Scan original documents to a shared network location using SMB and FTP transfer protocols. 
• Import scanned images into applications using TWAIN and WIA. 
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Document Loading Guidelines 

To scan or fax original documents, use the document glass or the duplex automatic document feeder. 
• For details on using the document glass, refer to Document Glass Guidelines on page 121. 
• For details on using the duplex automatic document feeder, refer to Single-Pass Duplex Automatic 

Document Feeder Guidelines on page 121. 
 

Loading Documents for Scanning 

Position the original document as shown. 
 

  
Document Glass 
Lift the document feeder cover, then place the 
original document face down in the upper-left 
corner of the document glass. 

Single-Pass Duplex Automatic Document Feeder 
Insert original documents face up with the top of the page 
entering the feeder first. Adjust the paper guides so they fit 
against the original documents. 
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Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats. 

To scan to a USB Flash drive: 
1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. Insert your USB Flash drive into the USB memory port on the front of the printer. 
4. At the USB Drive has been detected screen, touch Scan to USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. 

5. To save the scanned file to a specific folder on the USB Flash drive, navigate to the directory where 
you want to save your file, then touch OK. 

6. To save the scanned document as a specific file name, touch the attachment file name, enter a new 
name using the touch screen keypad, then touch Enter. 

7. To save the scanned document as a specific file format, touch the attachment file format, then 
select the desired format. 

8. Adjust scanning features as needed. 
9. To begin the scan, press Scan. 

The printer scans your images to the folder that you specified. 
10. If you are scanning from the document glass, when prompted, to finish, touch Done or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

11. When scanning completes, a message appears that notifies you that it is safe to remove the USB 
Flash drive. 

 

 WARNING: Do not remove the USB Flash drive until prompted. If you remove the Flash drive 
before the transfer is complete, the file can become unusable and other files on the drive can be 
damaged. 

 

12. To return to the Home screen, press the Home button. 
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Scanning to a User Home Folder 

Scan to Home allows you to scan documents that are saved to a home directory on an external server. 
The home directory is distinct for each authenticated user. The directory path is established through 
LDAP. 
 

Before You Begin 

To scan to the home folder defined in an LDAP directory, first ensure that the home folder locations are 
defined for each user. 

If you want to scan to a shared folder on the network, create a shared folder on your network with read 
and write access privileges. 
 

Scanning to a Home Folder 
Note: If LDAP Network Authentication is configured, the Home button appears as an option that 
you can select on the Scan To screen. 

1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. To log in to the printer, touch Log In. 
4. Enter your user name, then touch Next. 
5. Enter your password, then touch OK. 
6. To scan to a home folder, select an option: 

− Touch Scan To. On the Scan To screen, touch Home. 
− Touch My Folder. 

7. To save the scanned document as a specific file name, touch the attachment file name, enter a new 
name using the touch screen keypad, then touch Enter. 

8. To save the scanned document as a specific file format, touch the attachment file format, then 
select the desired format. 

9. Adjust scanning options as needed. 
10. To begin the scan, press Scan. 

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 
another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

11. To return to the Home screen, press the Home button. 
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Scanning to an Email Address 

Before you scan to an email address, ensure that you configure the printer with the email server 
information. For details, refer to Setting Up Scanning to an Email Address on page 262. 

To scan an image and send it to an email address: 
1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the control panel, touch the Home button. 
3. Touch Scan To. 
4. Enter recipients: 

− To enter the email address manually, touch Email, enter an email address, then touch Enter. 
− To select a contact or group from the Address Book, touch the Address Book icon. Touch 

Favorites or Contacts, then select a recipient. 
5. To save the scanned document as a specific file name, touch the attachment file name, enter a new 

name using the touch screen keypad, then touch Enter. 
6. To save the scanned document as a specific file format, touch the attachment file format, then 

select the desired format. 
7. Adjust scanning options as needed. 
8. To change the subject line, from Email Features, touch Subject, enter a new subject line using the 

touch screen keypad, then touch Enter. 
9. To change the email body message, from Email Features, touch Message, enter a new message, 

then touch OK. 
10. To begin the scan, touch Send. 
11. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

12. To return to the Home screen, press the Home button. 
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Scan to Desktop 

Before you begin: 
• Before scanning, ensure that your computer and the printer are plugged in, powered on, and 

connected to an active network. 
• On your computer, ensure that you have the correct print driver software installed. For details, refer 

to Installing the Software on page 60. 
• On your computer, ensure that the printer is installed using WSD. For details, refer to Installing the 

Printer as a Web Service on Devices on page 66. 
• On your printer, ensure that WSD is enabled. For details, refer to Enabling WSD Scan Services on 

page 263. 

To Scan to Desktop: 
1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. Touch Scan to Desktop. 
4. To select a destination, touch the computer address. 
5. To begin the scan, press Scan. 

The Windows Fax and Scan application opens on your PC desktop. The image file of your scan is 
saved to the Scanned Documents folder. 

6. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 
another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

7. To return to the Home screen, press the Home button. 
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Scanning to a Shared Folder on a Network 
Computer 

Before you use the printer as a scanner on a network, ensure the following: 
• Create a shared folder on your computer hard drive. 
• Create an address using the Embedded Web Server that points the scanner to the computer. 
 

Sharing a Folder on a Windows Computer 
1. Open Windows Explorer. 
2. Right-click the folder you want to share, then select Properties. 
3. Click the Sharing tab, then click Advanced Sharing. 
4. Select Share this folder. 
5. Click Permissions. 
6. Select the Everyone group, and verify that all permissions are enabled. 
7. Click OK. 

Note: Remember the Share name for later use. 

8. Click OK again. 
9. Click Close. 
 

Sharing a Folder in Macintosh OS X Version 10.7 and Later 
1. From the Apple menu, select System Preferences. 
2. From the Internet & Wireless menu, select Sharing. 
3. From the Service menu, select File Sharing. 
4. Under Shared Folders, click the plus icon (+). 
5. Browse to the folder that you want to share on the network, then click Add. 
6. To modify access rights for your folder, select the folder. The groups activate. 
7. From the Users list, click Everyone, then use the arrows to select Read & Write. 
8. Click Options. 
9. To share the folder, select Share files and folders using SMB. 
10. To share the folder with specific users, next to the user name, select On. 
11. Click Done. 
12. Close the System Preferences window. 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and subfolders. 
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Adding an SMB Folder as an Address Book Entry from the Embedded 
Web Server 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. Click Address Book, then click Add Contact. 
3. For Network (SMB), click the plus icon (+), then enter the following information: 

− Nickname: Enter the name that you want to appear in the Address Book. 
− Type: Select the network connection type. 
− IP Address: Port: Enter the IP address of your computer, then enter the default port number. 
− Share: Enter a name for the directory or folder. For example, to save scanned files to a shared 

folder named scans, type scans. 
− Document Path: Enter the path of the folder on the SMB server. For example, to save the 

scanned files to a folder named colorscans inside the scans folder, type colorscans. 
− Login Name: Enter your computer user name. 
− Password: Enter your computer login password. 
− Retype Password: Enter your login password again. 

4. To save your network information, click OK. 
5. To save your contact, click OK. 
 

Adding a Folder as an Address Book Entry Using the Control Panel 
1. At the printer control panel, touch the Home button. 
2. Touch Address Book. 
3. Touch the plus icon (+), then select Add Contact. 
4. Enter the name to appear in the address book. 
5. Touch Add (SMB), then navigate to the desired folder. 

Note: Login credentials are required for computers on secured networks. 

6. To save changes, touch OK. 
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Scanning to a Shared Folder on a Networked Computer 
1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. Touch Scan To. 
4. Touch Contacts. 
5. From the Contacts list, select the shared folder. 
6. To save the scanned document as a specific file name, touch the attachment file name, enter a new 

name using the touch screen keypad, then touch Enter. 
7. To save the scanned document as a specific file format, touch the attachment file format, then 

select the desired format. 
8. Adjust scanning options as needed. 
9. To begin the scan, press Scan. 
10. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

11. To return to the Home screen, press the Home button. 
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Scanning Images into an Application on a 
Connected Computer 

This section includes: 
• Scanning an Image into an Application ................................................................................................................... 139 
• Example of Scanning an Image in Microsoft Windows ..................................................................................... 140 
• Scanning an Image Using Windows Fax and Scan ............................................................................................. 141 
• Scanning from Windows Control Panel ..................................................................................................................... 141 

You can import images directly from the scanner into a folder on your computer. With a Macintosh® 
computer and some Windows applications, you can import the images directly into an application. 
 
 

Scanning an Image into an Application 
Note: Some Windows applications, including Office 2007, do not support this feature. 

1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. At your computer, open the application into which you want to scan the image. 
3. In the application, select the menu item to acquire the image. 
4. From the Paper Source menu in Windows, or from the Scan From menu on a Macintosh® computer, 

select one of the following: 
− For the Document Glass, select Flatbed. 
− For the Duplex Automatic Document Feeder, select Document Feeder. 

5. Specify other scan driver settings as needed. 
6. To begin the scan, click Scan. 

The printer scans the document and places the image in your application. 
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Example of Scanning an Image in Microsoft Windows 

The following procedure provides an example of how to scan an image using a TWAIN scan driver in a 
Microsoft Windows environment. 
1. At the printer, load the original document on the document glass or in the automatic document 

feeder. 
2. At your computer, click Start > Programs > Microsoft Office > Microsoft Office Tools > Microsoft 

Clip Organizer or OneNote. 
3. Click File > Add Clips to Organizer > From Scanner or Camera. 
4. Click Device > TWAIN Driver. 
5. Click Custom Insert. 
6. For Scan Mode, select an option. 

− Preview/Scan Multiples: This mode configures the printer to allow you to preview and 
rearrange scanned images. You can also specify to include single scans or multiple scans in the 
same session. 

− Transfer Directly to App: This option bypasses the preview and sends the scanned images 
directly to the application. 

7. To select a size for the scanned image, click Original Size, then select a size. 
8. To select the sides to scan from the original, click Side to Scan, then select an option. 

− 1 Sided Scan: This setting scans only one side of the original document or image and produces 
1-sided output files. 

− 2 Sided Scan: This setting scans both sides of the original document or image. 
− 2 Sided Scan, Rotate Side 2: This setting scans both sides of the original document or image, 

and rotates the second side by 180 degrees. 
9. To select the resolution to scan the image, click Resolution, then select an option. 

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both 
the size and image quality of the scanned image file. Higher scan resolution produces better image 
quality and a larger file size. 
1. To adjust the scan color, click Output Color, then select an option. 

− Automatically Detect: This option detects the color content in the original image. If the 
original image is color, the printer scans in full color. If the original image is a black and white 
document, the printer scans in black only. 

− Black and White: This setting scans in black and white only. 
− Color: This setting scans in full color. 
− Grayscale: This setting detects, then scans various shades of gray. 

2. To adjust the scan, click Scan Adjustments. 
3. Select a Scan Preset. 
4. Click Scan. 
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Scanning an Image Using Windows Fax and Scan 
1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. On your computer, select Start > All Programs > Windows Fax and Scan. 
3. From the Windows Fax and Scan window, click New Scan. 
4. To select your printer, click the Change button, select the device, then click OK. 
5. Select the paper source for your original document from the menu. 
6. Adjust scanning options as needed. 
7. To preview the document or select a portion of the document to scan, click Preview. 

The printer scans a preview copy of the image. 
8. To select part of the document, use the corner points to resize the frame. 
9. Click Scan. 

The scanned image is stored in the default Scanned Documents folder or in a folder that you 
selected. 

 

Scanning from Windows Control Panel 
1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. On your computer, select Start > Devices and Printers. 
3. From the Devices and Printers window, right-click the printer icon, then select Start Scan. 
4. Select the paper source for your original document from the menu. 
5. Adjust scanning options as needed. 
6. To preview the document or select a portion of the document to scan, select Preview. 

The printer scans a preview copy of the image. 
7. To select part of the document, use the corner points to resize the frame. 
8. Click Scan. 
9. To import the scan, in the Import Pictures and Video window, click Import. 

The scanned image is stored in the default My Pictures folder. 
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Faxing Overview 

You can use the Fax feature to do any of the following: 
• Fax documents to a fax number or individual contact. 
• You can delay the send of your fax job for up to 24 hours. 
• Send a fax from your computer. 
• Forward fax documents to an email address. 
• Print a fax from a secure folder. 
 

Configuring the Printer for Faxing 

Before you use the fax, you must configure the Fax Settings to make it compatible with your local 
connection and regulations. The Fax Settings include optional features you can use to configure the 
printer for faxing. 

For details on Fax Settings and Fax Default Settings, refer to Configuring Fax Defaults and Settings on 
page 161. 
 

Phone Line Compatibility 

The fax function works best with an analog phone line. Voice-Over Internet Protocols (VOIPs) such as 
FIOS and DSL are not supported. 
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Document Loading Guidelines 

To scan or fax original documents, use the document glass or the duplex automatic document feeder. 
• For details on using the document glass, refer to Document Glass Guidelines on page 121. 
• For details on using the duplex automatic document feeder, refer to Single-Pass Duplex Automatic 

Document Feeder Guidelines on page 121. 
 

Loading Documents for Faxing 

Position the original document as shown. 
 

  
Document Glass 
Lift the feeder cover, then place the original 
document face down in the upper-left corner of the 
document glass. 

Single-Pass Duplex Automatic Document Feeder 
Insert original documents face up with the top of the page 
entering the feeder first. Adjust the paper guides so that 
they fit against the original documents. 
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Sending a Fax from the Printer 

1. At the printer control panel, press the Home button, then touch Fax. 
2. Enter a recipient fax number manually, or select an individual or group from the fax address book. 

− To enter a fax number manually using the touch keypad, touch Enter Fax Number. Type the 
number, then press Enter. 

Note: To insert a pause as needed, touch the Special Characters icon, then touch Dial Pause. 
To enter longer pauses, touch Dial Pause multiple times. 

− To add a number from the fax address book, touch the Address Book icon. Touch Favorites or 
Contacts, then select the contact. 

3. Adjust fax settings as needed. 
− To adjust brightness, touch Lighten/Darken, then adjust as needed. Darken light original 

images such as pencil images, and lighten dark images such as halftone images from 
newspapers or magazines. 

− To scan both sides of your original document, touch 2-Sided Scanning, then touch 2-Sided. 
4. Touch Send. 
5. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

6. To return to the Home screen, press the Home button. 

Note: You can configure the printer to print a Confirmation Report after it transmits a fax. For details, 
refer to Configuring Fax Defaults and Settings on page 161. 
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Using Presets to Send a Fax From the Printer 

You can use Presets to retrieve settings and recipient names for frequently used fax jobs. You can set 
access to these features for all users or for administrators only. Preset settings are not available until a 
preset has been created and stored on the device. 

Note: Presets are not visible until the feature is enabled. 

To enable presets: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. Touch Customize. 

Note: To display the menu without entering a fax number, at the top of the screen, touch Fax. 

3. Touch Feature List. 
4. To make presets visible, touch the Eye icon for Preset. 
5. Touch Done. 
6. To return to the Home screen, press the Home button. 

To create fax presets: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. Add recipients as needed for the selected fax job. 
3. Adjust settings as needed for the selected fax job. 
4. Touch Save. 
5. Select Save as New Preset. 
6. Enter the name of the new preset, then touch Next. 
7. Choose an icon for the new preset, then touch Done. 
8. To return to the Home screen, press the Home button. 

To use presets: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. To use a preset, on the fax screen, touch Preset. 
3. Select a saved preset. 
4. Touch Send. 
5. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

6. To return to the Home screen, press the Home button. 
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Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax 
job for up to 24 hours. 

Note: Before you use this feature, set the printer to the current time. For details, refer to Setting the Date 
and Time on page 248. 

To specify the time to send your fax: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. Add fax recipients and adjust fax settings as needed. For details, refer to Sending a Fax from the 

Printer on page 146. 
3. Touch Delay Send. 
4. To set the Delay Send time, from the Delay Send screen, touch Specific Time. Specify the time for 

the printer to send the fax, then touch OK. 
5. Touch Send. 

The fax is scanned and saved, then sent at the time you specified. 
6. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

7. To return to the Home screen, press the Home button. 
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Sending a Cover Sheet with a Fax 

You can send a cover sheet with your fax. The cover sheet lists recipient information from the fax 
address book, and sender information from the Company Name Fax Line setting. 

To send a cover sheet with a fax: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. Add fax recipient names and adjust fax settings, as needed. For details, refer to Sending a Fax from 

the Printer on page 146. 
3. Touch Cover Sheet. 
4. On the Cover Sheet screen, touch Add Cover Sheet. 
5. To add predefined comments in the For or To fields on a cover sheet, touch Blank Comment. 

A list of predefined comments appears. 

Note: Use a predefined comment, or create another comment. For details, refer to Adding 
Predefined Comments on page 149. 

6. Select a comment, then touch OK. 
7. Touch Send. 
8. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

9. To return to the Home screen, press the Home button. 
 

Adding a Predefined Comment 
1. At the printer control panel, press the Home button. 
2. Touch Device > Apps > Fax. 
3. To enter a predefined comment: 

a. Touch Cover Sheet Comments. 
A list of saved comments appears. 

b. Select a Not in Use comment. 
c. Use the touch screen keypad to enter your comment. 
d. To save your comment, touch OK. 

4. To return to the Home screen, press the Home button. 
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Sending a Fax From Your Computer 

This section includes: 
• Sending a Fax From Windows Applications ............................................................................................................ 150 
• Sending a Fax From Macintosh Applications ......................................................................................................... 151 

You can send a fax to the printer from an application on your computer. 
 
 

Sending a Fax From Windows Applications 

You can use the print driver to send a fax from Windows applications. 

You can use the fax window to enter recipients, create a cover page with notes, and set options. You can 
send a confirmation sheet, set the send speed, resolution, send time, and dialing options. 

To send a fax from Windows applications: 
1. With the desired document or graphic image open in your application, open the Print dialog box. 

For most software applications, click File > Print or press CTRL+P. 
2. Select your printer. 
3. To open the print driver dialog box, click Printer Properties. 
4. On the Printing Options tab, from the Job Type list, select Fax. 
5. In the Fax window, do one or more of the following: 

− Click the Add Recipient button, type the recipient name and fax number, add other 
information, then click OK. Add new recipients as needed. 

− Click the Add From Phonebook button. In the Add From Phonebook window, click the arrow, 
then select a phonebook from the list. Select names from the list, or to search for a recipient, 
type a name, then click the search icon. To add a name to the Fax Recipients list, select the 
name, then click the Down Arrow. When you are finished, click OK. To add more names, repeat 
this procedure. 

6. To include a cover sheet, click Cover Sheet. 
7. From the Cover Sheet Options menu, select Print a Cover Sheet. Enter the details as needed, then 

click OK. 
8. On the Options tab, select the options for the fax, then click OK. 
9. Click Print. 
10. In the Printer Properties window, click OK. 
11. In the Print window, click OK. 
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Sending a Fax From Macintosh Applications 

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver, refer 
to Installing the Software on page 60. 

To send a fax from Macintosh applications: 
1. From your software application, access the print settings. For most software applications, press 

CMD+P. 
2. Select your LAN fax printer from the list. 
3. To access the fax driver settings, select Fax Setting. The title of the button can vary depending on 

your application. 
4. Modify fax settings as needed. For more information, click the Help (?) button. 
5. Click Print. 
6. Do one or more of the following: 

− Enter the recipient name and fax number, then click Add. 
− Click Look Up Address Book, select recipients from the local Address Book, then click Add. 
− Click Look Up Device Address Book, select recipients, then click Add. 

7. Click OK. 
8. To delay sending the fax, select Delayed Send, then enter the time that you want the fax sent. 
9. Click Start Sending. 
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Printing a Secure Fax 

When the Secure Receive setting is enabled, you must enter a password before faxes can be printed. 

Note: Before you can receive a Secure Fax, enable Secure Fax Receive. For details, refer to 
Configuring Fax Defaults at the Control Panel on page 163. 

To print a secure fax: 
1. At the printer control panel, press the Home button, then touch Jobs. 
2. Touch Personal & Secure Jobs. 
3. Touch your assigned private folder. 
4. At the prompt, enter the passcode, then press OK. 
5. Select a job to print, or touch Print All. 
6. To return to the Home screen, press the Home button. 
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Polling a Remote Fax Machine 

Fax Polling allows the printer to retrieve a fax stored on another fax machine that supports fax polling. 

To retrieve a fax from another fax machine: 
1. At the printer control panel, press the Home button, then touch Fax. 

Notes: 

• To display the menu without entering a fax number, at the top of the screen, touch Fax. 
• Features can be shown or hidden in a menu. If Polling is hidden in the fax menu, change the 

Fax App settings. For details, refer to Configuring Fax App Settings at the Control Panel on 
page 164. 

2. To toggle Polling from Off to On, touch the Polling toggle button. 
3. Enter the fax number of the fax machine that you want to poll. 

− To enter a fax number manually, using the touch screen keypad, touch Enter Fax Number. 
− To add a number from the fax address book, touch the Address Book icon. Touch Favorites or 

Contacts, then select a contact. 
4. Touch Retrieve. 
5. To return to the Home screen, press the Home button. 
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Sending a Fax Manually 

You can use the Manual Send feature to enable the fax modem speaker temporarily. This feature is 
helpful to dial international numbers, or to use phone systems that require you to wait for a specific 
audio tone. 

To send a fax manually: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. To toggle Manual Send from Off to On, touch the Manual Send toggle button. 

Note: To display the menu without entering a fax number, at the top of the screen, touch Fax. 

3. Modify fax settings as needed. 
4. Touch Dial. 
5. To enter a fax number, use the touch screen keypad. 

Note: To insert a pause as needed, touch the Special Characters icon, then touch Dial Pause. 
To enter longer pauses, touch Dial Pause multiple times. 

6. To send the fax, touch Scan. 
7. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

8. To return to the Home screen, press the Home button. 
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Printing a Fax Activity Report 

1. At the printer control panel, press the Home button. 
2. Touch Device > Apps > Fax. 
3. Touch Activity Report. 
4. To return to the Home screen, press the Home button. 
 

 Xerox® WorkCentre® 6515 Color Multifunction Printer 155 
 User Guide 
 



Faxing 

 

Editing the Address Book 

This section includes: 
• Adding or Editing Fax Contacts in the Address Book at the Control Panel ............................................... 156 
• Adding or Editing Groups in the Address Book at the Control Panel............................................................ 157 
• Adding or Editing Fax Contacts in the Address Book in the Embedded Web Server ............................ 158 
• Adding or Editing Groups in the Address Book in the Embedded Web Server ......................................... 159 
• Managing Favorites ........................................................................................................................................................... 160 

You can create and save contact information for individual contacts or groups. You can manage address 
book contacts at the control panel, or in the Embedded Web Server. 
 
 

Adding or Editing Fax Contacts in the Address Book at the Control Panel 

To add contacts: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. Touch the plus icon (+), then select Add Contact. 
4. To enter a name, touch the Enter First Name, Enter Last Name, or Enter Company field, then to 

move to the next field, touch Next. When finished, touch Enter. 
5. To add a fax number, touch Add Fax, enter a fax number, then touch OK. 
6. To save the contact, touch OK. 
7. To return to the Home screen, press the Home button. 

To edit contacts: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. From the Address Book, touch a contact name, then touch Edit. 
4. To change contact information, touch the information that you want to update, edit as needed, 

then touch OK. 
5. To save your contact changes, touch OK. 
6. To return to the Home screen, press the Home button. 
 

156 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



Faxing 

 

Adding or Editing Groups in the Address Book at the Control Panel 

To add groups: 
1. At the printer control panel, press the Home button, then touch Address Book. 
2. Touch the plus icon (+), then select Add Group. 
3. Select the group type, enter a name for the group, then touch Enter. 
4. To add group members, touch Add Member. 
5. To add a contact name, from the Favorites or Contacts menu, select a contact. 
6. To add more group members, touch Add Member, then select a contact. 
7. To save the group, touch OK. 
8. To return to the Home screen, press the Home button. 

To edit groups: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. From the address book, select a group, then touch Edit. 
4. To add group members, touch Add Member. 
5. To add a contact, from the Favorites or Contacts menu, select a contact. 
6. To add more group members, touch Add Member and select a contact. 
7. To remove group members, for each contact, touch the Trash icon. At the prompt, touch Delete. 
8. To save the changes, touch OK. 
9. To return to the Home screen, press the Home button. 
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Adding or Editing Fax Contacts in the Address Book in the Embedded 
Web Server 

To add contacts: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. Click Add Contact. 
4. To enter a name, click the First Name, Last Name, or Company field, then enter the details. 
5. To add an email address, in the Email field, enter an email address. 
6. To add a fax number, for Fax, click the plus icon (+), then enter a number. 
7. To save the contact, click OK. 

To edit contacts: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. From the Address Book, select a contact. 
4. To edit contact information, perform the following steps. 

a. Click the contact name or contact information, then edit as needed. 
b. To clear contact information, for the specific contact information, click the Trash icon. 
c. To save the changes, click OK. 

5. To remove the selected contact from the Address Book, click Delete. At the prompt, click Delete. 
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Adding or Editing Groups in the Address Book in the Embedded Web Server 

To add groups: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. Click Add Group. 
4. For Enter Group Name, enter a name for the group. 
5. From the menu, select the group type. 
6. To add group members, for Members, click the plus icon (+). 
7. To add contacts to the group, in the Add Members window, for each contact, select the check box. 

When you are finished, click OK. 
8. To save the group, click OK. 

To edit groups: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. Within the address book, select a group. 
4. To add group members: 

a. For Members, click the plus icon (+). 
b. In the Add Members window, click the check box for each desired member. 
c. To save the changes, click OK. 

5. To remove group members: 
a. For the desired member, click the Trash icon. 
b. At the prompt, click Delete. 
c. Repeat the previous two steps for each member. 
d. To save the changes, click OK. 

6. To remove the selected group from the Address Book, click Delete. At the prompt, click Delete. 
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Managing Favorites 

You can mark contacts as Favorites. A star next to a contact in the list indicates a Favorite. You can mark 
a favorite as a Global Favorite for all services or as a Favorite for email, fax, or scan-to destinations. 
 

Managing Favorites at the Control Panel 
1. At the printer control panel, press the Home button, then touch Address Book. 
2. Select a contact, then touch Edit. 
3. To make the contact a Global Favorite, for the contact name, touch the Star icon. 
4. To mark a contact as a Favorite for email, fax, or a scan-to destination: 

a. For each desired feature, touch the Star icon. 
b. To save changes, touch OK. 

5. To clear a contact marked as a Favorite: 
a. To remove the contact as a Global Favorite, for the contact name, touch the Star icon. 
b. To remove the contact from the Favorite list for a selected feature, for the selected feature, 

touch the Star icon. 
c. To save changes, touch OK. 

6. To return to the Home screen, press the Home button. 
 

Managing Favorites in the Embedded Web Server 
1. In the Embedded Web Server, click Address Book. 
2. Select a contact. 
3. To make the contact a Global Favorite, click the Global Favorite Star icon. 
4. To mark a contact as a Favorite for email, fax, or a scan-to destination, for each feature, click the 

Star icon. 
5. To remove a contact marked as a Favorite, for Global Favorite or the selected feature, touch the 

Star icon. The contact is removed from the Global Favorite list, or the Favorite list for the selected 
feature. 

6. To save changes, click OK. 
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Configuring Fax Defaults and Settings 

This section includes: 
• Configuring Fax Settings from the Embedded Web Server ............................................................................. 162 
• Configuring Fax Reports from the Embedded Web Server ............................................................................... 162 
• Configuring Fax Line Settings from the Control Panel ....................................................................................... 163 
• Configuring the Fax Settings at the Control Panel .............................................................................................. 163 
• Modifying the Default Fax Settings ............................................................................................................................ 164 
• Configuring Fax App Settings at the Control Panel ............................................................................................. 164 

It is unlawful to send a message from a fax machine without the proper Fax Send Header information. 
The following information must appear on the first transmitted page, or in the top or bottom margin of 
each transmitted page: 
• Identity of the business or individual sending the fax 
• Telephone number of the sending machine 
• Date and time of the transmission 

The first time that the printer is powered on, the Installation Wizard runs. The Installation Wizard 
process guides you through initial configuration of the printer and includes configuration of Fax settings 
and defaults. 

There are four areas to configure in Fax Settings: 
• Fax Line Settings 
• Incoming Defaults 
• Transmission Defaults 
• Fax Reports 

For proper fax operation, before you use the fax, configure all of the settings. You can change the 
settings using the control panel or the Embedded Web Server. 

Note: If your printer is connected to your computer through an Ethernet connection, to configure 
the fax settings, use the Embedded Web Server. 
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Configuring Fax Settings from the Embedded Web Server 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Apps > Fax. 
4. To configure fax line settings, for Fax Line, click Edit. 

a. Enter the Fax Number and Fax Name. 
b. Select the other fax line settings. 
c. When you are finished, click OK. 

5. For Defaults, select default fax settings as needed, then click OK. 
6. For General Settings and Policies, select options as needed, then click OK. 
7. For Presets, select original document size specifications as needed, then click OK. 
 

Configuring Fax Reports from the Embedded Web Server 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Apps > Fax. 
4. From General Settings and Policy, select a report. 

− Confirmation Report: You can print a report that confirms when your faxes are sent or 
received. The report contains information on timeouts, busy signals, and retry failures. 

− Broadcast Report: You can print a report that provides a record of broadcast faxes, including 
total pages scanned, remote station, start time, and result. 

− Activity Report: You can print a report that provides a record of faxes sent and received, 
including total pages scanned, durations, start date and time, and contents. 
Note: To print an Activity Report after every 100 fax communication attempts, from the 
Activity Report window, click Print Activity Report, then select On. To print an Activity Report 
manually, refer to Printing a Fax Activity Report on page 155. 

5. Select the desired report options. 
6. To save your settings, click OK. 
 

162 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



Faxing 

 

Configuring Fax Line Settings from the Control Panel 
1. At the printer control panel, press the Home button. 
2. Touch Device > Apps > Fax. 
3. Touch Fax Line. 
4. Touch Fax Number, enter the fax line number, then touch OK. 
5. Touch Country, then select your country from the list. 
6. To select a dialing type for outgoing faxes, touch Dialing Mode, then select an option. 

• Tone: This option sets tone dialing as the dialing method. 
• Pulse 10 pps: This option sets 10 pulse-per-second dialing pulses as the dialing method. 
• Pulse 20 pps: This option sets 20 pulse-per-second dialing pulses as the dialing method. 

7. Touch Line Type, then select PSTN or PBX. 
8. Touch Fax Name, enter a name, such as your company name, then touch OK. 
9. To save the setting, touch OK. 
10. To return to the Home screen, press the Home button. 
 

Configuring the Fax Settings at the Control Panel 
1. At the printer control panel, press the Home button. 
2. Touch Device > Apps > Fax. 
3. To configure Secure Receive: 

a. Touch Secure Fax Receive. 
b. To toggle Secure Fax Receive from Off to On, touch the Secure Fax Receive toggle button. 
c. Enter a 4-digit passcode, then touch OK. 

4. To set incoming call handling, select one of the following: 
− To set the printer to receive all incoming calls as faxes, touch Receive Mode > Immediately 

Auto Answer Fax, then touch OK. 
− To answer calls manually, touch Receive Mode > Manually Answer Fax, then touch OK. 

5. To configure how faxes are forwarded: 
a. Touch Fax Forwarding > Fax Forwarding. 
b. Select Receive Only, Send Only, or Send & Receive. 
c. Touch Add Email, then use the touch screen keypad to enter an email address, or select a 

contact from the Address Book. 
d. To add a subject line, touch Subject, enter your subject line text, then touch OK. 
e. To add a filename for attachments, touch Attachment, then enter a filename. 

To change the file format for attachments, touch the current format extension, then select a 
new format. 
Note: The default file format is .pdf. 

f. To save the settings, touch OK. 
6. For the new settings to take effect, press the Home button, then at the prompt, touch Restart Now. 
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Modifying the Default Fax Settings 

The printer uses the default fax feature settings on all embedded fax jobs unless you change them for 
an individual job. You can modify the default fax feature settings. 

To modify the default fax settings: 
1. At the printer control panel, press the Home button. 
2. Touch Fax. 
3. Touch the options you want to change. 
4. Scroll to the bottom and touch Save. 
5. Touch Save Defaults. The existing default settings are overridden with the new settings selected. 
6. Touch Save. 
 

Configuring Fax App Settings at the Control Panel 
1. At the printer control panel, press the Home button, then touch Fax. 

Note: To display the menu without entering a fax number, at the top of the screen, touch Fax. 

2. To hide or show features in the Fax menu, touch Customize > Feature List, then make a selection. 
− To hide a feature, for the desired feature, touch the Eye icon. To signify that the feature is 

hidden, a line appears across its Eye icon. 
− To show a feature, for the desired feature, touch the Eye icon. To signify a feature is visible, no 

line appears the line is removed from its Eye icon. 
3. To reorder the Fax menu features, touch and drag the features into the desired order. 
4. To save the current configuration, touch Done. 
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Cleaning the Printer 

This section includes: 
• Cleaning the Exterior ......................................................................................................................................................... 166 
• Cleaning the Scanner ........................................................................................................................................................ 166 
• Cleaning the Interior.......................................................................................................................................................... 170 
 
 

Cleaning the Exterior 

Clean the exterior of the printer once a month. 
• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 
• After cleaning, wipe with a dry, soft cloth. 
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain 

off. 
 

 CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer 
through a gap and cause problems. Never use cleaning agents other than water or mild detergent. 

 
 

Cleaning the Scanner 

Clean the scanner about once a month, when anything is spilled on it, or when debris or dust collect on 
any of the surfaces. Keep the feed rollers clean to ensure the best possible copies and scans. 
 

Cleaning the Scanner 
1. Remove any paper from the Document Feeder Tray, and the Document Output Tray. 
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2. Open the Document Cover. 

 

3. Slightly dampen a soft, lint-free cloth with water. 
4. Clean the document glass (A) and the CVT glass (B) to its left. 

Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks. 

 

5. Wipe the white underside of the document cover until it is clean and dry. 
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6. To access the second-side scanning lens assembly, lower the Second-Side Scanning Access Cover.

7. Using a soft cloth moistened with water, wipe the mirrored glass, the white-plastic strip, and the
rollers. If dirt is difficult to remove, moisten a soft cloth with a small amount of neutral detergent,
then wipe the printer parts dry with a soft cloth.

CAUTION: To prevent damage to the film around the glass, do not press heavily on the mirrored 
glass. 
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8. Close the Second-Side Scanning Access Cover.

9. Close the Document Cover.
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Cleaning the Feed Rollers on the Duplex Automatic Document Feeder 
1. Open the Top Cover.

2. Wipe the feed rollers with a dry, soft, lint-free cloth or paper towel until the rollers are clean.

Note: If the feed rollers get stained with toner or debris, they can cause stains on the documents. To 
remove the stains, use a soft lint-free cloth dampened with a neutral detergent or water. 

3. Close the Top Cover.
 

Cleaning the Interior 

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer 
regularly. Clean the printer interior whenever you replace the drum cartridge. 

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing 
the printer covers and doors. 
• Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper Jams on

page 199.
• Remove any dust or stains with a dry, clean cloth.

WARNINGS: 

• Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of
paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the printer
immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has
cooled.

• If you spill any toner in the printer, wipe it up using a moist cloth. Never use a vacuum cleaner to
remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion.
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Cleaning the LED Lenses 

If prints have voids or light streaks through one or more colors, use the following instructions to clean the 
LED lenses. 

WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. 
If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets 
on your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water and consult a doctor. 

1. Power off the printer.

2. Open the right-side door.

3. To unlock the waste cartridge, pinch the latch.
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4. To remove the waste cartridge, lower the top of the cartridge, then lift it away from the printer. 
To prevent toner spills, keep the openings facing up. 

 
Notes: 

• Be careful not to spill toner when handling the waste cartridge. 
• After removing the waste cartridge, do not touch the area shown in the illustration. 

 

5. Place the removed waste cartridge on a level surface, with the openings facing up. 
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 CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side, or with 
the openings facing down. 

 

 

6. Remove the cleaning rod from inside the printer. 

 

7. Insert the cleaning rod into one of the four cleaning holes until it stops, then pull out the rod. 
Repeat this two more times. 
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8. Repeat the procedure for the holes in the other three slots. 
9. Return the cleaning rod to its original location. 

 

10. To reinsert the waste cartridge, lower the bottom of the cartridge into position. To lock the cartridge 
into place, push the top forward until the latch clicks into place. 

 

11. Close the right-side door. 
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Cleaning the Color Density Sensors 

If the print or color density is too light, missing, or the background is foggy, clean the color density 
sensors. 
1. Power off the printer. For details, refer to Turning the Printer On and Off on page 52. 
2. Lift the rear door release and pull open the door. 

 

3. Use a dry cotton swab to clean the color density sensors. 

 

4. Close the rear door. 
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Adjustments and Maintenance Procedures 

This section includes: 
• Color Registration................................................................................................................................................................ 176 
• Color Calibration .................................................................................................................................................................. 177 
• Scan Color Consistency ..................................................................................................................................................... 177 
• Adjusting Paper Registration ......................................................................................................................................... 178 
• Transfer Voltage Adjustment ........................................................................................................................................ 180 
• Adjusting the Fuser ............................................................................................................................................................. 180 
• Adjusting the Altitude ....................................................................................................................................................... 180 
• Performing a Developer and Transfer Roller Cleaning Procedure ................................................................. 181 
 
 

Color Registration 

The printer automatically adjusts the color registration when automatic adjustment is turned on. You 
can also adjust color registration manually any time the printer is idle. You must adjust the color 
registration any time the printer is moved. If you are having printing problems, adjust the color 
registration. 
 

Performing a Color Registration Adjustment 

A color registration adjustment occurs every time a new toner cartridge is installed. You can run this 
adjustment at other times as needed. 

To perform a color registration adjustment: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Support > Color Registration. 
3. To perform an Automatic Color Registration adjustment, touch Start. 
4. At the successfully completed prompt, touch Close. 
5. To exit the menu, touch X. 
6. To return to the Home screen, press the Home button. 
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Color Calibration 

Use Color Calibration to adjust colors that appear incorrect, or for composite grays that look neutral. 

To perform a Color Calibration: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Support > Color Calibration. 
3. To select a screen to use for your calibration, touch Screen Type, then select an option. 

− To optimize color tones for copy jobs, touch Copy Job. 
− To optimize color tones for Standard print-quality print jobs, touch Print Job 1. 
− To optimize color tones for Enhanced print-quality print jobs, touch Print Job 2. 

4. To select a target job type for your calibration, touch Target, then select the type of output you 
want calibrated. 
− To optimize color only for copy jobs, touch Copy Jobs Only. 
− To optimize color only for print jobs, touch Print Jobs Only. 
− To optimize color for both copy and print jobs, touch Copy & Print Jobs. 
− If no adjustment is desired, touch None. 

5. To select the source paper tray, touch Paper Supply, then touch the desired tray. 
6. To begin the color calibration, touch Start. Follow the onscreen instructions. 
7. When finished, touch Close. 
8. To exit the menu, touch X. 
9. To return to the Home screen, press the Home button. 
 

Scan Color Consistency 

Use the Scan Color Consistency procedure to adjust scanned colors that appear incorrect, or for 
composite grays that look neutral. This procedure prints a Calibration Chart that you load into the 
automatic document feeder. The printer scans that page and uses the scanned values to complete 
the adjustments. 

To perform the Scan Color Consistency procedure: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Support > Color Scan Consistency. 
3. To select the desired procedure, touch Calibration Type, then select your procedure. 

− To perform the Scan Color Consistency procedure, touch Print Calibration Chart. Follow the 
onscreen instructions. 

− To restore your color scan settings to the previous settings, touch Restore Previous Settings. 
Follow the onscreen instructions. 

− To reset your color scan settings to factory-default values, touch Reset to Factory Defaults. 
Follow the onscreen instructions. 

4. When finished, touch Close. 
5. To exit the menu, touch X. 
6. When finished, to return to the Home screen, press the Home button. 
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Adjusting Paper Registration 

Use Adjust Paper Registration to adjust the placement of the printed image on the page. 
The adjustment allows you to place the top, bottom, left, and right margins exactly where you want. 
You can specify the image position on both the front and back sides of the paper, for each installed 
paper tray. 
 

Verifying Paper Registration 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to Logging In as the Administrator on page 265. 
3. Touch Device > Support > Image Position. 
4. Select the source paper tray for the registration print. 

a. Touch Paper Supply. 
b. Touch the desired tray. 

5. If your printer has automatic 2-sided printing, select the sides that you want to optimize. 
− To select a sample registration page for adjusting side 1, touch Adjusted Side, then touch 

Side 1. 
− To select a sample registration page for adjusting both sides, touch Adjusted Side, then touch 

Side 2. 
6. Specify the consecutive number of sample pages to print. 

a. Touch Print Settings. 
b. To increase or decrease the number of sample pages, for Quantity, touch Plus (+) or Minus (-), 

then touch OK. 
7. To print the sample pages, touch Print Sample. 
8. When printing is completed, touch Close. 
9. On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from the 

top, bottom, left, and right edges. 

Note: For identification, a single dot is printed on Side 1, and two dots are printed on Side 2. 

 

10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges. 
11. If the image is centered, no adjustment is required. If not centered, adjust the paper registration. 

For details, refer to Performing a Paper Registration Adjustment on page 179. 
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Performing a Paper Registration Adjustment 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to Logging In as the Administrator on page 265. 
3. Touch Device > Support > Image Position. 
4. To adjust registration, select the source paper tray. 

a. Touch Paper Supply. 
b. Touch the desired tray. 

5. Using the chart printed in Verifying Paper Registration, select the side for registration. 
a. For adjusting Side 1, touch Adjusted Side, then touch Side 1. 
b. For adjusting Side 2, touch Adjusted Side, then touch Side 2. 

6. To adjust the registration, touch Lead/Side Registration. 
a. To adjust the side-to-side registration, for Side Registration, touch Plus (+) or Minus (-). 
b. To adjust the top-to-bottom registration, for Lead Registration, touch Plus (+) or Minus (-). 

For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page. 
• For Lead Registration, a positive value shifts the image down the page. 
• For Side Registration, a positive value shifts the image to the left. 

 

7. To save your settings, touch OK. 
8. As needed, repeat steps 4 through 6 to enter additional values. 
9. Print another sample page, then repeat the process until you complete the registration corrections. 
10. To return to the Home screen, press the Home button. 
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Transfer Voltage Adjustment 

Use Transfer Voltage Adjustment to specify the bias transfer roller voltage for printing on the selected 
paper type. If the printed image is too light, increase the voltage for the paper you are using. If the 
printed image is mottled or blotchy-looking, decrease the voltage for the paper you are using. 

To adjust the transfer voltage: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Support > Transfer Voltage Adjustment. 
3. To perform an Automatic Color Registration adjustment, touch Start. 
4. To select the paper type for the adjustment, touch Paper Type, then touch the paper type. 
5. To adjust the transfer voltage, for Voltage Level, touch Plus (+) or Minus (-). 
6. Touch Adjust. 
7. To exit the menu, touch X. 
8. To return to the Home screen, press the Home button. 
 

Adjusting the Fuser 

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is 
smearing or can be rubbed off the paper, increase the temperature for the paper you are using. If the 
toner is blistered or mottled, decrease the temperature for the paper you are using. 

To adjust the fuser: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Support > Fuser Temperature Adjustment. 
3. To select the paper type, touch Paper Type, then touch the name of the paper type in the list. 
4. To increase or decrease the fusing temperature, press the arrow buttons, then touch Adjust. 
5. To adjust the fuser for another paper type, select it from the list, then repeat steps 3 and 4. 
6. To exit the menu, touch X. 
7. To return to the Home screen, press the Home button. 
 

Adjusting the Altitude 

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. 
If the altitude setting is incorrect, it can cause print-quality problems. 

To adjust the altitude: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Support > Altitude Adjustment. 
3. Touch the altitude of the location of the printer, then touch OK. 
4. To return to the Home screen, press the Home button. 
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Performing a Developer and Transfer Roller Cleaning Procedure 

When a printer sits idle for an extended time, it can result in visible background toner on prints. 
The Developer and Transfer Roller Cleaning procedure is used to reduce background toner on prints. 

To perform a Developer and Transfer Roller Cleaning procedure: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Support > Developer & Transfer Roller Cleaning. 
3. To perform a Developer and Transfer Roller Cleaning, touch Start. 
4. At the successfully completed prompt, touch Close. 
5. To exit the menu, touch X. 
6. To return to the Home screen, press the Home button. 
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Ordering Supplies 

This section includes: 
• Consumables ......................................................................................................................................................................... 182 
• Routine Maintenance Items ........................................................................................................................................... 182 
• When to Order Supplies .................................................................................................................................................... 183 
• Viewing Printer Supply Status........................................................................................................................................ 183 
• Toner Cartridges .................................................................................................................................................................. 184 
• Recycling Supplies ............................................................................................................................................................... 185 
• Checking Meter Readings ................................................................................................................................................ 185 
 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black. 
 

Notes: 

• Each consumable includes installation instructions. 
• Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner 

remaining amount displayed could be inaccurate. 
• To ensure print quality, the toner cartridge has been designed to cease functioning at a 

predetermined point. 
 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls 
by Xerox for specific use with this printer. 

 
 

Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 

Note: Each routine maintenance item includes installation instructions. 

Routine maintenance items for this printer include the following: 
• Cyan, Magenta, Yellow, and Black Drum Cartridges 
• Waste Cartridge 
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When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/WC6515supplies. 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation 
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for 
this printer. The Total Satisfaction Guarantee is available in the United States and Canada. 
Coverage could vary outside these areas. Please contact your Xerox representative for details. 

 
 

Viewing Printer Supply Status 

You can check the status and percentage of life remaining for your printer supplies at the control panel 
or from the Embedded Web Server. 

To view printer supply status in the Embedded Web Server: 
1. At your computer, open a Web browser. In the the address field, type the IP address of the printer, 

then press Enter or Return. 

Note: For details, refer to Finding the IP Address of Your Printer on page 33. 

2. To view the percentage of life remaining for toners, click Home. 
3. To view details, for Supplies, click Details. 

To view printer supply status at the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Supplies. 
3. To view additional details for an item, touch the item. 
4. To exit the menu, touch X. 
5. To return to the Home screen, press the Home button. 
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Toner Cartridges 

This section includes: 
• General Precautions ........................................................................................................................................................... 184 
• Replacing a Toner Cartridge ........................................................................................................................................... 184 
 
 

General Precautions 
 

 WARNINGS:  

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid 
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have 
the child spit out the toner, and rinse out their mouth with water. Consult a physician 
immediately. 

  

 WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove 
spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large 
volume of toner, contact your local Xerox representative. 

  

 WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge 
can catch fire and cause burn injuries or an explosion. 

  
 

Replacing a Toner Cartridge 

A message appears on the control panel when a toner cartridge must be replaced. 

Note: Each toner cartridge includes installation instructions. 
 

Printer Status Message Cause and Solution 

Reorder Toner The toner cartridge is low. Order a new toner cartridge. 

Out of Toner The toner cartridge is empty. Replace the toner cartridge 
with a new one. 
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Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 
 

Checking Meter Readings 

You can use Meter Readings to view impression count details for the printer. The current counts for color, 
black and white, and combined total impressions appear. Meter Readings track the total number of 
images and pages that are printed for the life of the printer. You cannot reset Meter Readings. For 
details, refer to Billing Meters/Usage Counters on page 35. 
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Moving the Printer 
 

 WARNINGS:  

• To lift the printer, always use at least two people to grasp the hand holds on each side of 
the printer. 

• To prevent you from dropping the printer or injury, lift the printer firmly by gripping the 
recessed areas on both sides of the printer. Never lift the printer by gripping any other 
areas. 

• If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. 
If the optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to the 
ground and cause injury. 

 

Follow these instructions when moving the printer: 
1. Power off the printer, then disconnect the power cord and other cables from the back of the printer. 

 
 

 WARNING: To prevent electric shock, never touch the power plug with wet hands. When 
removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can 
damage it, which can lead to fire or electric shock. 

 

2. Remove any paper from the Bypass Tray. 
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3. Close the Bypass Tray. 

 

4. Remove any paper or other media from the output tray. 

 

5. If the output tray extension is extended, close it. 
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6. Remove any paper from Tray 1, then close the tray. 

 
7. Keep the paper wrapped and away from humidity and dirt. 
8. If the optional 550-Sheet Feeder is installed, unlock, then uninstall it before you move the printer. 

 

9. Lift and carry the printer as shown in the illustration. 
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Notes: 

• When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the printer 
more than 10 degrees can cause toner spillage. 

• Repack the printer and its options using the original packing material and boxes or a Xerox 
Repackaging Kit. 

 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not 
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® 
Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer 
caused by improper moving. 

After moving the printer: 
1. Reinstall any parts that you removed. 
2. Reconnect the printer to the cables and power cord. 
3. Plug in and power on the printer. 
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General Troubleshooting 

This section includes: 
• Printer Does Not Power On ............................................................................................................................................. 192
• Printer Resets or Powers Off Frequently .................................................................................................................... 193
• Printer Does Not Print ........................................................................................................................................................ 193
• Printing Takes Too Long ................................................................................................................................................... 194
• Document Prints From Wrong Tray ............................................................................................................................ 195
• Automatic 2-Sided Printing Problems ........................................................................................................................ 195
• Printer is Making Unusual Noises ................................................................................................................................. 195
• Paper Tray Will Not Close ................................................................................................................................................ 195
• Condensation has Formed Inside the Printer ......................................................................................................... 196

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 

Printer Does Not Power On 

Probable Causes Solutions 

The power switch is not turned on. At the printer control panel, press the Power/Wake button. 
For details, refer to Turning the Printer On and Off on page 52. 

The power cord is not plugged into the outlet 
correctly. 

Power off the printer, and plug the power cord securely into the 
outlet. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and check if it
operates properly.

• Try a different outlet.

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 304. 

CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
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Printer Resets or Powers Off Frequently 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Power off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then power on the printer. 

A system error occurred. Power off the printer, then power on again. Print the Error History 
Report. For details, refer to Printing the Error History Report on page 
222. If the error persists, contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Power off the printer, then connect the power cord to a suitable 
outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other devices. 

Printer Does Not Print 

Probable Causes Solutions 

The printer is in Power Saver mode. On the control panel, press the Power/Wake button. 

The printer has an error. If the Status LED is blinking amber, follow the instructions on the 
control panel to clear the error. If the error persists, contact your 
Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

No control panel indicators are lit. Power off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then power on the printer. 
If the error persists, contact your Xerox representative. 

The printer is busy. • If the Status LED is flashing blue, a previous print job could be
the problem.
a. At your computer, use the printer properties to delete all

print jobs in the print queue.
b. At the control panel, touch Jobs, then delete all pending print

jobs.
• Load the paper in the tray.
• If the Status LED does not flash once after you send a print job,

check the connection between the printer and the computer.
Power off the printer, then turn it on again.

The printer cable is disconnected. If the Status LED does not flash once after you send a print job, 
check the connection between the printer and the computer. 
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Probable Causes Solutions 

There is a network-connectivity issue. If the printer is connected to a network: 
a. Verify that the Ethernet cable is connected to the printer.
b. On the printer Ethernet connector, verify that the green LED

is On. If not, reseat both ends of the Ethernet cable.
c. Examine the TCP/IP address in the Communication section

of the Configuration Report. For details, refer to Printing the
Configuration Report on page 32.

d. If the TCP/IP address is 0.0.0.0, the printer needs more time
to acquire an IP address from the DHCP server. Wait 2
minutes, then print the Configuration Report again.

e. If the TCP/IP address is unchanged, or begins with 169,
contact your network administrator.

There is a wireless network setup or 
connectivity issue. 

Verify that the Wireless Network Adapter is installed and properly 
configured. For details, refer to Connecting to a Wireless Network. 

Printing Takes Too Long 

Probable Causes Solutions 

The printer is set to a slower printing mode. 
For example, the printer could be set to print 
on Heavyweight paper. 

It takes more time to print on certain types of special paper. Ensure 
that the paper type is set properly in the driver and at the printer 
control panel. For details, refer to Print Speed on page 305. 

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out of 
Power Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, 
print some information pages such as the Demonstration Print. 
For details, refer to Information Pages on page 32. If the page 
prints at the rated speed of the printer, there could be a network or 
printer installation issue. For more help, contact the system 
administrator. 

The job is complex. Wait. No action needed. 

The print-quality mode in the driver is set to 
Enhanced. 

Change the print-quality mode in the print driver to Standard. 
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Document Prints From Wrong Tray 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver.
2. Go to the page setup or printer settings of the application from

which you are printing.
3. Set the paper source to match the tray selected in the print

driver or set the paper source to Automatically Select.

Note: To have the print driver select the tray, set the tray used as 
the paper source to Auto Selection Enabled. 

Automatic 2-Sided Printing Problems 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using a supported paper size and weight for 
2-sided printing. Envelopes and labels cannot be used for 2-sided 
printing. For details, refer to Supported Standard Types and 
Weights for Automatic 2-Sided Printing on page 71. 

Your printer model is not configured with 
automatic 2-sided printing. 

Ensure that your printer supports automatic 2-sided printing. For 
details, refer to Printer Configurations and Options on page 298. 

Incorrect setting. In the print driver Paper/Output tab, select Properties > 2-Sided 
Print. 

Printer is Making Unusual Noises 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Power off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox representative. 

Paper Tray Will Not Close 

Probable Causes Solutions 

The paper tray does not fully close. • If the tray is extended for legal-size paper, the tray protrudes
when it is inserted into the printer. For details, refer to
Configuring Trays 1 or 2 for the Paper Length on page 75.

• Some debris or an object is blocking the tray.
• The tray is hanging up on the table or shelf on which it is

located.
• If the paper lift at the back of the tray is not locked down,

replace the tray.
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Condensation has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 

Probable Causes Solutions 

The printer has been sitting in a cold room. Allow the printer to operate for several hours at room temperature. 

The relative humidity of the room is too high. • Reduce the humidity in the room.
• Move the printer to a location where the temperature and

relative humidity are within the operating specifications.
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Paper Jams 

This section includes: 
• Locating Paper Jams .......................................................................................................................................................... 197
• Minimizing Paper Jams ..................................................................................................................................................... 198
• Clearing Paper Jams ........................................................................................................................................................... 199
• Troubleshooting Paper Jams .......................................................................................................................................... 210
• Print-Quality Problems ...................................................................................................................................................... 212
• Copy and Scan Problems.................................................................................................................................................. 218
• Fax Problems ......................................................................................................................................................................... 219
 

Locating Paper Jams 

WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. 
If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch 
off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after 
the printer has cooled. If the error persists, contact your Xerox representative. 

CAUTION: Do not attempt to clear any paper jams using tools or instruments, which can damage 
the printer permanently. 

The following illustration shows where paper jams can occur along the paper path: 
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1. Tray 2
2. Single-Pass Duplex Automatic Document Feeder
3. Fuser

4. Bypass Tray
5. Tray 1

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver.
• Using damaged paper.
• Using unsupported paper.
• Loading paper incorrectly.
• Overfilling the tray.
• Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, refer to Supported Paper on page 68.
• Follow proper paper handling and loading techniques.
• Always use clean, undamaged paper.
• Avoid paper that is curled, torn, moist, creased, or folded.
• To separate the sheets before loading into the tray, fan the paper.
• Observe the paper tray fill line; never overfill the tray.
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted

can cause poor print quality, misfeeds, skewed prints, and printer damage.
• After loading the tray, at the control panel, select the correct paper type and size.
• When printing, select the correct type and size in the print driver.
• Store paper in a dry location.

Avoid the following: 
• Polyester coated paper that is designed specially for inkjet printers.
• Paper that is folded, wrinkled, or excessively curled.
• Loading more than one type, size, or weight of paper in a tray at the same time.
• Overfilling the tray.
• Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/rmlna. 
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Clearing Paper Jams 

This section includes: 
• Clearing Paper Jams from the Duplex Automatic Document Feeder .......................................................... 199
• Clearing Paper Jams from the Bypass Tray ............................................................................................................. 201
• Clearing Paper Jams from the Tray 1 Area .............................................................................................................. 203
• Clearing Paper Jams from the Tray 2 Area .............................................................................................................. 206
• Clearing Paper Jams from the Fuser Area ................................................................................................................ 208

Clearing Paper Jams from the Duplex Automatic Document Feeder 
1. Open the Top Cover and remove any paper.

2. If paper is jammed in the Single-Pass Duplex Automatic Document Feeder, open the Document
Cover.
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3. To access the jammed paper, open the Second-Side Scanning Access Cover, then remove any
jammed paper.

4. Close the Second-Side Scanning Access Cover.

5. Close the Document Cover, then reload the document in the Single-Pass Duplex Automatic
Document Feeder.
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To prevent paper jams: 
• Do not load original documents above the MAX fill line.
• Adjust the paper guides so that they fit against the original documents.
• Use only supported paper. For details, refer to Single-Pass Duplex Automatic Document Feeder

Guidelines on page 121.

Clearing Paper Jams from the Bypass Tray 

To resolve the error displayed on the control panel, you must clear all paper from the paper path. 
1. Remove any paper from the Bypass Tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Remove Tray 1 from the printer.
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4. Remove the jammed paper.

5. Insert Tray 1 into the printer, then push it all the way in.

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the 
printer. 

6. Insert the Bypass Tray completely into the printer.

7. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type and size.
a. If the paper size and type are correct, touch OK.
b. If the paper size or type are incorrect, change the settings.

• To select a sheet size, touch the current size setting, then from the list, select the size.
• To select a paper type, touch the current paper type, then from the list, select the type.
• To save the settings, touch OK.
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8. If no prompt appears when paper is loaded, set the paper type and size.
a. At the printer control panel, press the Home button.
b. Touch Device > Paper Trays.
c. To open the Bypass Tray menu, touch the Bypass Tray icon. It is displayed in the top position,

before the numbered trays.
d. To select a paper or envelope size, touch the current size setting, then from the list, select a size.
e. To select a paper type, touch the current paper type, then from the list, select a paper type.
f. To save the setting, touch OK.
g. To return to the Home screen, press the Home button.

Clearing Paper Jams from the Tray 1 Area 

To resolve the error displayed on the control panel, you must clear all paper from the paper path. 
1. Remove any paper from the Bypass Tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.
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3. Remove Tray 1 from the printer.

4. Remove any crumpled paper from the tray and any remaining paper jammed in the printer.

5. Insert Tray 1 into the printer, then push it all the way in.

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the 
printer. 
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6. Insert the Bypass Tray completely into the printer.

7. If the control panel prompts you, verify the size and type on the screen. If you are not prompted,
change the paper settings.
a. At the printer control panel, press the Home button.
b. Touch Device > Paper Trays.
c. In the Paper Trays menu, touch the desired tray.
d. To configure the printer to prompt you to set the paper type and size when paper is loaded,

touch Tray Mode, then touch Fully Adjustable.
e. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated.

• To select a paper or envelope size, touch the current size setting, then from the list, select
the size.

• To select a paper type, touch the current paper type, then from the list, select the paper
type.

• To select a paper color, touch the current paper color, then from the list, select the paper
color.

f. To save the setting, touch OK.
g. To return to the Home screen, press the Home button.
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Clearing Paper Jams from the Tray 2 Area 

To resolve the error displayed on the control panel, you must clear all paper from the paper path. 
1. Pull out Tray 2 until it stops.

2. To remove the tray, lift the front of it slightly, then pull it out of the printer.

3. Remove any crumpled paper from the tray and any remaining paper jammed at the front of the
printer.
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4. At the back of the printer, open the Tray 2 Door, then remove any paper jammed at the back of the
printer.

5. Insert Tray 2 into the printer, then push it all the way in.

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the
printer.

6. If the control panel prompts you, verify the size and type on the screen. If you are not prompted,
change the paper settings.
a. At the printer control panel, press the Home button.
b. Touch Device > Paper Trays.
c. In the Paper Trays menu, touch the desired tray.
d. To configure the printer to prompt you to set the paper type and size when paper is loaded,

touch Tray Mode, then touch Fully Adjustable.
e. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated.

• To select a paper or envelope size, touch the current size setting, then from the list, select
the size.

• To select a paper type, touch the current paper type, then from the list, select the paper
type.

• To select a paper color, touch the current paper color, then from the list, select the paper
color.

f. To save the setting, touch OK.
7. To return to the Home screen, press the Home button.
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Clearing Paper Jams from the Fuser Area 

To resolve the error displayed on the control panel, clear all paper from the paper path. 
1. Lift the rear door release and pull open the door.

2. To open the paper guide on the top of the fuser, lift the paper guide tab.

3. Remove any jammed paper from the back of the printer.
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4. Close the paper guide on the fuser.

5. Close the rear door.
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together ................................................................................................................................... 210
• Paper Misfeeds ..................................................................................................................................................................... 210
• Label and Envelope Misfeeds ......................................................................................................................................... 211
• Paper Jam Message Stays On ........................................................................................................................................ 211
• Jams During Automatic 2-Sided Printing ................................................................................................................. 211

Multiple Sheets Pulled Together 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present. Try a new ream of paper. 

Using unsupported paper. Use only Xerox®-approved paper. For details, refer to Supported 
Paper on page 68. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 

The feed rollers are dirty. Clean the feed rollers. For details, refer to Cleaning the Printer on 
page 166. 

Paper Misfeeds 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the tray.
• Adjust the paper guides in the tray to match the size of the

paper.

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, 
do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox approved paper. For details, refer to Supported 
Paper on page 68. 

The feed rollers are dirty. Clean the feed rollers. For details, refer to Cleaning the Printer on 
page 166. 
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Label and Envelope Misfeeds 

Probable Causes Solutions 

The label sheet is facing the wrong way in 
the tray. 

• Load label sheets according to the instructions from the
manufacturer.

• Load labels in the tray, face up.
For details, refer to Labels on page 87. 

Labels are missing, curled, or pulled away 
from the backing sheet. 

Do not use any sheet where labels are missing, curled, or pulled 
away from the backing sheet. 

Envelopes are loaded incorrectly. You can print envelopes from the Bypass tray or Tray 1. 
For details, refer to Envelopes on page 81. 

Envelopes are wrinkling. • The heat and pressure of the laser printing process can cause
wrinkling.

• Use supported envelopes. For details, refer to Guidelines for
Printing Envelopes on page 81.

Note: When you load envelopes long-edge feed, ensure that you 
specify landscape orientation in the print driver. 

Paper Jam Message Stays On 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed all 
of the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 

Note: Check for, and remove, torn pieces of paper in the paper path. 

Jams During Automatic 2-Sided Printing 

Probable Causes Solutions 

Using paper of the wrong size, thickness, or 
type. 

Use paper of the correct size, thickness, or type. For details, refer to 
Supported Paper Sizes for Automatic 2-Sided Printing on page 71. 

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For details, refer to 
Supported Paper on page 68. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Print-Quality Problems 

This section includes: 

• Controlling Print Quality ................................................................................................................................................... 212

• Paper and Media ................................................................................................................................................................. 213

• Solving Print-Quality Problems ...................................................................................................................................... 213

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC6515support. 

CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Contact your local Xerox representative for details. 

Notes: 

• To ensure consistent print quality, the toner/print/drum cartridges for many devices are
designed to cease functioning at a predetermined point.

• Grayscale images printed with the composite black setting increment the color pages counter,
because color consumables are used. Composite black is the default setting on most printers.

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color 
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The range for optimal print quality 
is 15–28ºC (59–82ºF) and 20–70% relative humidity. However, print quality can be affected when 
operating near the limits for both temperature and humidity. 
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Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox approved paper. For details, refer to Supported Paper on page 68. 
• Use only dry, undamaged paper. 
 

 CAUTIONS: Some paper and other media types can cause poor output quality, increased paper 
jams, or damage your printer. Do not use the following: 

• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 

• Ensure the paper type selected in your print driver matches the paper type on which you are 
printing. 

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is 
selected in the print driver. 

• Store your paper and other media properly for optimum print quality. For details, refer to Paper 
Storage Guidelines on page 69. 

 

Solving Print-Quality Problems 

When the print quality is poor, select the closest symptom from the following table and refer to the 
corresponding solution to correct the problem. You can also print a Demo Page to more precisely 
determine the print-quality problem. For details, refer to Information Pages on page 32. 

If the print quality does not improve after performing the appropriate action, contact your Xerox 
representative. 
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Notes: 

• To enhance print quality, the toner/print/drum cartridges for many models of equipment are 
designed to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color-pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

 

Symptom Probable Causes Solutions 

• Page Margins Are 
Inconsistent. 

• The image is not centered 
on the page or the margins 
are not consistent. 

 

A paper registration 
adjustment is 
needed. 

Use the paper registration procedure to adjust the image 
position on the page. For details, refer to Adjusting Paper 
Registration on page 178. 

Faded printouts with multiple 
colors faded. 

 
 

The toner cartridges 
are not Xerox® toner 
cartridges. 

Verify that the toner cartridges meet specifications, and 
replace them if necessary. 

The paper being used 
is outside the 
recommended 
specification range. 

Replace the paper with a recommended size and type, 
and confirm that your control panel and print driver 
settings are correct. For details, refer to Supported Paper 
on page 68. 

The paper type is 
heavier or thicker 
than the paper type 
selection. 

• Ensure that the proper paper is loaded in the paper 
tray. 

• Choose a heavier paper type at the control panel and 
in the print driver. 

• Use a lighter paper or paper type. 

The bias transfer 
voltage is not 
properly adjusted for 
the paper type. 

Verify that the paper types set in the control panel and 
the print driver match the paper loaded in the tray. 

The settings in the 
application or print 
driver are incorrect. 

Print the Demonstration Print from the Information Pages 
menu. For details, refer to Information Pages on page 32. 
If the Demo Print looks correct, the printer is printing 
properly. Verify that the application and the print driver 
selections are correct for your print job. 

The paper is damp. Replace the paper. 

The high-voltage 
supply is defective. 

For assistance, go to the Xerox® Support website at 
www.xerox.com/office/WC6515support. 
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Symptom Probable Causes Solutions 

Only one color is faded. 

 

Toner cartridge is 
empty or damaged. 

Check the condition of the toner cartridge and replace it if 
necessary. 

Color around the edge of 
printing is incorrect. 

The color registration 
is incorrect. 

Adjust the color registration. For details, refer to Color 
Registration on page 176. 

Stray black dots or white areas 
(dropouts). 

 

The paper is outside 
the recommended 
specification range. 

Replace the paper with a recommended size and type, 
and confirm that your control panel and print driver 
settings are correct. For details, refer to Supported Paper 
on page 68. 

There is debris on the 
rollers. 

Wipe the feed rollers with a clean damp cloth to remove 
debris from the rollers. 

Note: Do not touch the transfer roller or the exposed end 
of the transfer belt. Fingerprints can cause print-quality 
issues. 

The toner cartridges 
are not Xerox® toner 
cartridges. 

Ensure that the toner cartridges meet specifications and 
replace them if necessary. For details, refer to 
Consumables on page 182. 

• Vertical black or color 
streaks or multiple colored 
streaks or lines. 

• Streaks in only one color. 

 

The toner cartridges 
are not Xerox® toner 
cartridges. 

Ensure that the toner cartridges meet specifications and 
replace them if necessary. For details, refer to 
Consumables on page 182. 

Debris in the printer 
is dragging against 
the toner before it is 
fused. 

Remove any debris or paper scraps from the paper path 
under the rear cover. 

There is a problem 
with the toner 
cartridge for that 
color. 

Check the toner cartridge for damage and replace if 
necessary. For assistance, go to the Xerox® Support 
website at www.xerox.com/office/WC6515support. 
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Symptom Probable Causes Solutions 

Partial blanks, creased paper, or 
blotted printing. 

 

The paper is damp. Replace the paper. 

The paper is outside 
the recommended 
specification range. 

Replace the paper with a recommended size and type. For 
details, refer to Supported Paper on page 68. 

The printer is worn or 
damaged. 

For assistance, go to the Xerox® Support website at 
www.xerox.com/office/WC6515support. 

The toner cartridges 
are not Xerox® toner 
cartridges. 

Verify that the toner cartridges meet specifications and 
replace if necessary. For details, refer to Consumables on 
page 182. 

The paper is impeded 
in the paper path. 

• Remove any paper or debris from the paper path. 
• Ensure that the trays are pushed in all the way. 
• Ensure that the rear cover is closed and locked. 

Condensation inside 
the printer causes 
partial blanks or 
creased paper. 

Power on the printer and leave it on for at least one hour 
to get rid of the condensation. For assistance, go to the 
Xerox® Support website at 
www.xerox.com/office/WC6515support. 

Vertical blanks appear. 

 

The LED lenses are 
blocked. 

Clean the LED lenses. For details, refer to Cleaning the LED 
Lenses on page 171. 

The printer is worn or 
damaged. 

For assistance, go to the Xerox® Support website at 
www.xerox.com/office/WC6515support. 

The toner cartridges 
are not Xerox® toner 
cartridges. 

Ensure that the toner cartridges meet specifications and 
replace if necessary. 

White lines or streaks running 
through only one color. 

 

Something is 
blocking the lens for 
the affected color. 

Clean the lens for the affected color. For details, refer to 
Cleaning the LED Lenses on page 171. 
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Symptom Probable Causes Solutions 

White line or lines running 
through all colors. 

 

Paper or debris is 
dragging the bottom 
of the transfer belt. 

• Remove the paper or debris from the printer. 
• For assistance, go to the Xerox® Support website at 

www.xerox.com/office/WC6515support. 

Slanted printing. 

 

The paper guides in 
the trays are not set 
correctly. 

Reset the paper tray guides. For details, refer to Loading 
Paper on page 72. 

Blotchy or mottled images. 

 

The paper is too light 
or too thin. 

Choose a different paper type at the control panel, in the 
application, and in the print driver. 

The paper is damp. Replace the paper. 

The humidity is too 
high. 

Reduce the humidity in the room or move the printer to a 
new location. 

Spots or lines appear at regular 
intervals on the prints. 

 

One or more of the 
components in the 
paper path is 
marking the paper. 

1. Print the Repeating Defects pages. 
At the control panel, touch Device > Support > 
Support Pages > Repeating Defects. 

2. To determine the cause, measure the distance 
between the print defects. 

• 28 mm (1.1 in.) - Drum Cartridge 
• 52 mm (2.1 in.) - Drum Cartridge 
• 94 mm (3.7 in.) - Drum Cartridge 
• 56.5 mm (2.2 in.) - Transfer Roller 
• 63 mm (2.5 in.) - Fuser 
• 67 mm (2.6 in.) - Fuser 
3. If the repeating defects match one of the Drum 

Cartridge distances, replace the one for the affected 
color. 

4. If the distance matches the fuser or transfer roller, call 
for service. 
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Copy and Scan Problems 

If the copy or scan quality is poor, refer to the following table. 
 

Symptoms Solutions 

Lines or streaks only present in copies made 
from the document feeder. 

There is debris on the CVT glass or the second-side scanning lens 
assembly. When scanning, the paper from the document feeder 
passes over the debris on the glass surfaces, resulting in lines and 
streaks. Clean all glass surfaces with a lint-free cloth. For details, 
refer to Cleaning the Scanner on page 166. 

Spots present in copies taken from the 
document glass. 

There is debris on the document glass. When scanning, the debris 
creates a spot on the image. Clean all glass surfaces with a lint-free 
cloth. 

Image is too light or too dark. Adjust the lighten/darken setting. 

Colors are inaccurate. • Adjust color settings and confirm that the correct Original Type 
is set. 

• Perform the Scan Color Consistency procedure. For details, refer 
to Color Registration on page 176. 

If the problem persists, for online support information, go to www.xerox.com/office/WC6515support. 
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Fax Problems 

This section includes: 
• Problems Sending Faxes................................................................................................................................................... 219 
• Problems Receiving Faxes ................................................................................................................................................ 220 
 

Note: If you cannot send and receive faxes, make sure that you are connected to an approved 
analog telephone line. The fax cannot send or receive when connected to a digital phone line. 

If you cannot send or receive faxes correctly, refer to the following tables. 
 
 

Problems Sending Faxes 
 

Symptoms Causes Solutions 

The document is not scanned 
using the document feeder. 

The document is too thick, too thin, or 
too small. 

Use the document glass to send the 
fax. 

The document is scanned at an 
angle. 

The document feeder guides are not 
adjusted to the width of the document. 

Adjust the document feeder guides to 
fit the width of the document. 

The fax received by the recipient 
is blurry. 

The document is positioned incorrectly. Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too light. Adjust the resolution. 

There is a problem with the telephone 
connection. 

Verify that the telephone line is 
working, then send the fax again. 

There is a problem with the fax 
machine of the caller. 

Make a copy to verify that your printer 
is operating correctly. If the copy was 
printed correctly, have the recipient 
verify the condition of the receiving fax 
machine. 

The fax received by the recipient 
is blank. 

The document was loaded incorrectly. • Document feeder: Place the original 
document face up. 

• Document glass: Place the original 
document face down. 

Fax was not transmitted. The fax number is wrong. Verify the fax number. 

The telephone line is connected 
incorrectly. 

Verify the telephone connection. If it is 
disconnected, connect it. 

There is a problem with the fax 
machine of the recipient. 

Contact the recipient. 

The fax is not installed or is not 
enabled. 

Verify that the fax is installed and 
enabled. 

 

If the problem persists, for online support information, go to www.xerox.com/office/WC6515support. 
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Problems Receiving Faxes 
 

Symptoms Causes Solutions 

The received fax is blank. There is a problem with the telephone 
connection or with the fax machine of 
the caller. 

Verify that the printer can make clean 
copies. If it can, have the caller send 
the fax again. 

The sender loaded the pages 
incorrectly. 

Contact the sender. 

The printer answers the call, but 
does not accept incoming data. 

Not enough memory. If the job contains several graphics, the 
printer could not have enough memory. 
The printer does not answer when 
memory is low. Delete stored 
documents and jobs then wait for the 
existing job to complete. This increases 
available memory. 

The received fax size is reduced. The paper supply in the printer does 
not match the document size sent. 

Confirm the original size of the 
documents. Documents could be 
reduced based on the available paper 
supply in the printer. 

Faxes cannot be received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to automatic reception. 

The memory is full. Load paper if it is empty, and then print 
the faxes stored in the memory. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. If 
it is disconnected, connect it. 

There is a problem with the fax 
machine of the sender. 

Make a copy to verify that your printer 
is operating correctly. If the copy prints 
correctly, have the recipient verify their 
fax machine is operating correctly. 

If the problem persists, for online support information, go to www.xerox.com/office/WC6515support. 
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Getting Help 

This section includes: 
• Viewing Warning Messages on the Control Panel ................................................................................................ 221 
• Viewing Current Faults on the Control Panel .......................................................................................................... 221 
• Using the Integrated Troubleshooting Tools ......................................................................................................... 221 
• Online Support Assistant .................................................................................................................................................. 222 
• Information Pages .............................................................................................................................................................. 222 
• More Information ............................................................................................................................................................... 223 

Your printer comes with utilities and resources to help you troubleshoot printing problems. 
 
 

Viewing Warning Messages on the Control Panel 

When a warning condition occurs, a message appears on the control panel to inform you of the problem. 
Warning messages inform you about printer conditions, such as low supplies or open doors, that require 
your attention. If more than one warning condition occurs, only one appears on the control panel. 
 

Viewing Current Faults on the Control Panel 

When a fault condition occurs, a message appears on the control panel to inform you of the problem. 
Fault messages warn you about printer conditions that prevent the printer from printing or degrade 
printing performance. If more than one fault occurs, only one is displayed on the control panel. 
 

Using the Integrated Troubleshooting Tools 

Your printer has a printable set of reports. Two of them, the Demo Page and the Error History report, can 
help with troubleshooting certain problems. The Demo Page prints an image using many colors to show 
the current ability of the printer to print. The Error History report prints information on the most recent 
printer errors. 
 

Printing Information Pages 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. To print an information page, touch the desired page. 
4. To return to the Home screen, press the Home button. 
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Printing the Error History Report 
1. At the printer control panel, press the Home button. 
2. To print the Error History Report, touch Device > Support > Support Pages > Error History Report. 
3. To return to the Home screen, press the Home button. 
 

Viewing Meter Readings 
1. At the printer control panel, press the Home button. 
2. Touch Device > Billing/Usage. 
3. To view more details, touch Usage Counters and select an option. 
4. After viewing the usage readings, to return to the Home screen, press the Home button. 
 

Online Support Assistant 

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/WC6515support. 
 

Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/WC6515docs  

Recommended Media List United States: www.xerox.com/rmlna  
European Union: www.xerox.com/rmleu  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and print driver downloads. 

www.xerox.com/office/WC6515support  

Information Pages Print from the control panel. For details, refer to 
Information Pages on page 32. 

Order supplies for your printer www.xerox.com/office/WC6515supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
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Connecting the Printer 

This section includes: 
• Connecting to a Wireless Network Using the Embedded Web Server ......................................................... 227 
• Connecting to a Wireless Network Using the Control Panel ............................................................................ 228 
• Setting Up the Printer for Wireless LAN WPA2 Enterprise ................................................................................ 228 
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• Changing the IP Address Using the Embedded Web Server ............................................................................ 232 
• NFC ............................................................................................................................................................................................ 232 
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Connecting to a Wireless Network Using the Embedded Web Server 

When connecting to a wireless network that does not include a WPS-compliant router, set up and 
configure the printer manually. Before starting, obtain the router setup and configuration information, 
such as name and passphrase. For assistance, contact your system administrator. 

Notes: 

• To use the Embedded Web Server to set up the printer on a wireless network, connect the 
printer to your computer through an Ethernet wired network. 

• Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

To connect to a wireless network manually from the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Connectivity. 
4. For Connections, click Wi-Fi. 
5. In the SSID field, enter the network SSID (name). 
6. To select the Network Type, from the menu, select Infrastructure or AdHoc. 

Note: The Infrastructure network type provides the greatest selection of security options. AdHoc 
provides only WEP encryption in most networks. 

7. To select Encryption, for Security Settings, select the appropriate security option for your router. 
8. To remove the dots in the Passcode fields, select the dots, then press the backspace key. 
9. In the Passcode field, enter the network passcode. 
10. In the Retype Passcode field, reenter the network passcode. 
11. Click OK. 
12. To activate your changes, at the prompt, click Restart Now. 
13. Disconnect the Ethernet cable from the printer. 

Note: When the printer restarts, it uses the information from the Embedded Web Server to connect 
with the wireless router. 

14. After the printer restarts, wait two minutes, then to get the network information that includes the 
IP address, print a Configuration Report. For details, refer to Printing the Configuration Report on 
page 32. 

15. If the printer does not successfully connect with the wireless network, check your network 
information and try again. 
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Connecting to a Wireless Network Using the Control Panel 

You can connect to a wireless network manually using the printer control panel. For details, refer to 
Connecting to a Wireless Network Manually on page 50. 
 

Setting Up the Printer for Wireless LAN WPA2 Enterprise 

WPA-Enterprise Encryption is supported only when Infrastructure is selected as the Network Type in the 
Wi-Fi settings section. 

Note: To manage digital certificates, enable HTTPS communication. 

1. Import the required security certificate. For details, refer to Importing a Digital Certificate on page 
291. 

Note: Use Internet Explorer to import the certificate from Windows. Use Safari to import certificates 
from Macintosh. 

2. Verify the Certificate Authorities within the category. For details, refer to Verifying the Digital 
Certificate Purpose on page 291. 

3. Configure WPA2 Enterprise. For details, refer to Configuring WPA2 Enterprise Authentication on 
page 228. 

 

Configuring WPA2 Enterprise Authentication 
Note: WPA-Enterprise settings are unique for each network. For details on your settings, contact 
your network administrator. 

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 
press Enter or Return. 

2. Click Connectivity. 

Note: If this feature does not appear, log in as a system administrator. For details, refer to Logging 
In as the Administrator on page 265. 

3. For Connections, click Wi-Fi. 
4. Enter the SSID. 
5. For Network Type, select an option. 
6. Verify the TCP/IP Settings. 
7. For Security Settings, select an Encryption option, then enter the required information. 
8. Click OK. 
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Configuring Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. Wi-Fi Direct is disabled by default. For details, refer to Configuring Wi-Fi Direct on 
page 229. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

To configure Wi-Fi Direct: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Connectivity. 
4. For Connections, click Wi-Fi Direct. 
5. To enable Wi-Fi Direct, click the Enable toggle button. 
6. For Group Role, select an option: 

Group Owner 
a. To set the printer as Group Owner for a Wi-Fi Direct group, for Group Role, select Group Owner. 

Note: A Wi-Fi Direct group is similar to a wireless access point. 

b. In the DHCP Server area, for IP Address, use the default or type a new IP Address. 
c. For IP Address Lease Time, use the default or type a value in minutes. 
d. In the Group Owner area, for SSID, type a name to appear in a list of available wireless 

networks and devices. 

Note: The SSID is the name that that represents the printer on the network. 

e. In the Passcode field, type the network passcode. 

Note: To remove the dots in the Passcode field, select the dots, then press the backspace key. 

Auto 
a. For Group Role, select Auto. 
b. For Device Name, type a name to appear in a list of available wireless networks and devices. 
c. In the DHCP Server area, for IP Address, use the default or type a new IP Address. 
d. For IP Address Lease Time, use the default or type a value in minutes. 

7. Click OK. 
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Disabling Wireless Networking 

Disabling Wireless Networking from the Control Panel 

You can disable the wireless network from the printer control panel. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

To disable wireless networking from the Control Panel: 
1. At the printer control panel, press the Home button. 
2. To open the Wi-Fi menu, touch Device > Connectivity > Wi-Fi. 
3. To toggle Wi-Fi from On to Off, touch the Wi-Fi toggle button. 
4. Touch OK. 
5. Press the Home button. 
6. For the setting to take effect, at the prompt, touch Restart Now. 
 

Disabling Wireless Networking From the Embedded Web Server 
Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 
press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Connectivity. 
4. For Connections, click Wi-Fi. 
5. Click the Enable toggle button. 

Note: If Wi-Fi is disabled, the check mark on the toggle button is not visible. 

6. Click OK. 
7. To activate your changes, at the prompt, click Restart Now. 
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Assigning the IP Address Manually 
You can assign a static IP address to your printer from the printer control panel. After an IP address is 
assigned, you can change it in the Embedded Web Server. 

To assign a static IP address to the printer, ensure that you have the following information: 
• An IP address that is configured properly for your network 
• The Network Mask address 
• The default Router/Gateway address 

If you are on a network that is managed by a network administrator, contact your network administrator 
to obtain the network information. 

For a home network using routers or other devices to connect the printer to the network, refer to the 
device instructions on assigning network addresses. The router or device documentation can give you a 
range of acceptable address numbers you can use. It is important that the addresses be similar to the IP 
addresses used by other printers and computers on the network, but not the same. Only the last digit 
must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer 
has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4. 

The router can assign the static IP address of the printer to another computer that obtains its IP address 
dynamically. To avoid having the IP address reassigned, provide the printer an address at the higher end 
of the range that the device or router allows. For example, if your computer has IP address 192.168.1.2, 
and your device allows IP addresses to 192.168.1.255, select an address between 192.168.1.200 and 
192.168.1.254. 

Note: It is recommended when setting a static IP address, that at the same time, set a DHCP reservation. 
For details, refer to your router documentation. 

In IPv6 network configurations, the IPv6 address is assigned automatically. 

To assign a static IP address to the printer: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Connectivity > Ethernet > IPv4. 
3. Touch STATIC. 
4. At the restart system prompt, touch Continue. 
5. Touch the IPv4 Address field. 
6. Using the keypad, enter the address as X.X.X.X, where X is a number from 0–255, then touch Enter. 
7. Touch the Subnet Mask field. 
8. Using the keypad, enter the address as X.X.X.X, where X is a number from 0–255, then touch Enter. 
9. Touch the Gateway Address field. 
10. Using the keypad, enter the address as X.X.X.X, where X is a number from 0–255, then touch Enter. 
11. Touch Restart. 
12. Two minutes after the printer restarts, verify that the printer has retained the IP Address. For details, 

refer to Finding the IP Address of Your Printer on page 33. 

For reference:  
Online Support Assistant at: www.xerox.com/office/WC6515support  
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Changing the IP Address Using the Embedded Web Server 

To change the IP address of the printer using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. Click Connectivity. 
3. Click Ethernet. 
4. For IPv4, click Edit. 
5. On the IPv4 page, click STATIC. 
6. In the IP Address field, type the address as X.X.X.X, where X is a number from 0–255. 
7. In the Subnet Mask field, type the address as X.X.X.X, where X is a number from 0–255. 
8. In the Gateway Address field, type the address as X.X.X.X, where X is a number from 0–255. 
9. Click OK. 

Note: Changing the IP address disconnects the Embedded Web Server. 

10. To reconnect to the Embedded Web Server, in the address field of the Web browser, type the new IP 
address of the printer. 

11. Press Enter or Return. 
The Embedded Web Server opens. 

 

NFC 

Near field communication (NFC) is a technology that enables devices to communicate when they are 
within 10 centimeters of each other. 

You can use NFC to obtain the network interface to establish a TCP/IP connection between your device 
and the printer. 

To configure NFC: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Connectivity. 
4. For Connections, click NFC. 
5. To enable NFC, click the Enable toggle button, then touch OK. 
6. Click OK. 
7. For the new settings to take effect, restart your printer. 
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Configuring General Settings Using the 
Embedded Web Server 

This section includes: 
• Viewing Printer Information .......................................................................................................................................... 234 
• Configuring the Login Method From the Embedded Web Server ................................................................. 234 
• Configuring Power Saver Using the Embedded Web Server ............................................................................ 235 
• Setting the Date and Time Using the Embedded Web Server ........................................................................ 236 
• Configuring the Device Control Panel Timeout ..................................................................................................... 236 
• Configuring the Device Website Timeout ................................................................................................................ 237 
• Setting the Default Device Control Panel Screen ................................................................................................. 237 
• Configuring Tray Settings Using the Embedded Web Server .......................................................................... 238 
• Cloning Printer Settings .................................................................................................................................................... 239 
• Resetting the Printer .......................................................................................................................................................... 239 
• Setting Up a Proxy Server ................................................................................................................................................ 240 
• Setting Up the Network Address Book ....................................................................................................................... 240 
• Adding or Editing Contacts in the Address Book in the Embedded Web Server ..................................... 241 
• Adding or Editing Contacts in the Address Book at the Control Panel ........................................................ 242 
• Configuring Alerts ............................................................................................................................................................... 242 
• Configuring Email Alerts .................................................................................................................................................. 243 
• Configuring PDL Settings from the Embedded Web Server ............................................................................. 243 

This section provides information to help you configure general settings for the printer from your Web 
browser using the Embedded Web Server. You can configure settings such as power saver mode, alerts, 
and print job policies. 
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Viewing Printer Information 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
The Embedded Web Server Home page appears. 

2. In the printer status area, click Details. 
The Device Details page opens, showing printer information, network connectivity details, and 
system administrator information. 

 

Configuring the Login Method From the Embedded Web Server 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions > Login/Logout Settings. 
4. Select a login method: 

− Simple: Passwords are not required. 
− Local: Passwords are required. 
− Network: A remote server handles login authentication. Device User Accounts are used only for 

personalization and permissions. 
− Convenience: Log in with a magnetic-strip card. Device User Accounts are used only for 

personalization and permissions. 
5. To select the Simple or Local authentication, for either option, click Select, select how users identify 

themselves, then click OK. 
6. To select network authentication, for Network, click Select. Choose an authentication protocol, click 

Next, then configure the authentication settings. For assistance, contact your system administrator. 
7. To select Convenience authentication, for Convenience, click Select, enter a server IP address, then 

click Next. 
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Configuring Power Saver Using the Embedded Web Server 

You can set the time that the printer spends idle in ready mode before it automatically transitions to a 
lower power level. 

To configure Power Saver Timeouts: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click System > Power Saver. 

Note: If this feature does not appear, log in as a system administrator. For details, refer to Logging 
In as the Administrator on page 265. 

3. To set the time delay before the printer enters Low-Power mode, for Low Power Timeout, click 
current value, then type the desired timeout in minutes. 

4. To set the time delay before the printer enters Sleep mode, for Sleep Timeout, click current value, 
then type the desired timeout in minutes. 

Note: The sum of the two timeouts is within 60 minutes. 

5. To set Auto Power Off, click Auto Power Off: 
− To power off the device after all timeouts complete, select On, click current value, then type the 

desired timeout in hours. 
− To power off the device only if specific conditions are met: 

• Select Only When Conditions Are Met. 
• Click current value, then type the desired timeout in hours. 
Specific conditions are when Fax, USB Drive, Wired and Non-Wired Network features have not 
been activated. 

6. To finalize your selections, click OK. 
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Setting the Date and Time Using the Embedded Web Server 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click System > Date & Time. 

Note: If this feature does not appear, log in as a system administrator. For details, refer to Logging 
In as the Administrator on page 265. 

3. In the Date area, for Date Format, select an option. 
4. For Date, click the date field, then select the current date from the calender. 
5. In the Time area, select the desired clock options, then enter the current time. 
6. To set the time zone, click Time Zone, select your time zone from the list, then click OK. 
7. To enable or disable Daylight Savings Time, click the toggle button. 

Note: A check mark on the toggle button indicates the setting is enabled. 

8. To enable or configure Time Server Synchronization, for SNTP, click Edit. 
− To enable or disable Time Server Synchronization, click the toggle button. 

Note: The check mark on the toggle button indicates the setting is enabled. 

− Type the Time Server Address. 
− To set the amount of time between time synchronizations, for Time Synchronization Interval, 

click the current value, then type a value in hours. 
− To save SNTP settings, click OK. 

9. To save Date & Time settings, click OK. 
 

Configuring the Device Control Panel Timeout 

You can set the timeout period for the device control panel timeout. The timer begins when user input 
stops. At the end of the specified timeout period, the logged in user is logged out automatically. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Timeouts. 
4. For System Timeout, type a number in seconds. 
5. Click OK. 
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Configuring the Device Website Timeout 

You can set the timeout period for the Embedded Web Server. The timer begins when user input stops. 
At the end of the specified timeout period, the logged in user is logged out automatically. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Timeouts. 
4. For Device Website Timeout, type a number in minutes. 
5. Click OK. 
 

Setting the Default Device Control Panel Screen 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Apps. 
4. Click Preferences. 
5. For Walkup Screen, select an option. 
6. Click OK. 
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Configuring Tray Settings Using the Embedded Web Server 

When the bypass tray is set to Fully Adjustable mode, you can change paper settings each time you load 
the tray. When paper is loaded into the bypass tray, the control panel prompts you to set the paper size, 
type, and color. 

When other trays are set to Fully Adjustable mode, open the selected tray and load the desired paper. 
When you close the tray, the control panel prompts you to set the paper size, type, and color. 

When any paper tray is set to Dedicated mode, only load the size, type, and color of paper specified for 
the tray. If you move the guides, or load a different paper, change the size, type, and color of paper 
settings at the control panel. 

The Tray Priority feature determines the order in which the printer selects the tray for a print job when 
you have not specified one. Tray Priority also determines how the printer selects another tray when a 
paper tray runs out in the middle of a job. Priority 1 indicates that the tray is set to the highest priority. 

To configure the tray settings: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, click Home. 
3. In the Trays area, click the desired tray. 
4. To configure the tray mode, click Tray Mode. 

− To configure the printer control panel to prompt you for the paper settings each time the paper 
tray is loaded, click Fully Adjustable. 

− To configure the tray to use a specific paper, click Dedicated, then specify the paper size, type, 
and color. 

5. To configure the printer to select the appropriate paper tray for the print job, click the toggle button 
for Auto Select. If the required paper size is not available, the printer prompts you to load the 
correct paper size and type for the job. 

Note: A check mark on the toggle button indicates that the setting is enabled. 

6. To determine the order in which the printer selects the tray for a print job, click Priority, then select 
the tray priority. 

7. To save the tray settings, click OK. 
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Cloning Printer Settings 

You can use cloning to copy configuration settings from one printer to another printer on the same 
network. 

Notes: 

• Before using the clone feature, ensure that the source printer clone file is compatible with the 
destination printer. 

• Before you copy the address book, verify that the address book of the target printer is empty. 

To clone the printer settings: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. At the bottom of the Home page, click Cloning. 
4. To install a clone file: 

a. For Install Clone File, click Select. 
b. Locate, then select a clone file from the source printer, then click Open. 

• To select a different clone file, click the change file icon. 
• To remove the selected clone file, click the Trash icon. 

Note: Removing the clone file does not delete it from the computer. 

c. To install the selected clone file, click Install. 
5. To create a clone file: 

a. Select the parameters to clone from this printer. 
• To select individual parameters to clone from this printer, select the desired parameter. 
• To choose all settings, select Select/Clear All. 
• To clear all settings, clear Select/Clear All. 

b. Click Create. 
c. If prompted, save the clone file to a location that you can remember easily when you need the 

file for installation. 

Note: If you are not prompted to save the file, look for it in the Downloads folder on your computer. 

6. When you are finished creating or installing a clone file, click Close. 
 

Resetting the Printer 

Using Software Resets to restart the printer is faster and wastes fewer consumables than powering the 
printer on and off. Restarting the printer can take several minutes, during which time the Embedded 
Web Server is not available. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Home > Support > Restart Device. 
3. At the prompt, click Restart. 
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Setting Up a Proxy Server 

This feature allows you to set up and enable proxy services on the printer. You can enter your 
authentication login at the printer control panel, and access a set of features and options designed 
specifically for your business needs. You can scan and capture paper documents, preview thumbnails, 
and add them to frequently used document storage locations. 

To set up a proxy server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Connectivity. 
4. Click HTTP. 
5. To enable a proxy server, click the Proxy Server toggle button. 
6. To select if your system uses common or different proxy servers, click Proxy Setup. 

− If your setup uses a common proxy server, select Common Proxy. 
− If your setup uses different proxy servers, select Different Proxies. As needed, click the Enable 

Proxy Server toggle buttons. 
7. To set up a proxy server, click Setup. 

− If your proxy server uses automatic configuration, select Automatic. 
− If your proxy server uses a configuration script, select Configuration Script. Type the URL to 

locate the configuration script. 
− If your proxy server uses manual configuration, select Manual, then configure the settings. 

For assistance, contact your system administrator. 
8. Click OK. 
 

Setting Up the Network Address Book 

Before you can use the Network Address Book, configure the printer to communicate with the LDAP 
server. For details, refer to LDAP Server on page 268. 
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Adding or Editing Contacts in the Address Book in the Embedded Web Server 

To add contacts: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. Click Add Contact. 
4. To enter a name, click the First Name, Last Name, or Company field. 
5. To add an email address, in the Email field, enter an email address. 
6. To add a fax number, for Fax, click +, then enter a number. 
7. To add a network folder, for Network (SMB) or FTP, click the plus icon (+), then enter the following 

information. 
• Nickname: Enter the name that you want to appear in the Address Book. 
• Type: Select the network connection type. 
• IP Address: Port: Enter the IP address of your computer, and enter the default port 

number for SMB, 139, or select a number from the range provided. 
• Share: Enter a name for the directory or folder. For example, if you want the scanned files 

saved to a folder named scans, type scans. 
Note: FTP networks do not require a name for shared directories. 

• Document Path: Enter the path of the folder on the SMB server. For example, if you want 
the scanned files saved to a folder named colorscans inside the scans folder, type 
colorscans. 

• Login Name: Enter your computer user name. 
• Password: Enter your computer login password. 
• Retype Password: Enter your login password again. 

8. To save the contact, click OK. 

To edit contacts: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. From the Address Book, select a contact. 
4. To edit contact information, perform the following steps. 

a. Click the contact name or contact information, then edit as needed. 
b. To clear contact information, for the specific contact information, click the Trash icon. 
c. To save the changes, click OK. 

5. To remove the selected contact from the Address Book, click Delete. At the prompt, click Delete. 
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Adding or Editing Contacts in the Address Book at the Control Panel 

To add contacts: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. Touch the plus icon (+), then select Add Contact. 
4. To enter a name, touch the Enter First Name, Enter Last Name, or Enter Company field, then to 

move to the next field, touch Next. When finished, touch Enter. 
5. To add a fax number, touch Add Fax, enter a fax number, then touch OK. 
6. To add an email address, touch Add Email, enter an email address, then touch OK. 
7. To add a network folder, touch Add SMB. Navigate the network directory to the desired destination, 

then touch OK. 

Note: Login credentials are required for computers on secured networks. 

8. To add an FTP location, touch Add FTP, enter an FTP address, then touch OK. 
9. To save the contact, touch OK. 
10. To return to the Home screen, press the Home button. 

To edit contacts: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. From the Address Book, touch a contact name, then touch Edit. 
4. To change contact information, touch the information that you want to update, edit as needed, 

then touch OK. 
5. To save your contact changes, touch OK. 
6. To return to the Home screen, press the Home button. 
 

Configuring Alerts 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. On the Home page, for Supplies, click Details. 
4. For Options, click Alerts Setup. 
5. To enable alerts, for Enable Alerts, click the toggle button. 

Note: A check mark on the toggle button indicates the setting is enabled. 

6. To enable or disable an alert, for the alert type, select the appropriate option: 
− Click the toggle button. 
− Click the alert type and select an option from the list. 

7. Click OK. 
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Configuring Email Alerts 
Note: Before configuring email alerts, configure the printer to communicate with your SMTP email 
server. For details, refer to Configuring the SMTP Server Settings. 

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 
press Enter or Return. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. On the Home page, for Supplies, click Details. 
4. For Options, click Email Alerts. 
5. For Email Alerts, type the email address for the recipient. 

Note: A check mark on the toggle button indicates that the setting is enabled. 

6. To enable or disable an email alert, for the alert type, click the toggle button. 
7. Click OK. 
 

Configuring PDL Settings from the Embedded Web Server 

You can configure settings for the following PDL protocols: 
• PCL® 6/5e 
• PostScript® 
• PDF 
• TIFF/JPEG 

Note: PCL® 6/5e is the default PDL protocol. 
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Configure Settings for PCL 6/5e 
Note: Default PCL® settings are used when a print driver is not selected. Print driver settings override 
default PCL® settings configured from the Embedded Web Server. 

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 
press Enter or Return. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > PDL Settings. 
4. Click PCL 6/5e. 
5. Configure the following settings as needed: 

− To set the priority mode for print quantity, click Print Quantity Priority, then select an option. 
− To set the limit for number of sheets to print, for Print Quantity, type a number. 
− To specify the default paper tray, click Paper Tray, then select a paper tray. To allow automatic 

tray selection, select Auto. 
− To specify the default paper size for the default paper tray, click Paper Size, then select a paper 

size. 
− To specify the paper size for the Bypass Tray, click Paper Size (Bypass Tray), then select a 

paper size. 
− To select the maximum custom paper size width, for Custom Paper Size Width, type a number. 
− To select the maximum custom paper size length, for Custom Paper Size Length, type a 

number. 
− To set the default output color, click Output Color, then select an option. To allow automatic 

color output based on the original document, select Auto Detect. 
− To set the default printing option for 2-sided printing, click 2-Sided, then select an option. 
− To configure the printer not to print blank pages, for Remove Blank Pages, click the toggle 

button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

− To set the default page orientation for the original document, click Original Orientation, then 
select an option. 

− To enable Wide A4 printing, for Wide A4, click the toggle button. 
− To set the default pitch size, for Pitch Size, enter a number. 
− To set the default output font point size, for Point Size, type a number. 
− To set the default output font, click Font Name, then select a font. 
− To specify the default symbol set for the selected font, click Symbol Set, then select an option. 
− To set the maximum limit of lines allowed on the page output, for Lines per Page, type a 

number. 
− To enable Hex Dump, for Hex Dump, click the toggle button. 
− To allow the printer to enhance the image automatically, for Image Enhancement, click the 

toggle button. 
6. To save your settings, click OK. 
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Configure Settings for PostScript 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > PDL Settings. 
4. Click PostScript. 
5. Configure the following settings as needed: 

− To allow a report to print when an error occurs, for Print Error Sheet, click the toggle button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

− To specify the default paper tray, click Paper Supply, then select an option. 
6. Click OK. 
 

Configure Settings for PDF 
Note: Default PDF settings are used when a print driver is not selected. Print driver settings override 
default PDF settings configured from the Embedded Web Server. 

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 
press Enter or Return. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > PDL Settings. 
4. Click PDF. 
5. Configure the following settings as needed: 

− To specify the protocol used to construct the PDF output, click Decomposer, then select an 
option. 

− To set the limit for number of printed pages, for Print Quantity, type a number. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

− To specify the default paper size for the output, click Paper Size, then select a paper size. 
− To set the default output color, click Output Color, then select an option. To allow automatic 

color output based on the original document, select Auto Detect. 
− To set the default option for 2-sided printing, click 2-Sided, then select an option. 
− To allow output page collation, click Collated, then select On. 
− To specify output quality, click Print Mode, then select an option. 
− To select a layout mode for the output, click Layout, then select an option. 
− To require a password to open the PDF output, for Password, type a password. 

Note: To remove the dots in the Password field, double-click the field. 

6. Click OK. 
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Configure Settings for TIFF and JPEG 
Note: Default TIFF and JPEG settings are used when a print driver is not selected. Print driver 
settings override default TIFF and JPEG settings configured from the Embedded Web Server. 

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 
press Enter or Return. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > PDL Settings. 
4. Click TIFF/JPEG. 
5. To specify the default paper size for the output, click Paper Size, then select a paper size. 
6. Click OK. 
 

Viewing Version Information for a PDL Protocol 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > PDL Settings. 
4. To view version information for a PDL protocol, click the protocol name. 

Version information displays at the top of the settings page. 
5. To return to the PDL Settings page, click OK or Cancel. 

Note: Version information is available for PostScript®, TIFF, and XPS. 
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Configuring General Settings Using the 
Control Panel 

This section includes: 
• Configuring the Power Saver Modes .......................................................................................................................... 247 
• Setting the Date and Time ............................................................................................................................................. 248 
• Setting the Measurement Units ................................................................................................................................... 248 
• Setting the Display Brightness ...................................................................................................................................... 248 
• Configuring Audio Tones ................................................................................................................................................. 249 
• Configuring Low Supplies Alert Messages ................................................................................................................ 249 
• Setting the Control Panel Timeout using the Control Panel ............................................................................ 250 
• Configuring Tray Settings................................................................................................................................................ 250 
• Reset 802.1X and IPsec .................................................................................................................................................... 251 
• Reset to Factory Defaults ................................................................................................................................................ 251 
• Reset Fonts, Forms, and Macros ................................................................................................................................... 251 

Use these topics to configure general settings for the printer using the control panel. You can configure 
many printer settings from the control panel, including settings for power saver mode, alerts, touch 
screen, security, and printing defaults. 
 
 

Configuring the Power Saver Modes 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower 
power level. 

To configure power saver settings: 
1. At the printer control panel, press the Home button. 
2. Touch Device > General > Power Saver. 
3. Touch the Timer that you want to change. 

− Low Power Timeout: Use this option to set the time when the printer shifts from Ready mode 
to Low-Power mode. 

− Sleep Timeout: Use this option to set the time when the printer shifts from Low-Power mode to 
Sleep mode. 

− Auto Power Off: Use this option to set the time, in hours, for the printer to power off. 
4. To save the settings, touch OK. 
5. To return to the Home screen, press the Home button. 
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Setting the Date and Time 
1. At the printer control panel, press the Home button. 
2. Touch Device > General. 
3. Touch Date & Time. 
4. To allow an NTP service to set the time automatically, touch the Set Automatically toggle button. 

If an NTP server is detected, the Time Zone, Date & Time, and Daylight Savings Time values are set 
automatically. If no NTP server is detected, the Time Server menu opens, allowing you to enter the 
IP address for the server. 

5. To set the date and time manually: 
a. Touch Time Zone, then select your geographic region and time zone. 
b. Touch Date & Time. Select the date and time, then touch OK. 
c. To enable daylight savings, touch the Daylight Savings Time toggle button. 

6. To set the date format, touch Date Format, then touch the date format that you want to use. 
7. To show time in 24-hour format, touch the Use 24 Hour Clock toggle button. 
8. To save the settings, touch OK. 
9. To return to the Home screen, press the Home button. 
 

Setting the Measurement Units 
1. At the printer control panel, press the Home button. 
2. Touch Device > General > Measurements. 
3. To select an option for units, touch Units, then touch Millimeters or Inches. 
4. To set the units for the custom paper size, touch Paper Size Preference, then touch Inch or Metric. 
5. Touch OK. 
6. To return to the Home screen, press the Home button. 
 

Setting the Display Brightness 
1. At the printer control panel, press the Home button. 
2. Touch Device > General > Display Brightness. 
3. To adjust the brightness, move the slider to the right to increase the brightness or to the left to 

reduce the brightness. 
4. To return to the Home screen, press the Home button. 
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Configuring Audio Tones 
1. At the printer control panel, press the Home button. 
2. Touch Device > General > Sounds. 
3. Touch Enable Sounds. 
4. Touch a desired event. To lower the volume, move the slider left, or to increase the volume, move it 

to the right. 
5. Repeat for each tone that you want to set. 
6. To save the setting, touch OK. 
7. To return to the Home screen, press the Home button. 
 

Configuring Low Supplies Alert Messages 
1. At the printer control panel, press the Home button. 
2. Touch Device > Supplies > Alerts Setup. 
3. Touch Alerts Setup. 
4. To specify the level of toner remaining that triggers a toner low alert, touch Toner Level, then select 

a percentage. 
5. To set toner low alerts, select an option. 

− To display an alert message when the toner is low, touch the Toner Low toggle button. 
− To display an alert message when the toner is empty, touch the Toner Empty toggle button. 

6. To specify the percentage of life remaining that triggers a Drum Cartridge alert, touch Drum 
Cartridge Level, then select a percentage. 

7. To set Drum Cartridge alerts, select an option. 
− To display an alert message when the Drum Cartridge life is getting low, touch the Drum 

Cartridge Reorder toggle button. 
− To display an alert message when the Drum Cartridge life is low, touch the Drum Cartridge 

Near End of Life toggle button. 
− To display an alert message when the Drum Cartridge is empty, touch the Drum Cartridge End 

of Life toggle button. 
8. To set Waste Cartridge alerts, select an option. 

− To display an alert message when it would be advisable to order a replacement Waste 
Cartridge, touch the Waste Cartridge R5 Reorder toggle button. 

− To display an alert message when the Waste Cartridge is almost full, touch the Waste 
Cartridge R5 Almost Full toggle button. 

− To display an alert message when the Waste Cartridge is full, touch the Waste Cartridge R5 
Full toggle button. 

9. To save the settings, touch OK. 
10. To return to the Home screen, press the Home button. 
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Setting the Control Panel Timeout using the Control Panel 

You can set the timeout period for the device control panel timeout. The timer begins when user input 
stops. At the end of the specified timeout period, the logged-in user is logged out automatically. 
1. At the printer control panel, press the Home button. 
2. Touch Device > General > System Timeout. 
3. Select the time in minutes and seconds, then touch OK. 
4. To return to the Home screen, press the Home button. 
 

Configuring Tray Settings 

When the bypass tray is set to Fully Adjustable mode, you can change paper settings each time you load 
the tray. When paper is loaded into the bypass tray, the control panel prompts you to set the paper size, 
type, and color. 

When other trays are set to Fully Adjustable mode, open the selected tray and load the desired paper. 
When you close the tray, the control panel prompts you to set the paper size, type, and color. 

When any paper tray is set to Dedicated mode, only load the size, type, and color of paper specified for 
the tray. If you move the guides, or load a different paper, change the size, type, and color of paper 
settings at the control panel. 

The Tray Priority feature determines the order in which the printer selects the tray for a print job when 
you have not specified one. Tray Priority also determines how the printer selects another tray when a 
paper tray runs out in the middle of a job. Priority 1 indicates that the tray is set to the highest priority. 

To configure the paper tray settings: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Paper Trays. 
3. In the Paper Trays menu, touch the desired tray. 
4. To configure the printer to prompt you to set the paper type and size when paper is loaded, touch 

Tray Mode, then touch Fully Adjustable. 
5. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated. 

− To select a paper or envelope size, touch the current size setting, then from the list, select the 
size. 

− To select a paper type, touch the current paper type, then from the list, select the paper type. 
− To select a paper color, touch the current paper color, then from the list, select the paper color. 

6. To save the setting, touch OK. 
7. To return to the Home screen, press the Home button. 

Note: You can be required to enter a passcode to access specific control panel menus. For 
assistance, contact your system administrator. 
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Reset 802.1X and IPsec 

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. The Reset 
802.1X and IPsec feature resets specific settings stored in the printer for Ethernet connectivity settings. 
After executing this function and restarting the printer, Ethernet 802.1X and IPsec settings are reset to 
their default values. 

To reset the non-volatile memory 802.1X and IPsec settings: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Resets > Reset 802.1X and IPsec. 
3. At the prompt, touch Reset. 
4. When the process is complete, the printer restarts automatically. 
 

Reset to Factory Defaults 

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. The Reset 
to Factory Defaults feature erases all settings and returns the printer to original factory state. All jobs, 
presets, Apps, and device settings are reset. When complete, the printer restarts, then displays the Install 
Wizard. 

To reset the printer to factory defaults: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Resets > Reset to Factory Defaults. 
3. At the prompt, touch Reset. 
4. When the process is complete, the printer restarts automatically. 
 

Reset Fonts, Forms, and Macros 

This feature deletes the fonts, forms, and macros downloaded into the non-volatile memory of the 
printer. 

To reset downloaded fonts, forms and macros: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Resets > Reset Fonts, Forms, and Macros. 
3. At the prompt, touch Clear. 
4. When the process completes, the printer restarts automatically. 
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Configuring Default Settings and Printing 
Policies from the Embedded Web Server 

This section includes: 
• Configuring Common Settings ...................................................................................................................................... 252 
• Configuring Paper Supply Settings .............................................................................................................................. 253 
• Setting Printer Policies ...................................................................................................................................................... 253 
• Configuring Report Settings ........................................................................................................................................... 258 

This section provides information to help you configure default settings and printing policies for the 
printer. You can configure these settings from your Web browser using the Embedded Web Server. You 
can configure settings for paper supply, printer defaults, and reports. 
 
 

Configuring Common Settings 

Configuring Size Detection for Legal-Size Original Documents 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Common, click Legal Original Size Auto Detection. 
5. To enable automatic size detection for legal-size original documents, for Enable, click the toggle 

button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

6. For Legal Original Size Option, select an option. 
7. Click OK. 
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Configuring Paper Supply Settings 

Adjusting the Paper Type 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Paper Supply, click Adjust Paper Type. 
5. To adjust a paper type, click the paper type name, then select an option. 
6. After you have completed all paper type adjustments, click OK. 
 

Configuring Custom Paper Paper Names 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Paper Supply, click Custom Paper Names. 
5. To give a custom name to a paper type, for the Custom Paper Type, type a name. 
6. After you have completed the paper name adjustments, click OK. 
 

Setting Printer Policies 

Configuring Jobs Policies 

You can set policies for your print jobs. You can configure settings for Print Around, job name 
concealment, and stored print jobs. 

When a print job is paused or in an error state, The Print Around feature allows the subsequent jobs in 
the queue to print. For example, a print job can be paused because it requires paper that is not loaded in 
a tray. When Print Around is enabled, any subsequent job that requires another paper type prints 
immediately, even though a preceding job is held. 
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Enabling Print Around 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Jobs > Policies. 
4. To enable Print Around, click the Enable toggle button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

5. To allow held jobs to be deleted after a specified time: 
− For Delete Held Jobs After, select On. 
− Type the amount of time in days, hours, and minutes until the job is deleted. 

6. Click OK. 
7. Click Restart Now. 
 

Concealing or Showing Job Names 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Jobs. 
4. Click Policies. 
5. For Conceal Job Names, select an option. 
6. Click OK. 
7. Click Restart Now. 
 

Configuring Stored Print Job Settings 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Jobs. 
4. Click Policies. 
5. In the Stored Print Job Settings area, for Minimum Number of Passcode Digits, type a number. 
6. For Delete Stored Print Jobs After, select an option: 

− To save stored print jobs, select Off. 
− To delete print jobs after the specified number of days at the specified time, select Days. 

Type the number of days, select AM or PM, then type the time in hours and minutes. 
− To delete print jobs after the specified length of time, select Length of Time. Type the number 

of Hours and Minutes.  
7. Click OK. 
8. Click Restart Now. 
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Configuring PostScript® Memory 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Printer Settings, click Memory Settings. 
5. To specify the amount of memory allowed for PostScript® data, for PostScript Memory, type a 

number, in kilobytes. 

Note: The system requires that the number is a multiple of 256. 

6. Click OK. 
7. Click Restart Now. 
 

Setting Policies for Allowed Print Job Types 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Printer Settings, click Allowed Print Job Types. 
5. Select an option: 

− Personal, Secure, and Saved Only: This option limits the job types allowed. 
− All Jobs: This option allows any job type. 

6. Click OK. 
7. Click Restart Now. 
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Setting Policies for When a Paper Type is Unavailable 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Printer Settings, click Specified Paper is Unavailable. 
5. Select an option: 

− Prompt to Load Paper: This option requires a user to load the specified paper type before the 
job can proceed. 

− Letter/A4 Substitution: This option allows the printer to substitute a loaded media that is of 
similar size. 

6. Click OK. 
7. Click Restart Now. 
 

To Enable a Paper Type and Size Confirmation Prompt for the Bypass Tray 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Printer Settings, click Bypass Tray Paper Type and Size Confirmation. 
5. To enable a paper type and size confirmation prompt for the bypass tray, select On. 
6. Click OK. 
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Setting Print Job Policies for When an Error Occurs 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Printer Settings, click Resume Print After Error. 
5. To resume print jobs after the error is cleared, select an option: 

− To allow the print job to continue automatically, select Auto Resume. 
− To require user input before the job can continue, select Manual Resume. 

6. Click OK. 
7. Click Restart Now. 
 

Setting Print Job Policies for When a Paper Jam Occurs 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Printer Settings, click When Paper Jam Occurs. 
5. Select an option for resuming print jobs after the paper jam is cleared: 

− To allow the print job to continue automatically, select Resume Print After Jam Clearance. 
− To delete the job in memory, select Cancel Print. 

Note: To print a job that was canceled after jam clearance, resubmit the job. 

6. Click OK. 
7. Click Restart Now. 
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Setting Printing Policies for Banner Pages 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Printer Settings, click Print Banner Pages. 
5. Configure options as desired: 

− To configure banner page print settings, click Print Banner Pages, then select an option. 
− To disable banner page printing, click Print Banner Pages, then select Off. 
− To select a paper source for banner pages, touch Paper Tray, then select the desired tray. 
− To allow users to choose to print a banner page from a print driver, for Allow Print Driver to 

Override, click the toggle button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

− To allow the printer to print a banner page sent by the client, for Detect Client Banner Pages, 
click the toggle button. 

6. Click OK. 
7. Click Restart Now. 
 

Configuring Report Settings 

Setting the Output Tray for Reports 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Report Settings, click Report Output Tray. 
5. Select the output paper tray where you want the reports to print. For automatic tray selection, 

select Auto. 
6. Click OK. 
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Enabling the Job Deletion Report 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Defaults and Policies. 
4. For Report Settings, click Job Deletion Report. 
5. To allow the job deletion report to print, select On. 
6. Click OK. 
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Setting Up Scanning 

This section includes: 
• Scanning Setup Overview ................................................................................................................................................ 260 
• Setting Up Scanning to a Shared Folder on Your Computer ........................................................................... 260 
• Setting Up Scanning to an FTP Server ....................................................................................................................... 261 
• Setting Up Scanning to an Email Address ................................................................................................................ 262 
• Enabling WSD Scan Services .......................................................................................................................................... 263 
 

For reference:  
Scanning on page 129 
 

 
 

Scanning Setup Overview 

If the printer is connected to a network, it is enabled for scanning. Before you can scan, do the following: 
• If you are scanning to a shared folder on your computer, share the folder, then set the correct 

permissions. In the Embedded Web Server, add the folder as an Address Book entry. 
• If you are scanning to an FTP server, in the Embedded Web Server, add the FTP server as an Address 

Book entry. For the Address Book entry, assign the required folder permissions. 
• If you are scanning to an email address, in the Embedded Web Server, configure the email server. 

If the printer is connected using a USB cable, you cannot scan to an email address, a network location, or 
to a folder on your computer. 
 

Setting Up Scanning to a Shared Folder on Your Computer 

Before you can scan to a shared folder, share the folder, then add the folder as an Address Book entry in 
the Embedded Web Server. 

For details on sharing a folder, and adding an SMB entry, refer to Scanning to a Shared Folder on a 
Network Computer on page 136. 
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Setting Up Scanning to an FTP Server 

Before you set up scanning to an FTP Server, the server must have the proper software installed and be 
configured with shared folders for each user. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Address Book. 
4. To associate the FTP server with a contact, click a contact name. For details, refer to Adding or 

Editing Contacts in the Address Book in the Embedded Web Server on page 241. 
5. For FTP, click the plus icon (+), then enter the following information: 

− Nickname: Enter the name that you want to appear in the Address Book. 
− Type: Select the network connection type. 
− IP Address/Host Name: Port: Enter the IP address or host name of your FTP server, then enter 

the default port number. In the next field, enter the default port number for FTP, 21, or select a 
number from the range provided. 

− Document Path: Enter the path of the folder on the SMB server. For example, to save the 
scanned files to a folder named colorscans inside the scans folder, type colorscans. 

− Login Name: Enter your computer user name. 
− Password: Enter your computer login password. 
− Retype Password: Enter your login password again. 

6. To save your network information, click OK. 
7. To save your contact, click OK. 
8. Now you can scan to the FTP server. 
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Setting Up Scanning to an Email Address 

Before you can scan to an email address, configure the printer to communicate with your SMTP email 
server. 

To configure the SMTP server settings: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Apps > Email. 
4. For SMTP, click Setup. 
5. To enable Email Submission, click the Email Submission toggle button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

6. Type the following information: 
− For Device Email, type an appropriately formatted email address to appear in the From field of 

emails from the printer. 
− For SMTP Server, click Server Address. Type the IP address or DNS name of the SMTP server. 

If you do not know the IP Address or DNS Name of the SMTP server, click Select Server from 
List. 

Note: This feature requires that specific configurations be made to your network. For details, 
contact your network administrator. 

− For Outgoing SMTP Port Number, type the default port number required for the SMTP server, or 
select a number from the range provided. 

Note: Common default port numbers for SMTP include 25, 465, and 587. 

7. As needed for your environment, select a Connection Security protocol. 
8. As needed for your environment, select an Outgoing SMTP Authentication type. 

Note: Ensure that the authentication type is compatible with your SMTP server. 

a. If authentication is required, click SMTP Authentication, then select SMTP AUTH. If 
authentication is not required, select Off. 

b. If authentication is required, for SMTP AUTH User Name, enter a valid SMTP Login Name for 
the SMTP Server. 

c. If authentication is required, for SMTP AUTH Password, enter a valid password for the SMTP 
server. 

9. For Retype Password, reenter the password. 
10. To save changes, click OK. 

Note: Contact your Internet service provider or system administrator to obtain your SMTP server 
name or IP address. Some Internet service providers require authentication. Ensure that you confirm 
the authentication type, login, and password. 

When this process completes, you can scan to an email address. For details, refer to Scanning to an Email 
Address on page 134. 
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Enabling WSD Scan Services 

Web Services for Devices (WSD) is technology from Microsoft that provides a standard method for 
discovering and using network connected devices. It is supported in Windows Vista, Windows Server 
2008, and newer operating systems. WSD is one of several supported communication protocols. 

To enable WSD scan services: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, click Connectivity. 

Note: If this feature does not appear, log in as a system administrator. For details, refer to Logging 
In as the Administrator on page 265. 

3. For Protocols, click WSD (Web Services on Devices). 
4. To enable WSD scan services, click the WSD Scan toggle button. 
5. Click OK. 
6. At the prompt, click Restart Now. 
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Configuring Security Settings Using the 
Embedded Web Server 

This section includes: 
• Logging In as the Administrator................................................................................................................................... 265 
• Opening the Security Menu ............................................................................................................................................ 265 
• Accessing the Advanced Security Settings............................................................................................................... 265 
• Configuring the Advanced Security Settings .......................................................................................................... 266 
• Configuring Secure Settings ........................................................................................................................................... 267 
• LDAP Server ............................................................................................................................................................................ 268 
• LDAP User Mapping ........................................................................................................................................................... 269 
• Configuring LDAP Authentication ............................................................................................................................... 269 
• Configuring the Network Authentication ................................................................................................................. 270 
• Configuring an LDAP Authentication System ........................................................................................................ 271 
• Configuring an SMB Authentication System .......................................................................................................... 271 
• Configuring a Kerberos Authentication System .................................................................................................... 272 
• Configuring IP Address Filtering ................................................................................................................................... 272 
• Configuring SSL Settings in the Embedded Web Server .................................................................................... 273 
• Enabling HTTPS Communication ................................................................................................................................. 274 
• Configuring SMTP Domain Filtering ........................................................................................................................... 274 
• USB Port Security................................................................................................................................................................. 274 

Use security settings to configure administrative settings, authentication, user access and privileges, and 
service access. 
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Logging In as the Administrator 

Depending on the Permissions settings, some services and settings are locked or hidden until you enter 
the administrator user name and password. 

To access the control panel as the administrator: 
1. At the printer control panel, press the Home button. 
2. To log in as system administrator, touch Log In. 
3. If present, touch admin, otherwise, use the keypad to type admin, then touch Next. 
4. Type the administrator password, then touch OK. The default password is 1111. 

To log in to the Embedded Web Server as the administrator: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. At the top of the page, click Log In. 
3. Click admin. 
4. Type the administrator password, then click Log In. The default password is 1111. 
 

Opening the Security Menu 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security. 
 

Accessing the Advanced Security Settings 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions, then click Login/Logout Settings. 
4. For Advanced Settings, click Edit. 
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Configuring the Advanced Security Settings 

To configure the log in security settings: 
1. In the Embedded Web Server, access the Advanced Security Menu. For details, refer to Accessing 

the Advanced Security Settings on page 265. 
2. To set the case sensitivity for the user name input, click Case Sensitive User Name, click either Case 

Sensitive or Not Case Sensitive, then click OK. 
3. To configure logging of failed login attempts, click Log Failed Login Attempts. 

a. To enable logging for failed login attempts, click the Log Failed Login Attempts toggle button. 
b. To set the maximum number of failed login attempts allowed within a specific time period, in 

the Failed Login Attempt Limit field, type a number. 
c. Click OK. 

4. To configure limits for administrator login attempts, click Limit Login Attempts of System 
Administrator. 

Note: This setting is available only if more than one user is a member of the System Administrator 
device role. 

a. To limit the administrator login attempts, click the Limit Login Attempts of System 
Administrator toggle button. 

b. To set the maximum number of failed login attempts allowed before the administrator login is 
disabled, in the Failed Login Attempt Limit field, type a number. 

5. Click OK. 

To configure more advanced security settings: 
1. In the Embedded Web Server, access the Advanced Security Menu. For details, refer to Accessing 

the Advanced Security Settings on page 265. 
2. To set the timeout for the server authentication, in the Server Authentication Response Timeout 

field, type a number. 
3. To set the timeout for the search function, in the Search Timeout field, type a number. 
4. To configure the options for displaying the user name during login, click Display User Name. 

a. To hide the user name during login, click Hide. 
b. To hide the user name when using a smart card, click Hide Smart Card ID. 
c. To show the user name during login, click Show. 

5. To obtain the user information during login, click Obtain User Information at Login, click On, then 
click OK. 

6. To store the login information on the device, click Store Login Information on Device, then click 
On. 

7. To save your settings, click OK. 
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Configuring Secure Settings 

To allow users to edit the From field in emails sent from the printer: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. In the Embedded Web Server, click Apps > Email. 
4. For Scan To Apps General Settings, click "From" Field. 
5. Select an option: 

− To allow all users to edit the From field in emails sent from the printer, select Yes. 
− To allow only logged in users to edit the From field in emails sent from the printer, select 

Logged-In Users Only. 
− To prevent users from changing the default device email address in the From field, select No. 

6. Click OK. 

To limit users to selecting recipients from the address book only: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions. 
4. For Guest Accounts, click Edit, then select Device User Role. 
5. For Control Panel Permissions, select Custom Permissions, then click Setup. 
6. Click Email. 
7. To prevent users from editing the To field in emails sent from the printer, for Manually Enter 

Recipients, click Hide. 
8. To save your selections, click OK, then click Close. 
9. Click OK. 

To allow download of firmware updates: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Software Update. 
4. To allow download of firmware updates, click Enable. 
5. At the prompt, click Restart Now. 
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LDAP Server 

Lightweight Directory Access Protocol (LDAP) is a protocol used to process queries and updates to an 
LDAP information directory, on an external server. LDAP can also be used for network authentication and 
authorization. LDAP directories are heavily optimized for read performance. Use this page to define how 
the printer retrieves user information from an LDAP directory. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Connectivity > LDAP > LDAP Servers/Directory Services. 
4. For IP Address/Host Name: Port, enter the IP address or DNS name for the LDAP server, then enter 

the port number for LDAP. 
5. Configure the optional LDAP server information as needed. 

a. In the Search Directory Root field using Base DN format, type the root path of the search 
directory. For example, DC=xerox, DC=net. 

b. Select the type of LDAP Server. 
c. Type the Login Name and Password used to access the server. 
d. For Search Timeout, specify the type of timeout to use for the server. You can set the LDAP 

server to limit the time or you can set the time limit manually in the seconds field. 
6. Click OK. 
7. To enable LDAP-SSL/TLS: 

a. Click System > Security. 
b. For Network Security, click SSL/TLS Settings. 
c. To enable LDAP-SSL/TLS, click the LDAP - SSL/TLS Communication toggle button. 

8. Click OK. 
9. At the prompt, click Restart Now. 
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LDAP User Mapping 

LDAP servers display different results depending on how they implement mappings. Use this page to 
map LDAP fields to fields on your printer. Editing current map settings allows you to fine-tune server 
search results. 

Before you begin: 
• Ensure that you have configured the LDAP server settings. For details, refer to LDAP. 
• Ensure that you have set LDAP for authentication. For details, refer to Configuring LDAP 

Authentication. 
• Ensure that LDAP is enabled. For details, refer to Network Authentication on page 270. 
• Ensure that Network Authentication is enabled. For details, refer to Configuring Secure Settings on 

page 267.  

To define LDAP user mappings: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Connectivity. 
4. For Protocols, click LDAP, then click LDAP User Mappings. 
5. In the User Name field, type a user name, then click Search. 
6. If Network Authentication is enabled, the Home field appears. The Home field indicates the location 

of the user personal directory. The system administrator defines the default for homeDirectory 
when the user account is created. 

7. If incorrect information is shown in the User Mapping fields, as required, change the information. 
8. Click OK. 
9. At the prompt, click Restart Now. 
 

Configuring LDAP Authentication 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Connectivity. 
4. For Protocols, click LDAP, then click LDAP Authentication. 
5. To use a text string to add to the user name, for Use Added Text String, click the toggle button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

6. For Added Text String, enter the text string to add to the user name for authentication. 
7. Click OK, then click Close. 
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Configuring the Network Authentication 

Network Authentication is a security protocol that requires users to provide their login credentials before 
they can access the printer. The printer compares the user credentials to the information stored on an 
authentication server. 

To prove their identity, users can type their user credentials at the control panel, in the Embedded Web 
Server, or they can use a card reader. 

To configure access rights using network authentication: 
• Provide information about your authentication server and configure authentication server settings. 
• Enable Panel Lock. For details, refer to Managing Panel Lock. 
• Ensure that service locks are set. For details, refer to Setting Service Locks. 
• Ensure that Network Authentication is enabled. For details, refer to Configuring Secure Settings on 

page 267. 

To access the authentication system: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions. 
4. Click Login/Logout Settings. 
5. For Network, click Edit. 
6. For Network Login, select Kerberos, SMB, or LDAP, then click Next. 
7. Configure the LDAP server, authentication, and custom filter settings. For details, refer to the 

configuration topic for your authentication system. 

For reference:  
Configuring an LDAP Authentication System on page 271 
Configuring an SMB Authentication System on page 271 
Configuring a Kerberos Authentication System on page 272 
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Configuring an LDAP Authentication System 

Before using LDAP servers for authentication, configure the settings in the Embedded Web Server. 

To configure an LDAP system: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions, then click Login/Logout Settings. 
4. For Network, click Edit. 
5. In Network Login, select LDAP, then click Next. 
6. In LDAP, click each of the topics in the list. In each window, perform the required configuration, then 

click OK. 
7. When the LDAP configuration is finished, click Done. 
 

Configuring an SMB Authentication System 

Before using servers for authentication, configure the settings in the Embedded Web Server. 

To configure an SMB authentication system: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions, then click Login/Logout Settings. 
4. For Network, click Edit. 
5. In Network Login, select SMB (Windows ADS), then click Next. 
6. In SMB (Windows ADS), type the configuration information for the default server and any alternate 

servers, then click Done. 
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Configuring a Kerberos Authentication System 

Before using Kerberos servers for authentication, configure the settings in the Embedded Web Server. 

Note: For Kerberos authentication, configure the printer with the current time and date. For details, 
refer to Setting the Date and Time Using the Embedded Web Server on page 236. 

To configure a Kerberos authentication system: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions, then click Login/Logout Settings. 
4. For Network, click Edit. 
5. In Network Login, select Kerberos (Windows ADS), then click Next. 
6. In Kerberos (Windows ADS), type the configuration information for the default server and any 

alternate servers, then click Done. 
7. Click Restart Now. 
 

Configuring IP Address Filtering 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security. 
4. Click IP Address Filtering. 
5. For IP Address Filtering, to enable an Internet Protocol, click its associated toggle button. 

Note: A check mark on the toggle button indicates that the feature is enabled. 

6. To add an IP Address: 
a. For Allowed IP Address/Subnet Mask, click Add. 
b. In the Enter IP Address field, enter the IP address of the host as X.X. X.X, where X is a number 

from 0 through 255. For example, 192.168.200.10. 
c. In the Enter IP Mask field, enter the last digits of the network mask for the host. 
d. Click OK. 

7. To remove an allowed IP Address, for the IP Address: 
a. Click the Trash icon. 
b. At the prompt, click Delete. 

8. To edit an allowed IP Address: 
a. From the allowed IP Address list, click the IP Address. 
b. Edit the information. 
c. Click OK. 

9. When finished, to save your settings, at IP Address Filtering, click OK. 
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Configuring SSL Settings in the Embedded Web Server 
Secure Sockets Layer (SSL) is a protocol that creates an encrypted connection between your printer and 
a server. 

Note: To enable SSL, a digital certificate is required. 

To create a digital certificate: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security. 
4. For Certificates, click Security Certificates. 
5. From the Security Certificates menu, select Device Certificates. 
6. Click Create, then select Create Self-Signed Certificate. 
7. Select your Hash Algorithm and Public Key Length. For assistance, contact your system administrator. 
8. To set the number of days for the certificate to remain valid, type the desired number of days in the 

Validity Period field. 
9. Click Create. 
10. To return to the Security Certificates page, at the prompt, click Close. 
11. To close the Security Certificates page, click Close. 

To configure the SSL Settings: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security. 
4. For Network Security, click SSL/TLS Settings. 
5. Select one or more protocols from the list of SSL and TLS protocols. 
6. To select a Device Certificate for the server, click in the Device Certificate - Server area, then select a 

certificate from the list. 
7. To enable SSL communication, click the HTTP - SSL/TLS Communication toggle button. 
8. For HTTP - SSL/TLS Port Number, type a valid port number.  
 

 CAUTION: Before changing the default value of 443, contact your system administrator. 
 

9. If your LDAP server requires SSL communication using LDAP authentication, click the LDAP - 
SSL/TLS Communication toggle button. 

10. To enable SSL communication for SMTP, click SMTP - SSL/TLS Communication, then select an 
option. 

11. If necessary for your environment, click the Verify Remote Server Certificate toggle button, then 
click OK. 

12. To activate your changes, at the prompt, click Restart Now. 

Note: A check mark on the toggle button indicates that the setting is enabled. 
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Enabling HTTPS Communication 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Connectivity > HTTP. 
4. To enable HTTPS, click the HTTPS (SSL) toggle button. 

Note: A check mark on the toggle button indicates that the setting is enabled. 

5. Click OK. 
6. To activate your changes, at the prompt, click Restart Now. 
 

Configuring SMTP Domain Filtering 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. In the Embedded Web Server, click System > Security. 
4. For Network Security, click Domain Filtering. 

− To allow specific domains, select Allow Specific Domains. Type the domains to allow. 
− To block specific domains, select Block Specific Domains. Type the domains to block. 
− To disable domain filtering, select Off. 

5. Click OK. 
 

USB Port Security 

To prevent unauthorized access to the printer through the USB port on the front of the printer, disable 
the port. 

To enable or disable the USB port: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions. 
4. For Guest Access, click Edit > Device User Role. 
5. For Control Panel Permissions, click Custom Permissions, then click Setup. 
6. Click USB. 
7. For each USB access option, click Allow, Restrict, or Hide. 
8. To apply the new settings, click OK. 
9. To return to the Permissions window, click Close, then click OK. 
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Configuring Secure Settings Using the 
Control Panel 

Authentication Using a Card Reader System 

When Xerox® Convenience Authentication is configured, users swipe a pre-programmed identification 
card at the control panel. The printer compares the user credentials to the information stored on the 
Convenience Authentication server. 

For details, refer to the documentation provided with your authentication software. 
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Configuring User Roles and Access Permissions 

This section includes: 
• Setting the Login Method................................................................................................................................................ 276 
• Managing User Accounts ................................................................................................................................................. 277 
• Managing Device User Roles .......................................................................................................................................... 282 
• Managing Printing User Roles ....................................................................................................................................... 285 
• Setting Up an LDAP User Permissions Group ......................................................................................................... 288 

You can configure permissions settings, such as login settings, user roles, printing restrictions, and 
password rules. 
 
 

Setting the Login Method 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. In the Embedded Web Server, click Permissions > Login/Logout Settings. 
4. To change the options for the selected login method, click Edit. 
5. To change the login method to another login method: 

a. Click Select. 
b. Select options as needed. 
c. Click OK. 
d. To confirm the change, at the prompt, click Change. 

To activate your changes, the printer restarts automatically. 

Note: For details on network authentication, refer to Network Authentication on page 270. 

6. To configure other login settings, for Advanced Settings, click Edit. 
a. For Input Settings, and Authentication Settings, make selections as needed. 
b. Click OK. 
c. To activate your changes, at the prompt, click Restart Now. 

 

276 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



System Administrator Functions 

 

Managing User Accounts 

User accounts allow you to manage device and printing permissions. You can create, modify, and delete 
user accounts. You can also configure settings for the guest user account. 
 

Configuring Access Permissions for a Guest User 

You can set device access and printing permissions for a guest user. A guest user is any user that is not 
logged in to the device. 

To configure device access permissions for a guest user: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Permissions. 
3. For Guest Access, select Edit. 
4. Select Device User Role. 
5. For Control Panel Permissions, or Device Website Permissions, select a role from the list. 
6. To assign permissions to specific Apps: 

a. Click Custom Permissions, then click Setup. 
b. Select an App, then configure permissions as needed. 
c. Click OK. 
d. Click Close. 

7. Click OK. 

To configure printing permissions for a guest user: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Permissions. 
3. For Guest Access, select Edit. 
4. Select Printing User Role. 
5. For Printing Permissions, select an option. 

Note: When you select Custom Permissions, more print settings appear. Configure the settings as 
needed. 

6. Click OK. 
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Configuring Password Rules 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Password Rules. 
5. For Minimum Length and Maximum Length, type the minimum and maximum number of 

characters allowed for the password. 
6. To allow or disallow the user name as part of the password, for Password Contains User Name, 

select an option. 
7. To set the security level for passwords, for Password Complexity, select an option. 
8. Click OK. 
 

Adding a User Account 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Permissions. 
3. For User Accounts, click Add. 
4. For User Name, type a user name. 
5. Type, then retype a Password. 
6. Click Add. 

The new user account appears in the User Accounts list. 
 

Adding a Photo to a User Account 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. For User Accounts, select a user account. 
5. On the Profile Photo icon, click the pencil icon. 
6. Select an image to appear. 
7. Click OK. 
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Changing Device Access Permissions for a User 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. For User Accounts, select a user account. 
5. For Roles, click Device User Role. 
6. For Control Panel Permissions, or Device Website Permissions, select a role from the list. 
7. To assign permissions to specific Apps: 

a. Click Custom Permissions, then click Setup. 
b. Select an App, then configure permissions as needed. 
c. Click OK. 
d. Click Close. 

8. Click OK. 
 

Changing Printing Permissions for a User 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. For User Accounts, select a user account. 
5. For Roles, click Printing User Role. 
6. Select a role from the list. 
7. Click OK. 
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Configuring Guest User Permissions for Printing from an Application 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Permissions. 
4. For Guest Access, click Edit. 
5. For Printing Permissions, select Custom Permissions. 
6. Select Printing User Role. 
7. For Application Permissions, click Setup. 
8. To allow or restrict printing from an application, click the application name. 
9. Set options as needed, then click OK. 
10. To exit the Application Permissions page, click Close. 
11. To save your changes and exit the Edit Role page, click OK. 
 

Restoring the Home Screen and Apps to Default Settings for a User Account 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. For User Accounts, select a user account. 
5. For Personalizations, click Reset. 
6. To confirm, click Reset. 
 

Linking a PC User Name to a User Account for Job Status Updates 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. For PC User Names, click Link Account. 
5. Type the PC User Name. 
6. Click OK. 

Note: You can link multiple PC user names to a user account. 
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Adding an Email Address to a User Account 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. For Email "From" Address, click Edit. 
5. Type the email address. 
6. Click OK. 
 

Deleting a User Account 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. For User Accounts, select an account. 
5. Click Delete User. 
6. To confirm, click Delete. 
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Managing Device User Roles 

Device User Roles determine what appears on the printer control panel or in the Embedded Web Server 
for a logged-in user. You can create, modify, and delete device user roles. You can also associate user 
accounts with device user roles. Users added to a role are limited to the access permissions defined for 
the role. A user that is not a member of a custom device user role automatically becomes a member of 
the Basic User role. 
 

Adding a Device User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Device User Roles. 
6. For Device User Roles, click the plus icon (+). 
7. Select an option: 

− To start with the default settings, select Add New Role. 
− To start with settings from an existing role, select Add New Role from Existing, then select a 

role from the list. 
8. Type a name and description for the new role. 
9. For Device Website Permissions, select options as desired. 

Note: When you select Custom Permissions, click Setup, then configure settings as desired. 

10. Click OK. 
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Editing a Device User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Device User Roles. 
6. In the Device User Roles area, select a role, then click Edit. 
7. For Device Website Permissions, select options as needed. 

Note: When you select Custom Permissions, click Setup, then configure the settings as needed. 

8. Click OK. 
 

Adding Members to a Device User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Device User Roles. 
6. In the Device User Roles area, select a role, then click Members. 
7. For Members, click the plus icon (+). 
8. Select the members you want to add to the Device User Role. 
9. Click OK. 
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Deleting Members from a Device User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Device User Roles. 
6. In the Device User Roles area, select a role, then click Members. 
7. Select the user that you want to remove from the Device User Role. 
8. Click OK. 

Note: Deleting a user from a custom role adds the user to the Basic User role. 
 

Deleting a Device User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Device User Roles. 
6. In the Device User Roles area, select a role, then click Edit. 
7. At the bottom of the Edit Role page, click Delete. 
8. To confirm, click Delete. 

Notes: 

• Members deleted from a Custom Permissions role are added automatically to the Basic Printing 
User role. 

• You cannot delete the Basic User role. 
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Managing Printing User Roles 

A Printing User Role is a set of permissions that governs print jobs that are submitted from a computer. 
You can create, modify, delete, and associate user accounts to printing user roles. Users added to a role 
are limited to the printing permissions defined for the role. A user that is not a member of a custom role 
automatically becomes a member of the Basic Printing User role. 

You can set permissions for the following items: 
• Days and times during which the user is allowed to print 
• Color printing 
• Job types 
• 1-sided output 
• Specific paper tray usage 
• Printing from individual applications 
 

Adding a Printing User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Printing User Roles. 
6. For Printing User Roles, click the plus icon (+). 
7. Select an option: 

− To start with the default settings, select Add New Role. 
− To start with settings from an existing role, select Add New Role from Existing, then select a 

role from the list. 
8. Type a name and description for the new role. 
9. For Printing Permissions, select options as needed. 

Note: When you select Custom Permissions, more print settings appear. Configure the settings as 
needed. 

10. Click OK. 
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Editing a Printing User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Printing User Roles. 
6. In the Printing User Roles area, select a role, then click Edit. 
7. For Printing Permissions, select options as needed. 

Note: When you select Custom Permissions, more print settings appear. Configure the settings as 
needed. 

8. Click OK. 
 

Adding Members to a Printing User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Printing User Roles. 
6. In the Printing User Roles area, select a role, then click Members. 
7. For Members, click the plus icon (+). 
8. Select the members you want to add to the Printing User Role. 
9. Click OK. 
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Deleting Members from a Printing User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Printing User Roles. 
6. In the Printing User Roles area, select a role, then click Members. 
7. Select the user that you want to remove from the Printing User Role. 
8. Click OK. 

Note: If you delete a user from a custom role, this action adds the user to the Basic Printing User 
role. 

 

Deleting a Printing User Role 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click Permissions. 
4. Click Roles. 
5. Select Printing User Roles. 
6. In the Printing User Roles area, select a role, then click Edit. 
7. At the bottom of the Edit Role page, click Delete. 
8. Click OK. 

Notes: 

• Members deleted from a Custom Permissions role are added automatically to the Basic Printing 
User role. 

• You cannot delete the Basic Printing User role. 
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Setting Up an LDAP User Permissions Group 

You can define permissions groups using LDAP servers. 

Before you begin, ensure that you have configured the LDAP server settings. For details, refer to LDAP 
Server on page 268. 

To set up an LDAP user permissions group: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 33. 

2. Log in as a system administrator. For details, refer to Logging In as the Administrator on page 265. 
3. In the Embedded Web Server, click Permissions. 
4. Click Roles, then select Setup LDAP Permissions Groups. 
5. Select an LDAP server, then click OK. 
6. On the Permissions page, click Roles, then select Edit LDAP Groups. 
7. For LDAP Groups, click the plus icon (+). 
8. In the Add LDAP Group field, type your LDAP group name, then click the search icon. 
9. Select an LDAP group, then click Next. 
10. For Select Device User Role, select an option, then click Next. 
11. Select a user role, then click Next. 
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Managing Certificates 

This section includes: 
• About Security Certificates ............................................................................................................................................. 289 
• Overview of Setting Up Digital Certificates ............................................................................................................. 290 
• Before You Begin ................................................................................................................................................................. 290 
• Creating a Security Certificate ...................................................................................................................................... 290 
• Importing a Digital Certificate ...................................................................................................................................... 291 
• Verifying the Digital Certificate Purpose .................................................................................................................. 291 
• Deleting a Digital Certificate ......................................................................................................................................... 292 
• Exporting a Digital Certificate ....................................................................................................................................... 292 
 
 

About Security Certificates 

A digital certificate is a file that contains data used to verify the identity of the client or server in a 
network transaction. A certificate also contains a public key used to create and verify digital signatures. 
One device proves its identity to another by presenting a certificate trusted by the other device. Or, the 
device can present a certificate signed by a trusted third party and a digital signature proving its 
ownership of the certificate. 

A digital certificate includes the following data: 
• Information about the owner of the certificate 
• The certificate serial number and expiration date 
• The name and digital signature of the certificate authority (CA) that issued the certificate 
• A public key 
• A purpose defining how the certificate and public key can be used 

There are three types of certificates: 
• Device Certificate: A certificate for which the printer has a private key, and the purpose specified in 

the certificate allows it to be used to prove identity. 
• CA Certificate: A certificate with authority to sign other certificates. 
• Trusted Certificate: A self-signed certificate from another device that you want to trust. 

To ensure that the printer can communicate with other devices over a secure trusted connection, both 
devices must have certain certificates installed. 

For protocols such as HTTPS, the printer is the server, and must prove its identity to the client Web 
browser. For protocols such as 802.1X, the printer is the client, and must prove its identity to the 
authentication server, typically a RADIUS server. 
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The following steps provide an overview of installing certificates for HTTPS and 802.1X: 
• Install a device certificate on the printer. 

Note: To enable HTTPS, create a self-signed Certificate from the SSL page in the Embedded Web 
Server. 

• Install a copy of the CA certificate that was used to sign the device certificate of the printer on the 
other device. 

Protocols such as LDAP and IPsec require both devices to prove their identity to each other. 
 

Overview of Setting Up Digital Certificates 
The following steps are an overview of the procedure to set up and use digital certificates: 
1. Prepare the printer to manage digital certificates by enabling HTTPS communications. 
2. Import and set up digital certificates. 

a. Import the digital certificates. 
b. Configure the digital certificate purpose. 
c. Verify the digital certificate purpose. 

3. Configure the desired security features to use the imported digital certificates. 

Use the following topics to set up the digital certificates for your printer. 
 

Before You Begin 
Before you can manage certificates, configure SSL. For details, refer to Configuring SSL settings on 
page 273. 
 

Creating a Security Certificate 
Note: To import a certificate, ensure that HTTP - SSL/TLS communication is enabled. For details, 
refer to Enabling HTTPS Communication on page 274. 

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 
press Enter or Return. 

2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 
the Administrator on page 265. 

3. Click System > Security. 
4. For Certificates, click Security Certificates. 
5. From the certificate type menu, select Device Certificates. 
6. Click Create, then select Create Self-Signed Certificate. 
7. For the available fields, select your options. 
8. Confirm, or change, the issuer of the SSL self-signed certificate. 
9. For Validity Period, specify the length of time in days for the certificate to remain valid. 
10. Click Create, then at the prompt, click Close. 

The printer creates a digital certificate and places it in the certificate list. 
11. When you are finished, click Close. 
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Importing a Digital Certificate 

Before you import a certificate, ensure that you back up the certificate file. 

To import a digital certificate: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security. 
4. For Certificates, click Security Certificates. 
5. Click Import. 
6. Click Select. 
7. Locate, select the certificate file, then click Open. 
8. Depending on the type of security certificate, do one of the following: 

− Leave the password fields blank for PKCS#7 and other certificates. 
− If you select a PKCS#12 certificate, enter a password that corresponds to the certificate file to 

import. To confirm, reenter the password. 

Note: A password is required only for PKCS#12 certificates. 

9. To import the file, click Import. 
10. When the process completes, click Close. 
 

Verifying the Digital Certificate Purpose 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security > Security Certificates. 
4. To view the security certificates, from the Security Certificates menu, select the type of security 

certificate that you want to verify. 
5. To view all details for a certificate, click the desired certificate. 
6. Ensure that the certificate is valid and that it is the certificate associated with the Certificate 

Purpose. 
7. To return to the Security page, click Close, then click Close again. 
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Deleting a Digital Certificate 

When you delete a digital certificate, it disables the feature associated with the deleted feature. To 
delete a certificate that is in use, disable the feature in advance or switch the association to another 
certificate. 
• For an SSL server, select another certificate, such as a Local Device. 
• For an SSL Client, disable the LDAP-SSL/TLS and IEEE802.1x features. 
• For IPsec, change the IKE setting to Preshared Key, or disable the feature. 

To delete a digital certificate: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security. 
4. For Certificates, click Security Certificates. 
5. Select the certificate that you want to delete. 
6. Click Delete. 
7. At the prompt, click Delete. 
8. Click Close. 
 

Exporting a Digital Certificate 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Security. 
4. For Certificates, click Security Certificates. 
5. To display a list of certificates, from the Security Certificates menu, select the type of security 

certificate that you want to export. 
6. To view all details for the certificate you want to export, click the certificate information. 
7. Click Certificate Details. 
8. To export the certificate, at the bottom of the details list, click Export. 

Note: PKCS#12 passwords cannot be exported. To export a PKCS#12 certificate, export it as a 
PKCS#7 certificate. 

9. To return to the Security page, click Close, then click Close again. 
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Configuring Remote Services Upload 

Remote Services is a suite of features that simplify printer ownership and administration. It provides free 
services to enable administration of metered billing and supplies replenishment plans for printers on a 
network. 

Before you begin, if your network uses an HTTP proxy server, obtain the information about your proxy 
server. For details, refer to Setting up a Proxy Server on page 293. 
 

Setting Up a Proxy Server 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click Connectivity. 
4. For Protocols, click HTTP. 
5. To enable a Proxy Server, for Proxy Server, click the toggle button. 

Note: A check mark on the toggle button indicates that the setting is enabled. 

6. To set the configuration type, click Setup and select an option: 
− If your proxy server uses automatic configuration, select Automatic. 
− If your proxy server uses a configuration script, select Configuration Script. Type the URL to 

locate the configuration script. 
− If your proxy server uses manual configuration, select Manual, then configure the settings. For 

assistance, contact your system administrator. 
7. Click OK. 
 

Enabling Remote Services 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Remote Services Upload. 
4. For Remote Services, click Enable. 
5. Click OK. 
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Testing the Connection to the Xerox® Remote Services Datacenter 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Remote Services Upload. 
4. For Remote Services, click Settings. 
5. Click Test Connection. If communication is successful, a status message appears. 
6. Click Close. 
7. Click OK. 
 

Scheduling Daily Data Upload to the Xerox® Remote Services Datacenter 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Remote Services Upload. 
4. For Remote Services, click Settings. 
5. For Schedule Upload, type the time for the billing data and supplies data to upload to the Xerox® 

Remote Services data center. 

Note: Enter the time using a 24-hour clock format. 

6. To download billing data and supplies data to a .csv file, click Download Data. 

Note: Look for the.csv file in your Downloads folder. 

7. Click OK. 
 

Enabling Email Notifications for Remote Services 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Remote Services Upload. 
4. For Remote Services, click Settings. 
5. For Email Notifications, select one or more options. 

When a selected condition or event occurs, the system generates an email that is sent to the 
specified recipient. 

6. For Whom to notify, type the email address of the recipient. 

Note: You can specify up to five email recipients. 

7. To stop notifications for a recipient, for the email address, click the Trash icon. 
8. Click OK. 
 

294 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



System Administrator Functions 

 

Disabling Remote Services 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, log in as a system administrator. For details, refer to Logging In as 

the Administrator on page 265. 
3. Click System > Remote Services Upload. 
4. For Remote Services, click Disable. 
5. For Who is disabling, select an option. 
6. Type the reason for disabling Remote Services Upload. 
7. Click Disable. 
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Specifications 

 

Printer Configurations and Options 

Available Configurations 

The Xerox® WorkCentre® 6515 Color Multifunction Printer is available in three configurations: 
 

Configuration Feature 

N • Copy 
• Print 
• Scan 
• Fax 
• USB or Network Connectivity 

DN • Copy 
• Print 
• Scan 
• Fax 
• Automatic 2-Sided printing 
• USB or Network Connectivity 

DNi • Copy 
• Print 
• Scan 
• Fax 
• Automatic 2-Sided printing 
• USB or Network Connectivity 
• Wireless Network Adapter 

 
 

Standard Features 
 

Print Speed • Standard and Enhanced modes up to 30 ppm 

2-Sided Print speed • Standard mode up to 20 images per minute 
• Enhanced mode up to 20 images per minute 

Print Resolution • Standard mode: 600 x 600 dpi 
• Enhanced mode: 600 x 600 x 8 dpi from the print driver, which prints at 

1200 x 2400 dpi 

Paper Capacity 
• Bypass Tray 
• Tray 1 
• Optional 550-Sheet Feeder 
• Output Tray 

 
• 50 sheets 
• 250 sheets 
• 550 sheets 
• 150 sheets 

Maximum Print Size Legal (216 x 356 mm, 8.5 x 14 in.) 
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2-Sided Printing • N Configuration: Manual 
• DN Configuration: up to 176 g/m² from any tray 

Copy Speed 
• 1-Sided Copy 
• 2-Sided Copy 

 
• 13 copies per minute for color, 21 copies for black and white 
• 8 copies per minute for color, 9 copies for black and white 

Copy Resolution 600 x 600 dpi 

Maximum Copy Size Legal (216 x 356 mm, 8.5 x 14 in.) 

Document Feeder Single-Pass Duplex Automatic Document Feeder 

Document Feeder Capacity 50 sheets 

Optical Scan Resolution 600 x 600 dpi 

Maximum Scan Size 
• Document Glass 
• Single-Pass Duplex Automatic 

Document Feeder 

 
• 215.9 x 297 mm (8.5 x 11.7 in.) 
• 215.9 x 355.6 mm (8.5 x 14 in.) 

File Formats • JPEG 
• TIFF 
• PDF 
• PDF/A 
• XPS 

Supported Scanning • Scan to Desktop (WSD) 
• Scan to SMB 
• Scan to FTP 
• Scan to Email 
• Scan to USB Flash drive 

Control Panel 5-inch LCD touch screen and keypad navigation 

Connectivity • USB 2.0 
• USB 3.0 
• USB Flash drive 
• Ethernet 10/100/1000 Base-TX 
• Wireless network connectivity with an IEEE802.11 n/g/b-compliant 

Wireless Network Adapter: Standard only on the DNi configuration. 
• NFC 
• AirPrint™ 

Remote Access Embedded Web Server 
 
 

Options and Upgrades 
• Wireless Network Adapter: Optional for the N and DN configurations but standard for the DNi 

configuration. The Wireless Network Adapter is IEEE802.11 n/g/b-compliant, and supports 2.4-GHz 
and 5-GHz frequencies. 

• 550-Sheet Feeder. 
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Physical Specifications 

Weights and Dimensions 

 Configurations without the Optional 
550-Sheet Feeder 

All Models with the Optional 
550-Sheet Feeder 

Width 420 mm (16.5 in.) 420 mm (16.5 in.) 

Depth 506 mm (19.9 in.) 506 mm (19.9 in.) 

Height 500 mm (19.7 in.) 650 mm (25.6 in.) 

Weight 31 kg (68 lb.) 38 kg (84 lb.) 
 
 

Standard Configuration 

 
 

Configuration with Optional 550-Sheet Feeder 
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Total Space Requirements 
 

 Configurations without the Optional 
550-Sheet Feeder 

All Models with the Optional 
550-Sheet Feeder 

Width 870 mm (34.3 in.) 870 mm (34.3 in.) 

Depth 1264 mm (49.8 in.) 1264 mm (49.8 in.) 

Height 751 mm (29.6 in.) 901 mm (35.5 in.) 
 
 

Clearance Requirements 
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Clearance Requirements with Optional 550-Sheet Feeder 

 
 

302 Xerox® WorkCentre® 6515 Color Multifunction Printer 
 User Guide 
 



Specifications 

 

Environmental Specifications 

Temperature 
• Operating temperature: 5–32°C (41–90°F) 
• Optimum temperature: 15–28°C (59–82°F) 
 

Relative Humidity 
• Minimum–Maximum Humidity Range: 15–85% 
• Optimal Humidity Range: 20–70% relative humidity at 15–28ºC (59–82ºF) 

Notes: 

• Under extreme environmental conditions, such as 10°C and 85% relative humidity, printing 
defects can occur due to condensation in the printer. 

• Print quality can be affected when operating near the limits for both temperature and 
humidity. 

 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 

Power Supply Voltage Frequency Current Required 

120 VAC +/-10% 
(108–132 VAC) 

60 Hz +/-3 Hz 12 A 

220–240 VAC +/-10% 
(198–264 VAC) 

50 Hz +/-3 Hz 6 A 

 
 

Power Consumption 
• Power Saver Mode (Sleep): 1.2W 
• Ready: 52 W 
• Continuous printing: 370 W 
 

ENERGY STAR Qualified Product 

 

This product is ENERGY STAR® qualified under the ENERGY STAR Program 
Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United 
States, European Union, and Japanese governments and the office equipment industry 
to promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes 
after 10 minutes from the last copy or print. 
 

Germany - Blue Angel 

 

RAL, the German Institute for Quality Assurance and Labeling, has awarded this 
device the Blue Angel Environmental Label. This label distinguishes it as a device that 
satisfies Blue Angel criteria for environmental acceptability in terms of device design, 
manufacture, and operation. For more information, go to: www.blauer-engel.de. 

Recycling Supplies 
If you want to return used supplies for recycling, follow the instructions included with the new supplies. If 
the instructions or shipping label are not available, for more information, go to www.xerox.com/gwa for 
more information. 
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Performance Specifications 
 

Feature Specifications 

Printer warm-up time Power on: As fast as 53 seconds. 
Recovery from sleep mode: As fast as 11 seconds. 

Note: Warm-up time assumes an ambient temperature of 20ºC (68°F) at 
60% relative humidity. 

 
 

Print Speed 

Print speeds for continuous printing are up to 30 ppm. Print speeds are the same for color or black and 
white printing. 

Several factors affect print speed: 
• Print mode: The fastest print modes are Standard and Enhanced. 
• Paper size: Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger sizes reduce 

print speeds. 
• Paper type and weights: For faster printing, use paper weights of 105 g/m² or less. 

The maximum print speed for 1-sided printing is 30 ppm on Letter-size paper, and 28.6 ppm on A4-size 
paper. 

The maximum print speed for 2-sided printing is 20 ppm on Letter-size paper and 18.8 ppm on A4-size 
paper. 

The maximum print speed for heavy paper weights is 17 ppm. 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with 
these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
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European Union 
 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox 
with the following applicable Directives of the European Union as of the dates indicated: 
• February 26, 2014: Low Voltage Directive 2014/35/EU 
• February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU 
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 

1999/5/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Introduction 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute. 
• Standard color format products with a maximum speed less than 51 A4 images per minute. 
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Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

ENERGY STAR 

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy 
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and 
models qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ  

For additional information on energy or other related topics, go to 
www.xerox.com/about-xerox/environment/enus.html or 
www.xerox.co.uk/about-xerox/environment/engb.html. 
 

Power Consumption and Activation Time 

The amount of electricity that a product consumes depends on the way the device is used. This product 
is designed and configured to enable you to reduce your electricity usage. 

After the last print, the device switches to Ready mode. In this mode, the device can print again 
immediately. If the product is not used for a period of time, the device switches to a Power Saver mode. 
In these modes, to enable reduced product power consumption, only essential functions remain active. 
The product takes slightly longer to produce the first print after it exits Power Saver mode than it takes in 
Ready mode. This delay is the result of the system waking up from Power Saver mode and is typical of 
most imaging products on the market. 

You can set a longer activation time or completely deactivate the Power Saver mode. This device can 
take longer to switch to a lower energy level. 

Note: Changing the default Power Saver activation times can result in an overall higher energy 
consumption of the product. 

To learn more about Xerox participation in sustainability initiatives, go to: 
www.xerox.com/about-xerox/environment/enus.html. 
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Environmental Choice Certified to Office Machines CCD-035 

 

This product is certified to Environmental Choice standard for office machines, 
meeting all requirements for reduced environmental impact. As part of achieving 
certification, Xerox Corporation has proven this product meets the Environmental 
Choice criteria for energy efficiency. Certified copier, printer, multifunctional device, 
and fax products must also meet criteria such as reduced chemical emissions and 
demonstrate compatibility with recycled supplies. Environmental Choice was 
established in 1988 to help consumers find products and services with reduced 
environmental impacts. Environmental Choice is a voluntary, multi-attribute, and 
lifecycle-based environmental certification. This certification indicates that a 
product has undergone rigorous scientific testing, exhaustive auditing, or both, 
to prove its compliance with stringent, third-party, environmental performance 
standards. 

 
 

Germany 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
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Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
1. Obligations or Securities of the United States Government, such as: 

− Certificates of Indebtedness. 
− National Bank Currency. 
− Coupons from Bonds. 
− Federal Reserve Bank Notes. 
− Silver Certificates. 
− Gold Certificates. 
− United States Bonds. 
− Treasury Notes. 
− Federal Reserve Notes. 
− Fractional Notes. 
− Certificates of Deposit. 
− Paper Money. 
− Bonds and Obligations of certain agencies of the government, such as FHA and so on. 
− Bonds. United States Savings Bonds may be photographed only for publicity purposes in 

connection with the campaign for the sale of such bonds. 
− Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 

canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

− Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

− Postal Money Orders. 
− Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 
− Stamps and other representatives of value, of whatever denomination, which have been or 

may be issued under any Act of Congress. 
− Adjusted Compensation Certificates for Veterans of the World Wars. 

2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 
6. Immigration papers. 
7. Draft Registration Cards. 
8. Selective Service Induction papers that bear any of the following Registrant’s information: 

− Earnings or Income. 
− Court Record. 
− Physical or mental condition. 
− Dependency Status. 
− Previous military service. 
− Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 
• Automobile Licenses. 
• Drivers’ Licenses. 
• Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
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Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
• Current bank notes or current paper money 
• Obligations or securities of a government or bank 
• Exchequer bill paper or revenue paper 
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of 

a court of law 
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 

same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer 
for a province) 

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 

• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of 
a province or by the government of a state other than Canada 

• Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 
• Currency notes 
• Bank notes and checks 
• Bank and government bonds and securities 
• Passports and identification cards 
• Copyright material or trademarks without the consent of the owner 
• Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges. 
 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. Refer to the installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. Refer to the 
installation instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be 
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing 
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). 
To be certain of the number of devices that can be connected to a line, as determined by the RENs, 
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the 
product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN 
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately 
shown on the label. 

To order the correct service from the local Telephone Company, you could also have to quote the codes 
in the following list: 
• Facility Interface Code (FIC) = 02LS2 
• Service Order Code (SOC) = 9.0Y 
 

 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line. 
Connecting this machine to an unauthorized jack can damage telephone company equipment. 
You, not Xerox, assume all responsibility and/or liability for any damage caused by the connection 
of this machine to an unauthorized jack. 
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If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the 
Telephone Company interrupts your service, they can advise you of your right to file a complaint with 
the FCC if you believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Machine Status menu on the 
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing 
harm to the telephone network, the Telephone Company may request you to disconnect the equipment 
until the problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If 
unauthorized repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state 
tariffs. Contact the state public utility commission, public service commission, or corporation commission 
for information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
 

Canada 

This product meets the applicable Innovation, Science and Economic Development Canada technical 
specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 
 

 WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric 
inspection authority, or electrician, to make the ground connection. 

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be 
connected to a telephone interface. The termination of an interface may consist of any combination of 
devices subject only to the requirement that the sum of the RENs of all the devices not exceed five. For 
the Canadian REN value, please refer to the label on the equipment. 
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Regulatory Information 

 

Canada CS-03 Issue 9 

This product has been tested to and is compliant with CS–03 issue 9. 
 

European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

This Xerox device has been self-certified by Xerox for pan-European single terminal connection to the 
analog public switched telephone network (PSTN) in accordance with Directive 1999/5/EC. 

This device has been designed to work with the national public switched telephone networks and 
compatible PBX devices of the following countries: 
 

Pan-European Analog PSTN and Compatible PBX Certifications 

Austria Greece Netherlands 

Belgium Hungary Norway 

Bulgaria Iceland Poland 

Cyprus Ireland Portugal 

Czech Republic Italy Romania 

Denmark Latvia Slovakia 

Estonia Liechtenstein Slovenia 

Finland Lithuania Spain 

France Luxembourg Sweden 

Germany Malta United Kingdom 

This product has been tested to and is compliant with TBR21 OR ES 103 021-1/2/3 or ES 203 021-1/2/3 
technical specifications for terminal equipment for use on analog-switched telephone networks in the 
European Economic Area.  

If you have problems with your product, contact your local Xerox representative. This product can be 
configured to be compatible with other country networks. Before reconnecting the device to a network in 
another country, contact your Xerox representative for assistance. 
 

Notes: 

• Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox 
recommends that you use DTMF signaling. DTMF signaling provides reliable and faster call 
setup. 

• Modification of this product, or connection to external control software or control apparatus 
not authorized by Xerox, invalidates its certification. 
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Regulatory Information 

 

New Zealand 
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 

accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not 
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model. 
The equipment may not be capable of correct operation at the higher data speeds designated. 
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to 
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such 
circumstances. 

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its 
disposal or repair. 

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom 
customers. 

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is 
no guarantee that Telecom lines will always continue to support pulse dialing. 

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may 
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, 
do not contact the Telecom Faults Service. 

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is 
readily available on almost all New Zealand telephone exchanges. 

 

 WARNING: No '111' or other calls can be made from this device during a mains power failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected to 
the same line. 

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on 
the equipment (computer) associated with this device. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom Specifications: 
For repeat calls to the same number: 
− There shall be no more than 10 call attempts to the same number within any 30 minute period 

for any single manual call initiation, and 
− The equipment shall go on-hook for a period of not less than 30 seconds between the end of 

one attempt and the beginning of the next attempt. 
For automatic calls to different numbers: 
The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of 
another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should 
not exceed five. 

 

South Africa 

This modem must be used in conjunction with an approved surge protection device. 
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Regulatory Information 

 

Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds  
• European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
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Recycling and Disposal 

 

All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply. For more information, go to 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
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Recycling and Disposal 

 

North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment , or for recycling and disposal 
information, contact your local authorities. 
 

 Xerox® WorkCentre® 6515 Color Multifunction Printer 323 
 User Guide 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6515&PgName=environmentna&Language=English


Recycling and Disposal 

 

European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Recycling and Disposal 

 

Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents mean 
that used electrical and electronic products and batteries should not be 
mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 
2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a manufacturer-approved service facility. 
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Recycling and Disposal 

 

Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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